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In This Guide...

Methylation (CH3) Analysis Guide

This guide describes how to use the Methylation (CH3)
application of Agilent Genomic Workbench Lite Edition 6.5
to apply algorithms that help identify methylated regions.

Getting Started

This chapter gives instructions on how to start the
application and enter license information. It also gives an
overview of how to analyze CH3 data.

Importing, Managing, and Exporting CH3 Data and Other Content

This chapter describes how to import, organize, manage, and
export CH3 data and other content in Agilent Genomic
Workbench Lite Edition.

Displaying CH3 Data and Other Content

This chapter shows you how to display log ratio data from
imported feature extraction data files and analysis results, as
well as gene list and track content, in the Genomic Viewer. It
also gives you instructions on how to change parameters to
display the data and content the way you prefer.

Setting Up Methylation (CH3) Analysis

This chapter gives instructions on how to set up the analysis
functions for Methylation (CH3) experiments. These include
the Preprocessing, Analysis and Reports tabs.

Methylation (CH3) Analysis Reference

This chapter describes the tabs, commands, shortcut menus
and dialog boxes specific to Agilent Genomic Workbench
methylation (CH3) data analysis. The chapter also includes
information on the format of the reports created by the
program.



Statistical Algorithms

This chapter provides implementation details of the
algorithms used in the CH3 application of Agilent Genomic
Workbench Lite Edition. The CH3 application algorithms
facilitate the statistical analysis of methylated genomic
regions. The first section presents the main methylation
detection algorithm. The next section describes the display
options available for methylation analysis.
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This chapter gives an overview of the Methylation (CH3) application of
Agilent Genomic Workbench Lite Edition. It shows you how to start the
application and find help, and gives general instructions on how to get
started with analyzing CH3 data.

Before or after you import extracted data into the program, you can
assign identification information and attributes to the samples through the
Sample Manager tab. See the Sample Manager User Guide.

To display or analyze imported CGH data, you organize the data files into
logical units called experiments. Experiments are used to define the data
you want to display or analyze using Agilent Genomic Workbench. You can
then use the Preprocessing, Analysis, Discovery and Reports tabs of the
program to interactively analyze the data in the experiment for
aberrations. For detailed steps on how to create an experiment, see the
Data Viewing User Guide.

Agilent Technologies 13



1 Getting Started

What is the CH3 Application?

The CH3 (methylation) application is a framework used to identify
methylation events in your samples. CH3 microarray analysis can help
identify methylated regions isolated using affinity based methods such as
methylated DNA immunoprecipitation. The software helps you:

¢ Identify molecular events associated with DNA methylation

¢ Find and validate gene regulation and regulatory networks by
creating high-resolution, genome-wide methylation profiles

¢ Show modes of action and potential therapeutic activities of
compounds and target genes by understanding the relation of DNA
methylation to transcriptional control

With the CH3 application, you can:

¢ Import data from the Agilent Feature Extraction and Axon programs,
and import UDF files

* Use an intuitive graphical interface to display data and annotations
in the context of an organism’s genome, at several simultaneous
levels of detail

¢ Use a Z-score or BATMAN (Bayesian Tool for Methylation Analysis)
algorithm to calculate the probability that probes are methylated or
unmethylated

¢ Compare the moving average of your log ratio and Z-score data
within the boundaries of CpG Island tracks

You cannot use workflow mode for methylation event detection.

14 Methylation (CH3) Analysis Guide



Getting Started 1

Using Agilent Genomic Workbench on a Mac

The content of this User Guide applies to both the Windows and Mac

versions of Agilent Genomic Workbench. Both of these versions have the

same features. However, when you use the Mac version of the program,

please note the following:

Windows command Equivalent Mac command

Right-click + Command-click ( 38 -click)

* 0On Macs with trackpads, other options are available. On
certain machines, you place two fingers on the trackpad
while you press the button below the trackpad. See the user
guide for your specific machine.

+ If you have a third-party mouse that has more than one
button, you may be able to use one of the buttons as a right
mouse button.

Control-click Control-click (Same as the Windows command)
Shift-click Shift-click (Same as the Windows command)
ﬂ (Close button) @ (Close button)
Methylation (CH3) Analysis Guide 15



1 Getting Started

Entering a License and Starting the CH3 Application

This section describes how to enter your license for the CH3 application
to begin analyzing CH3 data.

When you start Agilent Genomic Workbench for the first time, the
program opens in the Home tab, with the Open Application tab
displayed. From this tab, you can click any of the application areas, enter
license information, or click Help to open the User Guide for that

application.
Jf pen Application) Genamic Viewsr application Type: CH3
av
Open Application Product Dverview 0
Sample Manager Ivanagement console that enables sasy assocition of meta data (patient/sample Help

information) with individual slides, which is carried through the analysis process

'\_\ DNA Analytics(CH3 Module) Analysis application designed to exarnine data generated from CH3 experiments License Help

Figure 1 Open Application tab for CH3
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Getting Started 1

To enter your license for analyzing Methylation (CH3) data
interactively

1 Click the Open Application tab if it is not already displayed.
2 Click License next to the description of DNA Analytics (CH3 Module).

The License tab of the User Preferences dialog box appears.

User Preferences §|

Tracks | Miscellaneous fLicense‘

Flease provide license information to activate the ch3 functionality of Genomic Workbench,

Host Name = webbpc100

Select Analysis Application:

ch3 'y

OServer Location

——

@Text License

Flease paste your license text in the area below:

EATURE ch3 agilent 5.0 04-dec-2009 uncounted HOSTID=ANY SIGN="0013
AB13 3617 OD73 9469 1780 A360 E200 41F4 CCC3 OFS0 0632 BFF4 Y
31DF

[o]4 Cancel Apply

Figure 2 License tab of the User Preferences dialog box

There are two ways to provide the license information:

Use a Server Location

1 Unzip the license .txt file into a folder on your server, to which the
program has access.

2 Copy the path for that folder to the Clipboard.

3 In the User Preferences License tab, click Server Location.

Methylation (CH3) Analysis Guide 17
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Paste the license folder path into the field below Server Location. (To
paste the license for both Windows and Mac computers, hold down the
ctrl key and press V.)

Click Apply, or click OK to apply the license and close the dialog box.

Enter a Text License

Find the folder that contains the CHS3 application license .txt file.

Double-click the license name to open the file in Notepad (or open the
file in another text editor), and copy the text displayed to the
Clipboard.

3 In the User Preferences License tab, click Text License.

4 Paste the license information into the License text box. (To paste the

license for both Windows and Mac computers, hold down the ctrl key
and press V.)

5 Click Apply.

6 If you have no other licenses, click OK.

OR

If you have another license, click the arrow from the Select Analysis
Application list, select the application and repeat steps 1-5.

To start the CH3 application

¢ In the Open Application tab, click the icon next to DNA Analytics

(CH3 Module) L\_,\
The CH3 application starts and the Genomic Viewer is displayed.

Methylation (CH3) Analysis Guide



Getting Started 1

Using Main Window Components to Display/Analyze Data

You can use the data viewing capability in Agilent Genomic Workbench
Lite Edition without a license to view data for many types of arrays,
including CGH, ChIP, and Methylation (CH3). You can use the data
analysis capability in Agilent Genomic Workbench Lite Edition only if you
have a license for one or more of the DNA Analytics programs (CGH,
ChIP, or Methylation).

What are the main window components?

You use four primary components of the Agilent Genomic Workbench main
window to import, manage, export, display, and analyze extracted data.

¢ Home tab commands — import, manage and export data
* Navigator — create and fill new experiments with array data

When you make the experiment active, the data appear in the display,
called Genomic Viewer.

* Genomic Viewer — display data and content in four Views: Genomic
View, Chromosome View, Gene View, and Tab View

You use commands in the interactive analysis tabs to perform
preprocessing, analysis, and reporting of data. You can view the results
of data analysis in the Genomic Viewer.

¢ View tab commands — change appearance of Genomic Viewer display

Figure 3 shows the main window of Agilent Genomic Workbench when the
Genomic Viewer tab is selected, and identifies the names of its
components.

Methylation (CH3) Analysis Guide 19
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Getting Started 1

What can you do with the main components for display of data and
results?

See the table below for the parts of the main window you use to display

log ratio data and results.

Table 1
and results

Components of Agilent Genomic Workbench main window for display of data

To do this

Use this part of the main window

Change program to CGH, ChlIP,
Methylation (CH3), Expression,
microRNA, or SureSelect Target
Enrichment module

Import or export data

Select array data to display in the three
graphical views or in the Tab View as a
table

Display array data/results for only a
certain portion of a chromosome

Switch Application button: Click the button and click the
program module you want to open. The window and
options are different for the different program types.

Home tah: Click the Import or Export button to select the
data you want to import or export. See Chapter 2,
“Importing, Managing, and Exporting CH3 Data and Other
Content” for more information.

Experiment pane of the Navigator: Create an experiment
with the imported data, select the experiment, and then
select the data within the experiment to display or
analyze. See Chapter 3, “Displaying CH3 Data and Other
Content” for more information.

Genome View: Select a chromosome to display in
Chromosome View. You cannot view log ratio data points
here.

Chromosome View: Select a gene region to display in
Gene View. You can display log ratio data points here if
you select Scatter Plot in the View Preferences dialog
box.

Gene View: See the log ratio data next to a selected
region of a chromosome, with associated genes and
track-based annotation. See Chapter 4, “Setting Up

Methylation (CH3) Analysis” for details about these
Views.

Methylation (CH3) Analysis Guide
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Table1  Components of Agilent Genomic Workbench main window for display of data
and results (continued)

To do this Use this part of the main window

Show/Hide or customize the data Gene View: Move the mouse pointer over Scatter Plot to

points for the scatter plots display the options. Or, right-click and then click View
Preferences.

Chromosome View: Right-click and then click View
Preferences.

View tab: Click View Preferences.

See Chapter 3, “Displaying CH3 Data and Other Content”
for information on how to do this.

Display array data next to tracks or My Entity List pane of Navigator: Add or select a track or
gene lists gene list to have it appear in Gene View.

See Chapter 3, “Displaying CH3 Data and Other Content”
for information on how to do this.

Change the appearance of the display  View Tab: Click View Preferences. From the View
Preferences dialog box, you can change the orientation,
select what type of data to view, and configure scatter
plot options.

Genomic Viewer: Right-click any View except the Tab
View and select View Preferences. In the View
Preferences dialog box, you can select to show or hide the
scatter plots and how to display them, including results.

See Chapter 3, “Displaying CH3 Data and Other Content”
for more information.

Analyze or reanalyze displayed data Preprocessing Tab: Click this tab to display commands
you use to manipulate the data before you apply the
algorithms.

Analysis Tab: Click this tab to display commands you use
to analyze the data.

Reports Tab: Click this tab top display commands you use
to generate and manage reports.

For more information on what you can do in these tabs,
see “Tabs” on page 24.

Methylation (CH3) Analysis Guide
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Switching Applications

You can use the Agilent Genomic Workbench to work with a variety of
different data types. Because the requirements for the display of data (and
calculation of results, if using a license) are different for different data
types, you must switch the application for the type of data you want to
display.

The Switch Applications menu, located at the upper right corner of the
Agilent Genomic Workbench window, is used to change the application.
The selected application is marked @\ The selected application is also
displayed in the title bar of the Agilent Genomic Workbench main window.

':D'Switch Application *
CigH

ChIP-on-chip

CH3

Q006

Sureselect Target Enrichment

Figure 4 Switch Application menu

Methylation (CH3) Analysis Guide 23
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Using Tabs and Command Ribbons

24

Tabs

When you click a tab, groups of commands or single commands appear
that are specific for that tab. The tabs that are displayed change
depending on what licenses you have, and what application is selected

(such as CGH, ChIP, CH3).

Home Sample Manager Preprocessing Analysis

Reports View Help

Figure 5 Tabs for CH3 interactive analysis

The following table summarizes the capabilities in the interactive tabs of
the CH3 application of Agilent Genomic Workbench:

Tabs CH3 Capabilities
Preprocessing Combine (fuse) array designs
Analysis Calculate a moving average on log ratio data

Calculate a moving average on ZScores generated by probe

methylation algorithm

Apply probe methylation algorithm

Apply BATMAN algorithm

Reports Generate probe report
Generate BATMAN report

Methylation (CH3) Analysis Guide
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Commands

The area where commands appear is called a command ribbon. The
command ribbon that appears when you click the Home tab for CHS is
shown below. The commands that appear in the command ribbon change
depending on what application module is selected, and which tab in that
application module is selected.

GoTo

(., User @ Import Export I Create A ; i ;
L ﬁ’ Preferences. .. ._JI v & ¥ “" Experiment = E&::;iienomlc EP' i g 2

Figure 6 Home command ribbon for CH3 interactive analysis
For a complete description of all of the command ribbons and commands

you see in Agilent Genomic Workbench, see “Command Ribbons” on
page 124.

Methylation (CH3) Analysis Guide 25
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Using the Navigator to Search for Data

26

This section gives you instructions on how to search for design files,
extracted FE data, experiments and other information in the Navigator of
Agilent Genomic Workbench. The Navigator contains different panes when
you select the Sample Manager tab. See the Sample Manager User Guide
information on the Navigator contents.

>

<4—Search pane

4 Data <4—Data pane

F}-[H Designt 1356859211521019
- [ 014693

-[GHBR 014698

--[GH 014950

--[GH 018897

- [GH 018898

F#-[GHER 021365

4

Experiment |
4 Experiments

-] CH_ExP

4—— Experiment pane

|
|
!
#- | CEHZ |
-4 MyExperiment J;
[H-[6HER 021385 1
E+-Build ho1s !
B4 Arrays |

=) Uszasnz418| |

US23502415 4
£ Usz3s024154
T
My Entity List > 8
A Enties <«4— My Entity List pane
[=+_4 Gene List
- #f ONCOJenes
| Tracks

i< »

Figure 7 Navigator panes
The Navigator shows the array data, experiments, and other content

stored in Agilent Genomic Workbench that is available to the user. It
contains the following panes:
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Pane

Comments

Search

Data

Experiment

My Entity List

My Networks

Lets you search within any pane of the Navigator for a specific
item (array or build, for example). You must type the entire array
name or term; otherwise, use asterisks (*) as wild cards for
unspecified strings. For example, type *1234" to find any item that
contains “1234".

Contains microarray data files, organized by application, then by
design and genome build.

Shows all probe groups and microarray designs that are available
to you, organized by folders. In general, you can:

» Expand or collapse folders to show or hide content.

+ Right-click the name of a folder or item to open a shortcut menu
that lets you take action on the item.

See “Data pane —icons, special text, and buttons” on page 140

and “Data pane — actions and shortcut menus” on page 140.

Contains Agilent Genomic Workbench experiments. Experiments
are organizational units that contain links to microarray data and
design files. In data analysis modules, experiments also contain
saved results.

Contains gene lists and tracks:

» Gene Lists are collections of genes of interest. You can create
them within the program, import and export them, and apply
them to Gene View and Chromosome View.

+ Tracks are collections of annotation or other information that
map to specific genomic locations. You can import, export, and
combine tracks, and display them in Gene View with your array
data and analysis results.

Contains the biological networks/pathways that you found using
Network Search or that you create using a literature search in
eArrayyp. For more information, see the eArrayyy Users Guide.

Methylation (CH3) Analysis Guide
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To search the Navigator

You can search one or all of the panes of the Navigator for items that
match a specific search term. Figure 8 shows the search pane of the
Navigator, and identifies a couple of its elements.

Search

hats X L
| Mext [ 3
all Panels "~

Figure 8 Search pane of the Navigator

1

At the top of the Navigator, in the Pane list, select the pane to search.
To search in all panes, select All Panels. If the pane list is not visible,
click % to show it.

In the search term box, type the desired search term. The search term
is not case sensitive, but it must contain the complete entry that you
want to find. You can use asterisks (*) to represent one or more
unspecified characters. For example, type *12345* to find any item that
contains “12345”.

Click ~ .

The program searches the selected pane(s) for items that match your
search term. If it finds matching items, the program expands the
appropriate folders, and displays the names of the matching items in
red. The first matching item is highlighted in yellow.

Do any of the following:

¢ To highlight the next matching item, if one is available, click
Hext [=

¢ To highlight the previous matching item, click <] Prev

After you complete the search, click % to clear the results of the
search, as well as your search term.
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Using the Genomic Viewer to Display Data

What is the Genomic Viewer?

Genomic Viewer is the graphics and tabular display section of the Agilent
Genomic Workbench main window. In the Genomic Viewer, extracted data
and analysis results are tabulated and displayed next to depictions of the
genome, selected chromosome, and selected genes of the species whose
array data you are analyzing.

There are four main views in the Genomic Viewer, as shown in Figure 9.

¢ Genome View - A graphical representation of the entire genome for the
selected species. Use this view to select the chromosome to show in the
other views.

e Chromosome View - A graphical representation of the selected
chromosome, displayed with cytobands and a plot area. Click or drag
the mouse to select a region to display in the Gene View.

* Gene View — A more detailed view of the chromosomal region selected
in the Chromosome View.

e Tab View - Displays design annotation and log ratio data related to the
chromosome you select in Chromosome View

For more information on the Genomic Viewer and its views, see
Chapter 5, “Methylation (CH3) Analysis Reference”.
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To change the size of and detach panes from the Agilent Genomic
Workbench main window

¢ To change the size of a pane in the main window, drag one of its inside
borders.

e To detach a pane from the main window and open it in a separate
window, click its Detach button

Drag a border to
to resize pane

Click here

i to detach View

Figure 10  Changing the size of and detaching panes
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To maximize and reattach panes to the Agilent Genomic Workbench
main window
e To display a view full-screen in a separate window, click its Maximize
button.

e To reattach a view in a separate window to the main window, click its
Close button.

Click here Click here to
to maximize View reattach View

£ Gene view
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Figure 11 Maximizing and reattaching panes
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General Instructions for Displaying Microarray Data/Results

General Instructions for Displaying Microarray Data/Results

An experiment is
the folder that
holds data from
any array set you
select for the
experiment. The
folder also holds
analysis results.

You set up experiments to display all data and results in the Genomic
Viewer. To set up an experiment you:

¢ Import data
¢ Create a new experiment
¢ Add the imported data to the experiment

¢ Select the experiment to display data

For step-by-step instructions on how to display data, see the Data
Viewing User Guide.

Change to the Turn on scatter Import
CH3 application plot options design files

Add data to the new Create an
experiment experiment

Select the

Import data files
Agilent FE files
Axon files
UDFs

Review data
Select arrays to

. . (tracks and
experiment display

Figure 12

genomic
boundaries)

Typical pathway for displaying microarray data/results

Methylation (CH3) Analysis Guide
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General Instructions for Setting Options for CH3 Interactive Analysis

General Instructions for Setting Options for CH3 Interactive
Analysis

Figure 3 shows the pathway for setting up an experiment and analyzing
data interactively with the CH3 application. After you import data and set
up experiments, you can set up preprocessing and analysis calculations
before you make the experiment active, or apply them afterwards. You can
combine designs, apply an algorithm to show probabilities that genomic
regions are methylated or not and report the results. When you change
each option after experiment activation, the program recalculates the
results. For more information on how to change analysis options, see
Chapter 4, “Setting Up Methylation (CH3) Analysis”.

Set up and select Select /deselect Combine
experiment arrays to include designs
in reanalysis

Compare moving Apply Z-score
Display and save average of log and/or BATMAN

results ratio and Z-score algorithms tofind

data with genomic methylation
region tracks events

Generate reports

Figure 13  Typical analysis pathway — Interactive mode for CH3 application
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To get help within Agilent Genomic Workbench

Agilent Genomic Workbench has several help resources. All help guides
open using Adobe® Acrobat®.

Help Resource

Description/Instructions

Methylation (CH3)
Analysis User Guide

Other User Guides

Product Overview Guide

This user guide, which you are now reading, supplies comprehensive
help on all available CH3 tasks. You can access it easily from anywhere
within the program.

1 Inany tab of Agilent Genomic Workbench, click the Help tab.
2 0Onthe Help Ribbon, click Application Guide.
Methylation (CH3) Analysis User Guide opens.

The Help tab in Agilent Genomic Workbench lets you view any of the
available user guides that apply to the currently selected application
type.
1 Set the desired application type. See “Switching Applications” on
page 23.
2 In the Agilent Genomic Workbench tab bar, click Help.
The names of the available user guides appear in the command
ribbon.
3 Click the desired user guide.
The selected user guide opens.

An additional guide gives an overview of the capabilities within Agilent
Genomic Workbench and describes how to start and find help for all of
the programs. In addition, it helps you with system administration and
troubleshooting.

1 Inany interactive analysis tab of Agilent Genomic Workbench, click
the Open Application tab.

2 Atthe upper right corner of the Open Application tab, click Product
Overview.

Methylation (CH3) Analysis Guide
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To contact Agilent Technical Support

Technical support is available by phone and/or e-mail. A variety of useful
information is also available on the Agilent Technical Support Web site.

Resource To find technical support contact information

Agilent Technical Support 1 Go to http://chem.agilent.com.
Web site 2 Select a country or area.
3 Under Quick Links, select Technical Support.
4 Select from the available links to display support information.

Contact Agilent Technical ~ Telephone: (800-227-9770)

Support by telephone or  E_mail: informatics_support@agilent.com
e-mail (United States and

Canada)

Contact Agilent Technical 1 Go to http://chem.agilent.com.

Support by telephone or 2 Select Contact Us.

e-mail (for your country) 3 Under Worldwide Sales and Support Phone Assistance, click to
select a country, and then click Go. Complete e-mail and telephone
contact information for your country is displayed.

To learn about Agilent products and services

To view information about the Life Sciences and Chemical Analysis
products and services that are available from Agilent, go to
www.chem.agilent.com.
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° o ° CH3 Data and Other Content

Importing Files 38

Working with Experiments to Organize Imported Data 50
Managing Content 60

Exporting and Saving Content 71

This chapter describes how to import, organize, manage, and export
methylation (CH3) data and other content within the user interface of
Agilent Genomic Workbench Lite Edition.

~ii Agilent Technologies
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Importing Files

You can use the Home tab to import many kinds of files into Agilent
Genomic Workbench. The table below describes the kinds of files you can
import, and the topics in this section that describe how to import them.

The Data pane of the Navigator displays all of the content available for
the user who is logged in.See “Navigator” on page 136 for more
information on the Navigator panes and how to use them.

Type of file

Description

See these topics

Microarray data files

Microarray design files

Genome builds

Tracks

Array attributes

Experiments

+ Agilent Feature Extraction
(.txt) data files

» GenePix/Axon (*.gpr) data
files

 Universal Data Files (UDFs)
(*.txt files)

+ Agilent GEML (*.xml) design
files

» GenePix/Axon (*.gal) design
files

Agilent-supplied genome
information for human, mouse
and rat genomes

BED format annotation track
files

.txt files that you have created
yourself or previously exported
from Agilent Genomic
Workbench

ZIP format file of experiments
exported from Agilent Genomic
Workbench

“To import Agilent FE or Axon
data files” on page 41

“To import a UDF file” on
page 43

“To import Agilent GEML
design files” on page 39
“To import Axon design
files” on page 41

“To import a genome build” on
page 46

“To import tracks” on page 47

“To import array attributes” on
page 48

“To import an experiment
file” on page 49

38
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To select a different location for data files

By default, the program stores microarray and experimental data files in
C:\Program Files\Agilent\Agilent Genomic Workbench Lite Edition<version>\data. If
you want, you can select a different location.

Do not select a location that contains a backup data folder; the current data overwrites
the data in the folder you select.

1 In the Home tab, click User Preferences.

The User Preferences dialog box appears. See “User Preferences” on
page 231.

2 In the Miscellaneous tab, under Data Location, click Browse.
An Open dialog box appears.
3 Select a location, then click Open.

The selected location appears in the User Preferences dialog box, in
Data Location.

4 Click OK.

To import Agilent GEML design files

The Agilent Genomic Workbench database must contain designs that match
the Agilent Feature Extraction data files you want to import. The design
file must be present before any extraction data files are imported. Your
imported GEML files contain array-specific information such as probe
names, annotations, and chromosomal locations, and are associated with a
specific genome build. To import an Agilent GEML file, use the following
procedure.

+ Catalog design files must be downloaded from the eArray Web site.

+ Designs with multiple genome builds are supported for both Catalog and custom designs. For
Catalog designs, the design must first be downloaded from the eArray Web site. You can then
import the design for other genome builds.
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1 In the Home tab, click Import > Design Files > GEML File.

The Import Design Files dialog box appears. See “Import” on page 201.
The dialog box shows only *.xml files.

2 To select a file for import, click its name. To select additional files, hold
down the ctrl key while you click their names.

3 Click Open.

The program validates the selected file(s), and the Import GEML Design
Files dialog box appears. See “Import GEML design files” on page 204.

e If a design file passes validation, the Status column shows Valid in
green.

e If a design and build is already in the database, the Status shows
Overwrite in yellow. If you continue, the imported design replaces the
design in the database.

e If a design is already in the database, but has a different build, the
Status shows Update in green. If you continue, this build of the design
will be added to the database. The existing design build will not be
overwritten.

e If a design file fails validation, Corrupt appears in the Status column
beside it, and the program will not import the file. To remove the
corrupt design from the list, click its Remove button ] .

4 Click Start Import.

The program imports the file(s). The files appear as new design folders
in the Data folder of the Navigator with the genome build as a node
within the folder.

You can import two design files with the same name, but associated
with different genome builds; for example, Hgl7 or Hgl8. If you do, the
program creates a single design folder with two nodes, one for each
genome build.

Methylation (CH3) Analysis Guide
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To import Axon design files

You can import Axon (*.gal) microarray design files into Agilent Genomic
Workbench. The program requires the Axon design files that match all
Axon array data files you import.

1 In the Home tab, click Import > Design Files > Axon File.

The Import Axon Design Files dialog box appears. See “Import” on
page 201. The dialog box shows only *.gal files.

2 To select a file for import, click its name. To select additional files, hold
down the ctrl key while you click their names.

3 Click Import.

The program validates the selected file(s), and the Set genome build
and species for Axon design files dialog box appears. See “Set genome
build and species for Axon design files” on page 220.

e If a design file passes validation, the Status column will show Valid in
green.

e If a design file fails validation, Corrupt appears in the Status column
beside it, and the program will not import the file. To remove the
corrupt design from the list, click its Remove button ] .

4 For each design file, select the appropriate Species and Genome Build.
5 Click Start Import.
The program imports the file(s). The files appear as new design folders in

the Data folder of the Data pane, organized by application (CGH, ChIP, or
methylation, for example).

To import Agilent FE or Axon data files
You can import several types of microarray data files into Agilent Genomic
Workbench:
e Agilent Feature Extraction (FE) *.txt data files
e Axon (*.gpr) data files

e Universal Data Files (UDFs) (*.txt files) See “To import a UDF file” on
page 43 for instructions on how to import this file type.

Methylation (CH3) Analysis Guide 4
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In order to import Agilent Feature Extraction files, you must import the
representative GEML array design files first. In order to import Axon data
files, you must import the representative Axon.gal design files first. See
“To import Agilent GEML design files” on page 39 or “To import Axon
design files” on page 41.

1

42

In the Home tab, do one of the following:

¢ To import Agilent FE data files, click Import > Array Files > FE
File.

¢ To import Axon data files, click Import > Array Files > Axon File.

A dialog box appears. Only data files of the appropriate type appear.
See “Import” on page 201.

To select a file for import, click its name. To select additional files, hold
down the ctrl key while you click their names.

Do one of the following;:
¢ For Agilent FE files, click Open.
¢ For Axon files, click Import.

In either case, the Agilent Feature Extraction Importer dialog box
appears. “Agilent Feature Extraction Importer” on page 167.

Set the following, as needed:

Setting Comments

Name The names of imported arrays are often cryptic. You can give
any array a more meaningful label.
a Double-click the name of the array.
b Edit the name, as desired.
¢ Press Enter.
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Setting

Comments

Dye Flip

Overwrite arrays with
duplicate names

For each array:

+ Select Normal if:
The test samples were labeled with cyanine-5 (red).
The control samples were labeled with cyanine-3 (green).
The imported ratio (test/control) should be reported
directly.

+ Select Flipped if:
The test samples were labeled with cyanine-3 (green).
The control samples were labeled with cyanine-5 (red).
The imported ratio (control/test) should be reported with
the ratio inverted (test/control).

The program does not combine dye-flip pairs.

If you mark this option, the program deletes an existing array
data file if it has the same name as one you import.

5 Do one of the following:

* To import the file(s) while you wait, click OK.

¢ To import the file(s) in the background, click Run in Background.
This lets you continue while the program imports the files.

To import a UDF file

UDF files are plain text files that contain array data in tab-delimited
format. Files must contain the following six columns of information, in
any order. Each column must contain the following column names, as
column headers, or you must “map” the names from the file to these
columns in Agilent Genomic Workbench:

¢ Probe name

¢ Chromosome name

e Start position
¢ Stop position

¢ Description

¢ Signal intensity data (The file can contain additional columns, each
with data from an additional array.)

Methylation (CH3) Analysis Guide
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When you import a UDF file, the program creates a new design based on
the information you enter during import, and the information in the file
itself. This design contains all of the arrays represented in the file. The
program also creates a new experiment that contains the arrays.

1 In the Home tab, click Import > Array Files > UDF File.

The UDF Files dialog box appears. See “Import” on page 201. Only *.txt
files appear in the dialog box.

2 Select the desired UDF file, then click Open.

The Select data type for experiments dialog box appears. “Select data
type for experiments” on page 219.

3 For each array, set the following, as needed:

Setting Comments

Experiment Name By default, the program creates an experiment with the same
name as the imported file. To change the name:

a Double-click the name.
b Edit the name as desired.
¢ Press Enter.

Data type + Select the mathematical form of the signal intensity data for
the array. The options are ratio, log, ratio, log4 ratio, and
In ratio.

Design type + Select CH3.

4 Click Continue.

The Universal Data Importer — Map column headers dialog box appears.
The main table in the dialog box contains the first few rows of data
from the file. Column headings that are contained in the first line of
the file appear at the top of the table as a guide. See “Universal Data
Importer - Map Column Headers” on page 226 for more information.

5 Below each column heading, select the label that identifies the content
of the column. Use each label exactly once, except for LogRatio, which
you can use multiple times. Alternatively, in Select Mapping, select a
saved column map.

These options are available:

Methylation (CH3) Analysis Guide



Importing, Managing, and Exporting CH3 Data and Other Content

Label Description

ProbeName The column contains names of probes.

ChrName The column contains names of chromosomes.

Start First chromosomal location for the probe.

Stop Last chromosomal location for the probe.

Description Text annotation related to the probe.

LogRatio The column contains array data values that correspond to each probe.

You can use this label more than once.

6 Under Species Info, select the species and Genome Build appropriate
to the data in the file.

71 If you expect to import many similar UDFs in the future, follow these
steps to save the column map:

a Under Mapping Info, click Save Mapping As.
An Input dialog box appears.

b Type a name for the column map, then click OK.
The name of the saved map appears in Select Mapping.

In the future, you can select this mapping and apply it to any UDF file
that you import.

8 By default, the program creates a “Virtual Array ID” that becomes the
Array ID attribute for the array(s) in the UDF. To create your own
virtual Array ID, follow these steps:

a Under ArrayID Info, clear Use System Generated ArrayID.

b Double-click the number in Virtual ArrayID, then type the desired
new Virtual Array ID.

For more information on Array IDs, see the Sample Manager User
Guide.

9 Click Import.

The program validates your column mapping. A dialog box appears. If
you need to fix the column map, the dialog box has a list of the
missing column label(s). If the column map is complete, a message asks
if you want to import additional files with the same mapping.

10 Do one of the following:
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e If you want to import additional files with the same column
mapping, follow these steps to include these files in the import:

a Click Yes.
The UDF Files dialog box appears.

b Click the name of a file to select it for import. Hold down the ctrl
key while you click the names of additional files.

¢ Click Open.

e If you do not want to include additional file(s) in the import, click
No.

The Program imports all requested files, and the UDF Import Summary
dialog box appears. This dialog box shows the imported files, the
number of lines of data that were imported for each file, and the
number of lines that were skipped, if any. If a file name appears in red,
the program may not have imported the file. See “UDF Import
Summary” on page 225.

11 Click OK.

In the Data pane, in the appropriate application type folder, a new
design folder appears. The design folder contains the imported array
data.

A new experiment appears in the Experiments folder in the Experiment
pane, that contains the array data. This experiment has the name of the
imported UDF file, unless you changed it during import.

To import a genome build

In general, the program uses the genome build specified in the array
design file, and protects it from changes. If a genome build is not available
in the program, you can import one.

Use arrays from a single genome build in an experiment.

1 In the Home tab, click Import > Genome Build.

The Import Genome Build dialog box appears. See “Import Genome
Build” on page 205.
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2 Set the following. All are required.

Setting Instructions

Species + Type the genome's species of origin, as you would want it to
appear within the program.

Build Name + Type the name of the genome build you want to import, as
you would want it to appear within the program.

Refseq File This file contains information on gene locations for Gene View.

a Click Browse.
A dialog box appears.
b Select the desired file, then click Open.

Cyto-band File This file contains the graphic information on the cyto-bands
for Genome and Chromosome Views.
a Click Browse.
A dialog box appears.
b Select the desired file, then click Open.

3 Click OK.

To import tracks

You can import BED format track files into Agilent Genomic Workbench.
Track files contain specific features correlated with chromosomal
locations, and apply to a specific genome build of a given species.

1 In the Home tab, click Import > Track.
The Import Track dialog box appears. See “Import Track” on page 206.
2 Set the following. All are required.

Setting Instructions
Species + Select the species to which the track applies.
Build Name + Select the specific genome build of the species to which the

track applies.
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Setting Instructions

Track Name + Type a name for the track.
This name identifies the track within the program, including
the name that appears if you include the track in Gene View.

Track File a Click Browse.
A dialog box appears.
b Select the name of the track (*.bed) file that you want to
import.
¢ Click Open.
The location of the file appears in Track File.

3 Click OK.

The program imports the track. To display the track in Gene View, and
to manage tracks, see “To show tracks in Gene View” on page 92.

To import array attributes

An array attributes file is a tab-delimited *.txt file that contains a list of
arrays by Array ID, and values for array attributes. Attributes are pieces
of array- specific information, such as the hybridization temperature or the
name of an array set that contains the array.

Although you can import array attributes with this function, the Sample
Manager application lets you import and assign array attributes more
easily. See the Sample Manager User Guide for more information. To
import an array attributes file

1 From the Home tab, click Import and then select ArrayAttributes.

The Import microarray attributes dialog box appears. See “Import” on
page 201.

2 Select the microarray attributes file, then click Import.

The program imports the file. If the ArrayIDs in the file do not match
the ArraylDs of arrays in the program, a dialog box appears. The dialog
box has a list of the ArrayIDs in the file that do not match. Click No to
stop the import process, or click Yes to continue anyway.
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To import an experiment file

In Agilent Genomic Workbench, an experiment is a set of links to
microarray data and design files, and any associated results. An Agilent
Genomic Workbench experiment file is a single ZIP file that contains the
design and data files for one or more experiments. You can import

¢ Experiment files created in Agilent Genomic Workbench on another
computer

* Agilent Genomic Workbench 5.0 and 6.x experiment files
1 In the Home tab, click Import > Experiments.
The Import Experiments dialog box appears. See “Import” on page 201.

2 Select the ZIP file that contains the experiment(s) you want to import,
then click OK.

The program imports the experiment file. Designs appear as new folders
in the Data pane, in the applicable design type folder. Array data
appears within the applicable design folder, organized by genome build.
In addition, the experiment(s) appear in the Experiment pane,
containing the appropriate arrays.

Agilent Genomic Workbench experiment files contain all of the design and
array data files for an experiment, but do not include any analysis
parameter settings, array selections, or analysis results. To export the data
and design files from one or more experiments, see “To export
experiments” on page 72.
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Working with Experiments to Organize Imported Data

This section describes how to organize imported array data and designs
into experiments. Experiments, shown in the Experiment pane of the
Navigator, contain links to specific array data and design files in the Data
pane. After you set up an experiment, you can then analyze selected array
data within the experiment.

Because experiments only contain links to the actual data and design
files, any number of experiments can use a given set of files. In the CH3
application, experiments also can contain saved experiment results.

To display the array designs and data in the program

e To display the directory of data in the program, use the Data pane
(Figure 14). Double-click a folder to expand or collapse it, or click the
and = buttons.
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Figure 14  Data pane of the Navigator
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In the Data pane, the program organizes design files by the application
(CGH, ChIP, or methylation, for example) to which they apply. It organizes
array data files by genome build under the design with which they are
associated.

You can right-click many elements of the Data pane to open shortcut
menus. For more information, see “Data pane - actions and shortcut
menus” on page 140.

Many icons can appear in the Data pane. See “Data pane - icons, special
text, and buttons” on page 140 for a complete list.

The Search pane can help you find specific data files or other content. See
“To find specific content items in the Navigator” on page 62.

To create a new experiment

In Agilent Genomic Workbench, experiments are organizational units that
contain links to data and design files. To display or analyze data, you
must first create an experiment and associate the desired data files with
it. Because experiments only contain links to the actual data and design
files, any number of experiments can use a given set of files. In data
analysis applications (CGH, ChIP, or methylation, for example),
experiments can also contain saved experiment results.

1 In the Home tab, click Create Experiment.

The Create Experiment dialog box appears. See “Create Experiment” on
page 178.

2 Type a Name and an optional Description for the experiment.
3 Do one of the following:

e To create an empty experiment, and add data to it later, click OK.
The program creates the experiment. To add arrays to the
experiment later, see “To add arrays to an experiment” on page 53.
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¢ To create an experiment and add data to it now, follow these steps:
(You can add or remove data from the experiment later.)

Click Properties.
The Experiment Properties dialog box appears. See “Experiment
Properties” on page 188.

Under Select Design, select the design and genome build
associated with the desired array data.
The applicable arrays appear in Array List.

In Array List, click the name of an array that you want in your
experiment. Hold down the ctrl key while you click the names of
additional arrays.

Click = .

The program transfers the selected arrays to the Selected Array
List.

The dialog box also shown other options for adding arrays. See
“Experiment Properties” on page 188 for more information.

Click OK.
The program creates the new experiment, and adds data to it from
the selected arrays.

¢ To create an experiment and add data to it using the “drag and
drop” method, follow these steps:

To create an empty experiment, click OK.
The program creates the experiment.

From the Data pane, expand a design to see the build and array
data.

Drag an array from the Data pane and drop it onto the
experiment folder in the Experiment pane.

In all cases, a folder with the name of the new experiment appears in
the Experiment pane of the Navigator.
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To add arrays to an experiment

After you create an experiment, or import one, you can add arrays to it.
When you add arrays to an experiment, you create links between the

experiment and the array data and design files. Because the program does
not move the actual files, multiple experiments can share the same arrays.

1 In the Experiment pane, double-click the Experiments folder to expand
it.

2 Right-click the name of the experiment, then click Show Properties.

The Experiment Properties dialog box appears. See “Experiment
Properties” on page 188.

3 Under Select Design, select the design file and genome build for the
arrays to add.

The arrays for the selected design file and genome build appear in
Array List.

4 In Array List, select the arrays to add to the experiment. To select a
single array, click its name. To select additional arrays, hold down the
ctrl key while you click their names.

5 Click | *
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The program transfers the selected arrays to the Selected Array List.

The dialog box also has other options for adding arrays. See
“Experiment Properties” on page 188 for more information.

6 Click OK.

Or, to add array data to an experiment using the “drag and drop” method,
1 From the Data pane, expand a design to see the build and array data.

2 Drag an array from the Data pane and drop it onto the experiment
folder in the Experiment pane.

If needed, the program adds appropriate design and genome build folders
to your experiment folder in the Experiment pane. It places the arrays you
selected in the appropriate genome build folder.

If you add arrays to a selected experiment, and analysis options are marked (for example,
Probe Methylation or Batman), you need to clear and then mark these options again to
apply the analysis to the arrays.

To change the order of arrays in an experiment

When you select an experiment, a table appears in the Tab View of
Genomic Viewer that contains log ratio values for arrays in the
experiment. See “Tab View” on page 161. You can change the order in
which the arrays appear the table. If you display separate scatter plots in
Gene View and Chromosome View for each array, the array order also
determines the order in which these plots appear. You can use this feature
to organize your arrays more logically, or to make it more convenient to
display certain arrays. It is especially useful if you have many arrays.

1 In the Experiment pane, right-click the name of the desired experiment,
then click Edit Array Order.

The Edit Array Order dialog box appears. See “Edit Array Order” on
page 187.

2 In Design, select the design that contains the arrays whose order you
want to change.

The arrays from the selected design appear in Array Name.

3 Do any of the following:
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e To move an array up in the list, click its name, then click | */.
* To move an array down in the list, click its name, then click (Y .

* To sort the list based on a specific microarray attribute, select the
desired attribute in Order by.

4 Click OK.

To change the display names for arrays in an experiment

You can change the name displayed for arrays in an experiment, based on
array attributes. When you change the display names for arrays in an
experiment, the array names are changed only for the selected experiment.
The display names are unchanged in the Data pane and in the other
experiments.

1 Expand the folders in the Experiment pane until you see the
experiment you want to change.

2 Right-click the experiment name, and select Show Properties.
3 In the Experiment Properties dialog box, click Display Name by and
select an attribute to use for display of array names.

Click OK. The names of the arrays in the experiment are changed to the
selected attribute. If the attribute does not exist for an array, the Global
Display Name is displayed.

To change the name of an array that is displayed throughout Agilent Genomic Workbench,
change its Global Display Name using Sample Manager. For more information, see the
Sample Manager User Guide.
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To rename an array in an experiment

When you rename an array in an experiment, you change the array’s name
only within the context of the selected experiment. The name of the array
is unchanged in the Data pane, and in other experiments.

1

Expand the folders in the Experiment pane until you can see the array
to rename.

Right-click the name of the desired array, then click Rename.
An Input dialog box appears.
Type the new name for the array, then click OK.

The name of the array in the tab view of the selected experiment is
renamed. The global display name of the array is not changed.

To remove arrays from an experiment

When you remove arrays from an experiment, you only remove the links
between the experiment and the data files. The files are still available in
the program for use in other experiments. To completely remove files from
the program, see “To remove data or design files from the program” on
page 64.

1

In the Experiment pane, expand folders until you can see the desired
experiment, and the array(s) that you want to remove from it.

In the Arrays or Calibration Arrays folder of the desired experiment,
click the name of an array to select it for removal. Hold down the ctrl
key while you click the names of additional arrays.

Right-click one of the selected array names, then click Delete.
A Confirm dialog box appears.
Click Yes.

The program removes the links between the experiment and the
selected array data files. If the removal of arrays leaves a design folder
in the experiment empty, the program removes this folder as well.
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To select or remove calibration array(s)

After you add an array to an experiment, you can select it as a calibration
array. The program lists calibration arrays within the Calibration Arrays
folder of the experiment with a special icon [€]. You can also remove the
calibration designation from an array.

To select an array as a calibration array

1 Expand the folders of the Experiment pane until you can see the array
that you want to select as a calibration array.

2 Right-click the name of the desired array, then click Select for
Calibration. To select all of the arrays of a given design in the
experiment as calibration arrays, right-click the genome build folder of
the desired design, then click Set for Calibration.

The program selects the array as a calibration array. In the Calibration
Arrays folder of the applicable genome build and design within the
experiment, the array appears with a special icon [E].

To deselect an array from calibration

1 Expand the folders of the Experiment pane until you can see the
desired array. The program lists calibration arrays in the Calibration
Arrays folder(s) of the applicable genome build(s) and design(s) within
each experiment.

2 Right-click the name of the desired array, then click Deselect from
Calibration.

To deselect multiple calibration arrays at once, select all of the desired
arrays. Right-click one of the arrays, then click Deselect from
Calibration. (To select multiple arrays, click the name of one array,
then hold down the ctrl key and click the names of additional arrays. To
select a contiguous block of arrays, click the name of the first array,
then hold down the Shiftkey and click the name of the last one.)

The program removes the array(s) from calibration, and moves the
arrays to the Arrays folder of the applicable genome build and design
within the experiment. The icons of the arrays change to the standard
(non- calibration) array icon (£
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To show or hide array attributes in an experiment

Sample attributes are pieces of information specific to an array, such as
chip barcode or hybridization temperature. You can show or hide
attributes for the arrays in the experiment with the Sample Attributes
dialog box. See “Sample Attributes” on page 213.

1 Right-click the experiment whose attributes you want to show or hide,
or to change.

You see the array attributes and their values that were set up in the
Sample Manager table. See the Sample Manager User Guide.

2 Click Sample Attributes.
3 Click Show/Hide Attributes.

The Show/Hide Columns dialog box appears. See “Show/Hide
Columns” on page 222.

You cannot hide the required attributes. These include Array ID, Global Display Name,
Green Sample, Red Sample (for 2-color arrays), and Polarity.

4 Mark the check boxes for the attributes you want to show, or clear the
check boxes for the attributes you want to hide. These changes are
applied globally for the arrays.

5 Click Save.
6 In the Show/Hide Columns dialog box, click Close.
7 Click Close.

You cannot create new attributes using this dialog box. To do this, you must use the Sample
Manager tab. See the Sample Manager User Guide.

To display or edit array attributes in an experiment

1 Right-click the experiment whose attributes you want to display or edit.
2 Click Sample Attributes.
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You see the array attributes and their values that were set up in the
Sample Manager table. See the Sample Manager Guide. See “Sample
Attributes” on page 213.

3 Double-click the cell whose array attribute value you want to change.

You cannot change Array ID, Polarity, Extraction Status, or IsMultiPack attributes for
extracted or UDF arrays.

4 Click Save Changes.
5 Click Close.

To display or edit the attribute values of a specific array

1 Array attributes are pieces of information specific to an array, such as
chip barcode or hybridization temperature. In the Navigator, you can
display or change attributes for each array.Expand the folders of the
Data pane or the Experiment pane until you can see the array of
interest.

2 Right-click the name of the array, then click Show Properties.

The Microarray Properties dialog box appears, with a list of array
attributes. See “Microarray Properties” on page 208. You can also edit
the attributes of a specific array from this dialog box. In addition, if the
array is an Agilent array, you can see header and feature information
sent from the Agilent Feature Extraction program.

3 When you are finished, click Close.

You use the Sample Manager tab to organize, create, import, and export array attributes.
See the Sample Manager User Guide.
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Managing Content

This section describes how to create, find, rename, update, combine,
and/or remove content such as data, gene lists, and tracks, stored in
Agilent Genomic Workbench. To display the data, gene list and track
content, see Chapter 3, “Displaying CH3 Data and Other Content”.

To display a list of the content stored in the program
The Data and My Entity List panes of the Navigator show the content

stored in Agilent Genomic Workbench. For more information on the
Navigator and its contents, see “Navigator” on page 136.
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Figure 16  Navigator panes

Data pane - Shows all of the design and array data files stored in the
database. For more information, see “To display the array designs and
data in the program” on page 50.

My Entity List pane — Shows the gene lists and tracks stored in the
program. To display the names of gene lists or tracks available in the
program, double-click the names of folders to expand or collapse them, or
click the or El buttons.
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To find specific content items in the Navigator

At the top of the Navigator is a search pane that can help you find
specific content items. See “Search pane” on page 138.

1

Type a search term in the box at the top of the Navigator. The search
term is not case-sensitive, but it must reflect the entire name of the
content item that you want to find. You can use asterisks (*) as
wildcards to represent a group of unspecified characters. For example,
if you type *1234* the search will find all items that contain “1234” in
the name.

By default, the program searches all panes of the Navigator. To limit
your search to a specific pane, click % . In the list that appears, select
the desired pane.

Click £© .
The program searches the selected pane(s). If it finds item(s) that
match your search term, it expands folders so that the items are visible,

and selects them in red. You may need to scroll down to see all the
search results.

To clear the results of a search, click .

To display the properties of a specific design

Design properties include general information about a design, such as its
name, application type, and associated species. They also include a list of
the names and chromosomal locations of probes.

1

Expand the folders of the Data pane until you can see the genome build
folder(s) within the desired design folder.

Right- click the desired genome build folder, then click Show Properties.

The Design Properties dialog box appears. See “Design Properties” on
page 183.
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To update probe annotation in design files

Agilent regularly makes updates to probe annotations on its eArray Web
portal. If you have imported Agilent array designs into Agilent Genomic
Workbench, and you are a registered eArray user, you can download the
updated design files from within Agilent Genomic Workbench. For more
information about eArray, go to https://earray.chem.agilent.com and click
Help.

1 In the Home tab, click User Preferences.
The User Preferences dialog box appears.

2 In the Miscellaneous tab, under eArray User Details, type your eArray
Username and Password. See “User Preferences” on page 231.

3 Click OK.

4 Expand the folders of the Data pane until you can see the design that
you want to update.

5 Right-click the desired design, then click Update from eArray. This
option appears only for Agilent designs.

A confirmation dialog box appears.
6 Click Yes.

The program downloads an updated design, if one is available.

To rename an array in the Data pane

This topic describes how to rename an array in the Data pane, which
changes the Global Display Name for the array. If you rename an array in
this way, and subsequently add the array to an experiment, the array
appears in the experiment with the new name. It also changes the array
name in any experiment to which it is already linked. To rename an array
only within the context of a specific experiment, see “To rename an array
in an experiment” on page 56.

1 Expand the folders of the Data pane until you can see the array you
want to rename.

2 Right-click the name of the array, then click Rename.

An Input dialog box appears.
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3 Type a new name for the array, then click OK.

The program renames the array.

To remove data or design files from the program

You can delete array design and data files from the program when you are
finished with them.

1

If an array that you want to delete is associated with an experiment,
first delete it from the experiment. See “To remove arrays from an
experiment” on page 56.

In the Data pane, expand folders until you can see the design folder or
array that you want to delete.

Do one of the following:

e For array data files, click the name of the first array, then hold down
the ctrl key while you click the names of additional arrays within the
same design.

e For array design folders, click the name of the first design folder,
then hold down the ctrl key while you click the names of additional
ones. This selects the designs and all array data files within them for
deletion.

Right-click the name of a selected design folder or array data file, then
click Delete.

A confirmation dialog box appears.
Click Yes.

The program deletes the selected files.

When you delete files, you permanently remove them from Agilent Genomic
Workbench. To restore deleted files, you must import them again.

64

Methylation (CH3) Analysis Guide



Importing, Managing, and Exporting CH3 Data and Other Content 2

To create a gene list

When you create a gene list, you create a list of the genes in a contiguous
chromosomal region that you define. To create a list of genes in multiple
regions, create multiple gene lists, and combine them. See “To add one
gene list to another” on page 67.

1 Follow these steps to define a chromosomal region for your gene list. If
you know the exact start and end locations of the desired chromosomal
region, skip to step 2.

a In Genome View, select the desired chromosome.

The selected chromosome appears in Chromosome View. See
“Chromosome View” on page 154.

b In Chromosome View, in the plotting area to the right of the
chromosome, drag the pointer over the chromosomal region of
interest.

The program draws a blue box around the region, and displays the
region in greater detail in Gene View.

¢ In Gene View, adjust the view so only the genes of interest appear.
For a description of the adjustment commands available in Gene
View, see “Gene View” on page 156.

2 Right-click anywhere within the log ratio plotting area in Gene View,
then click Create Gene List.

The Create Gene List dialog box appears. See “Create Gene List” on
page 180.

3 In the dialog box set the Name, Description and Color.
4 In the dialog box select the chromosomal region for the new gene list.
Click OK.

The new gene list appears in the Gene List folder in the My Entity List
pane of the Navigator.
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To import a gene list

A gene list file is a plain text (*.txt) file that contains one gene name per
line. When you import a gene list into Agilent Genomic Workbench, it
appears in the Gene List folder in the My Entities List pane. You can use
the gene list to highlight specific genes, or to show or hide the appearance
of genes and data, in Gene and Chromosome Views. See “To show gene
lists in Gene View” on page 90.

1

In the My Entities List pane, double click the Entities folder to expand
it.

Right-click the Gene List folder, then click Import Gene List.
An Import dialog box appears. See “Import” on page 201.

Select the desired gene list file. To select additional gene list files, hold
down the ctrl key and click their names.

Click OK.

To display the genes in a gene list

You can display the genes in a gene list as a table.

1

Expand the folders in the My Entity List pane until you can see the
desired gene list.

Right-click the gene list, then click View In Table.

The Gene List dialog box appears, with a table that contains the names
of the genes in the gene list. You can also use this dialog box to edit
the description of the gene list and its display color. See “Gene List” on
page 199.

You can also create gene lists. For more information, see “To create a
gene list” on page 65.
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To add one gene list to another

You can add one gene list (a source gene list) to another (the target gene
list). The program appends the source gene list to the end of the target
gene list, and leaves the source gene list unchanged.

1 Expand the folders in the My Entity List pane until you can see the
gene lists that you want to combine.

2 Right-click the desired source gene list, then click Add to Gene List.

A dialog box appears. For more information, see “Add Gene List
<name> to” on page 166.

3 In Select target gene list, select the desired target gene list.
4 Click OK.

To rename a gene list

The name of a gene list identifies it within the Gene List folder of the My
Entity List pane. You can rename gene lists.

1 Expand the folders of the My Entity List pane until you can see the
gene list that you want to rename.

2 Right-click the desired gene list, then click Rename.
An Input dialog box appears.

3 Type a new name for the gene list, then click OK.

To delete gene list(s)
1 In the My Entity List pane of the Navigator, click to expand the Gene
List folder.

2 Click the name of a gene list to delete. Hold down the ctrl key while
you click the names of additional gene lists.

3 Right-click one of the selected gene lists, then click Delete.
A confirmation dialog box appears.
4 Click Yes.
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To display the details of a track

You can display a table that contains the values for a list of track
attributes.

1
2
3

In My Entity List pane, expand the Tracks folder to see the track.
Right-click the name of the track, then click View Details.

Data describing the track appear in a Track table. See “Track” on
page 223.

To combine tracks

You can create a track that contains elements from two or more existing
tracks. The existing tracks must be available in Agilent Genomic
Workbench, and they must be associated with the same genome build.

1

In the My Entities List pane, double-click the Entities folder to expand
it, if necessary.

Right-click the Tracks folder, then click Combine Tracks.

The Combine Tracks dialog box appears. See “Combine Tracks” on
page 172.

In Name, type a name for the combined track. The program uses this
name to identify the track in the Tracks folder, and to label the track if
it appears in Gene View.

Click New Condition.
A new row appears in the Track/Operator list.

Under Track, select the first track to combine.

6 Click New Condition, then select another Track/Operator pair. You can

set up as many Track/Operator pairs as you like, but you must set up
at least two. When you add a track, the program automatically assigns
the AND operator to the previous track.

To remove the bottom row from the list, click Delete Condition. To
delete all rows from the list, and erase any entry in Name, click Reset.

Under Operator, select one of the following:
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Operator Comments

AND Creates a combined track out of 2 tracks that will contain elements that appear
in both tracks

OR Creates a combined track out of 2 tracks that will contain elements that appear
in either of the tracks

MINUS Removes the elements of the second track from the first track.

8 Click Save.

Your combined track appears in the Tracks folder of the My Entities
List pane. The Combine Tracks dialog box remains open for you to
create another combined track.

9 Click Close.

To rename a track

The name of a track identifies it both within the Tracks folder of the My
Entity List pane, and in Gene View when you select Show In UI for the
track. You can rename tracks.

1 Expand the folders of the My Entity List pane until you can see the
track that you want to rename.

2 Right-click the desired track, then click Rename.
An Input dialog box appears.
3 Type a new name for the track, then click OK.
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To delete tracks

1 In the My Entity List pane of the Navigator, expand the Tracks folder.

2 Click the name of a track to delete. Hold down the ctrl key while you
click the names of additional tracks.

3 Right-click one of the selected tracks, then click Delete.
A confirmation dialog box appears.
4 Click Yes.
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Exporting and Saving Content

This section describes how to export several kinds of files from the
program.

To export array attributes

You can export selected array attributes for any imported arrays. You first
select the arrays and then the attributes for the selected arrays. You can
export array attributes from the Home tab or from the short-cut menu for
an experiment.

1

Click Home > Export > Array Attributes.
OR

In the Experiment pane of the Navigator, right-click an experiment of
interest, and click Export Attributes.

The Export Array Attributes dialog box appears with the Array tab
displayed. See “Export Array Attributes” on page 191.

If you opened this dialog box by right-clicking an experiment, only
those arrays selected for the experiment appear in the Selected Array
List. You can add or subtract from the list.

Under Select Design, select the design file and genome build for the
arrays to add.

The arrays for the selected design file and genome build appear in
Array List.

In Array List, select the arrays whose attributes you intend to export.
To select a single array, click its name. To select additional arrays, hold
down the ctrl key while you click their names.

Click | *

The program moves the selected arrays to the Selected Array List.
Click Next to select attributes for the selected arrays.

The Export Array Attributes dialog box appears with the Attribute tab
displayed. See “Attribute Tab” on page 193.

All of the attributes for the arrays are already located in the Selected
Attribute List.
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6 Move any attributes you don’t want to export to the Available List.

a In the Selected Attributes List, select those attributes you do not
intend to export.

b Click <
7 Click OK.
The Export dialog box appears. See “Export” on page 190.

8 Select the folder in which to save the attributes, and click Export.

The attributes are saved to the selected folder as a .txt file.

To export experiments

You can export experiments as a ZIP file to transfer them to another
computer. Exported experiments contain the associated design and array
data files, only. The program does not export information about array
selections, or any analysis parameters or results.

1 In the Home tab, click Export > Experiments.

The Export Experiments dialog box appears. See “Export
Experiments” on page 195.

2 Mark the experiments that you want to export. To export all
experiments, click Select All.

3 Click OK.
An Export dialog box appears. See “Export” on page 190.

4 Select a location and type a name for the exported ZIP file.
Click Export.

The program exports all selected experiment(s) together as a single ZIP
file.
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To export a gene list

You can export a gene list as a text file that contains one gene per line.

1 In the My Entity List pane, in the Gene List folder, right-click the gene
list that you want to export, then click Save As.

A Save As dialog box appears.
2 Select a location and type a name for the file.
3 Click Save.

A message appears when the operation is complete.
4 Click OK.

To export tracks

You can export selected tracks as a BED format track file. You can then
import this file into Agilent Genomic Workbench on another computer, or
into a genome browser that accepts BED format files.

1 In the Home tab, click Export > Tracks.

The Export Tracks dialog box appears. See “Export Tracks” on
page 196.

2 Mark the tracks to export. To select all tracks for export, click Select
All.

3 Click OK.
An Export dialog box appears.

4 Select a location and type a name for the exported track file, then click
Export.

The program exports the track(s) as a single BED format track file.
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To copy what you see in the main window

You can copy panes of the main window to the clipboard as images, and
then paste them into a new document in another program (such as Word,
or PowerPoint). The images contain only what actually appears on your
screen — regions to which you must scroll are not included.

1 In the View tab, click Copy.

2 In the shortcut menu that appears, click the name of the pane that you
want to copy. You can copy any view, or the Navigator. To copy all of
the panes, click All.

The program copies the selected pane(s) to the clipboard.

To adjust how data is displayed in the panes, use the View Preferences dialog box. See
“View Preferences” on page 236 for more information.

3 Open a document in a program that accepts images. In that program,
click Edit > Paste, or the appropriate paste command.

To copy the list of array colors for an experiment

You can copy the list of arrays in an experiment, and the colors assigned
to them, to the clipboard as an image. You then paste the image into a
document in another program such as Word or PowerPoint.

1 In the Experiment pane, expand the Experiments folder.

2 Right-click the name of the desired experiment, then click Edit Array
Color.

The Edit Array Color dialog box appears. See “Edit Array Color” on
page 186.

3 In the dialog box, click Edit > Copy.

The program copies the names of the arrays and their colors to the
clipboard as an image.

4 Open a program that accepts images. Click Edit > Paste, or the
appropriate paste command for the specific program.
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To save data and design information from an experiment

You can save the data and design information from a single design in an
experiment as a tab-delimited text file.

1 In the Experiment pane, expand the Experiments folder until you see
the genome build(s) for the design you want to export.

2 Right-click the name of the desired genome build, then click Save As
Text File.

A dialog box appears.

3 Select a location and type a name for the file, then click Save.
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This chapter shows you how to display log ratio data from imported
feature extraction data files, as well as gene and track content, in the
Genomic Viewer. It also has instructions on how to customize the display
of data and content to meet your needs.

To learn about the options for the main window and the dialog boxes for
displaying data, see Chapter 5, “Methylation (CH3) Analysis Reference”.
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Selecting an Experiment

78

An experiment is a set of links to microarray data and design files, and
any associated results. You can see a list of the experiments in the
Experiments pane of the Navigator. See “Navigator” on page 136 for more
information.

When you select an experiment and the Preprocessing and Analysis
options have not been turned on or set to apply, the program shows the
log ratio data of selected arrays in the active experiment, if certain
options have been set. See “To locate and display data (or results) within
the Views” on page 87 for more information.

When you select an experiment and Preprocessing and Analysis options
have been turned on or set to apply, the program automatically begins the
analysis of the selected array data with current settings and displays its
results.

This section describes how to select an experiment, select or deselect
arrays for further analysis, and analyze arrays one at a time.

To select an experiment

When you select an experiment, the program begins the analysis with the
current settings. You can either set the Preprocessing and Analysis
parameters before you select the experiment or change the settings one at
a time after the first analysis and reanalyze. Every time you change a
Preprocessing or Analysis setting for an active experiment, the program
recalculates results.

1 If necessary, do one of the following to add the desired experiment to
the Experiment Pane in the Navigator:

¢ Create a new experiment and add data to it. See “To create a new
experiment” on page 51.

e Import a saved experiment file. See “To import an experiment
file” on page 49.

2 In the Navigator, double-click the name of the experiment.
The Experiment Selection dialog box appears.
3 Click Yes.
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In the Experiment pane of the Navigator, the name of the experiment
turns blue. The name also appears in the title bar of the main window.
Tables of data and design information appear in Tab View.

If you have selected to show the results of an algorithm calculation, then
results appear for the first array when you select the experiment, if you
have not selected any other arrays.

You can select or deselect arrays in the experiment before or after you
select the experiment. Every time you select or deselect an array in a
selected experiment or change a setting, the program reanalyzes the new
data set with the changed settings. See “To select or deselect arrays in the
experiment” on page 79.

When you select the experiment after deselecting it or selecting another
one, the experiment is simply restored if the settings in the Ul haven’t
changed. If they have changed, the program reanalyzes all of the arrays
assigned when the experiment was last selected.

To select or deselect arrays in the experiment

To include arrays for display and analysis, you select them from the
arrays available, either in an inactive experiment or the selected one.
When you first create an experiment, the program automatically sets the
first array in the experiment for analysis. If you do not select additional
arrays for analysis, only the first one is analyzed when the experiment is
selected.

To select the arrays for analysis before experiment selection:

1 Hold down the Shift key to highlight contiguous arrays or hold down the
ctrl key to highlight noncontiguous arrays.

2 Right-click the highlighted arrays, and click Select.
Even though the selected arrays do not change color, they will change
color after activation.

In the Navigator, the color or an array’s icon has the following meaning
after experiment selection:

1nd
=

Array is not selected.
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Array is selected. The specific color matches the color of the column
headings for the array in Tab View. In addition, the program displays
aberration results and moving averages related to this array in this color.
To configure a custom color for the array, see “To change the display color
of an array” on page 81.

To select or deselect arrays in a selected experiment:

1
2

In the Navigator, expand the folders of the selected experiment.
Click the name of an array you want to include in the display.

To include additional arrays, hold down the ctrl key while you click
their names. To include a contiguous block of arrays, click the name of
the first array in the block, then hold down the Shift key while you click
the name of the last one.

Right-click the name of one of the highlighted arrays, then click Select.

4 After you select the arrays, if you have Analysis options selected

(Methylation or Batman, for example), clear the options and then mark
them again. The program re-analyzes the data set within the
experiment and displays the data in Genome, Chromosome, and Gene
Views. You can see the data and results for just the selected arrays in
the Selected Arrays tab in Tab View.

To show analysis results if they do not appear, see “To display results
of analysis” on page 111.

To customize the appearance of the results in Genome, Chromosome,
and Gene Views, see “To change scatter plot appearance” on page 85.

You can also use the headings of columns in Tab View that contain array
data to select and deselect arrays.

Click a column heading to select that array only.

Hold down the ctrl key while you click a column heading to select or
deselect an array without changing the status of other arrays.

Right-click a column heading to open a shortcut menu with options
that let you select or deselect that array, or all arrays.

For more information on Tab View, see “Tab View” on page 161.
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To change the display color of an array

The color assigned to an array sets the color of its icon when you select
the array within an experiment. It also changes the colored square in the
array’s column heading in Tab View.

1 In the Experiment pane, in the Experiments folder, expand the folder of
an experiment until you can see the array whose color you want to
edit.

2 Right-click the desired array, then click Edit Array Color.

The Select Color dialog box appears. The dialog box offers three
different ways to choose the desired color. See “Select Color” on
page 216.

3 Select the desired color in one of the following ways:

Dialog box tab Instructions
Swatches * Click the desired color swatch.
HSB Type or adjust the values in H (Hue), S (Saturation), and B

(Hue/Saturation/Brightness)  (Brightness), or alternately, follow these steps:

a Select H, then drag the slider to select a hue based on the
color strip to its right.

b Click an appropriate location in the large color box to the
left of the slider to set the saturation and brightness levels
of the color.

Both the HSB and equivalent RGB values of the color
appear in the dialog box. Note these values; they will be
useful if you need to duplicate this color in the future.

RGB (Red/Green/Blue) Do any of the following. Note the final RGB Values; they will be
useful if you need to duplicate this color in the future.

+ Drag the Red, Green, and Blue sliders.
+ Type or adjust values in the boxes to the right of the sliders.

Samples of the color in different contexts appear under Preview. The
upper half of the color sample on the right shows the original color for
comparison.

4 Adjust the color as desired, then click OK.
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You can also manage all of the colors for all of the arrays in an
experiment. Right-click the desired experiment, then click Edit Array
Color. For more information, see “Edit Array Color” on page 186.
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Displaying Array Data

After you select an experiment, you can change how data appear within
the Views or change the appearance of the Views that contain the data (or
results).

To display the scatter plots

By default, display of scatter plots is turned On. If you do not see the
scatter plot(s), do one of the following:

1 From the View tab, click View Preferences. See “View Preferences” on
page 236 for more information.

2 In the View Preferences dialog box, under Data Visibility, select All
views and then mark the box next to Scatter Plot.

OR

1 Right-click in any of the views, and select View Preferences. See “View
Preferences” on page 236 for more information.

2 In the View Preferences dialog box, under Data Visibility, select All
views and then mark the box next to Scatter Plot.
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To show or hide data in the scatter plots

1 In the Gene View, move the mouse cursor over the arrow next to
Scatter Plot, and do any of the following:

To do this

Follow these steps

Show or hide the Methylation
Results plot and color the results
by Z-Score values

Show or hide Log Ratio values in
the Log Ratios plot

Show or hide log ratios and
color-code them by Probe Score
values in the Log Ratios plot

Change the ranges and colors for
all scatter plots

+ To show the data points — Mark the Methylation Results
check box and select Z-Score Values from the list.

» To hide all data points — Clear the Methylation Results
check box.

+ To show the data points — Mark the Log Ratios check box
and select Log Ratio Values from the list.
+ To hide all data points — Clear the Log Ratios check box.

» To show the data points — Mark the Log Ratios check box
and select Probe Score Values from the list.
» To hide the data points, Clear the Log Ratios check box.

» Click Configure Color and Ranges to enter ranges and
change colors. See “Configure Coloring Ranges and
Shades” on page 174 for more information.

2 Click X to close the Scatter Plot window.

To customize scatter plot ranges and colors

In order to make it easier to see significant results, you can customize the
display of scatter plot data. For each data type (Z-Score, Log Ratio, probe
score) you can set custom ranges and colors for the display. For channels,
you can set custom colors only.

Add and customize a range

1 In Gene View, move the mouse pointer over Scatter Plot to display the

options.

Mark the check box under Methylation Results or Log Ratios.
Select a data type from the Color by list.

Click Configure Color and Ranges.
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The Configure Coloring Ranges and Shades dialog box appears where
you set ranges and colors for any of the data types. For more
information, see “Configure Coloring Ranges and Shades” on page 174.

5 In the Configure Coloring ranges and Shades dialog box, click the
Methylation Results or Log Ratios tab and then select the data type to
configure.

6 Enter minimum and maximum numbers to define a range for the data
type.

7 Click Color to open the Select Color dialog box. Use the tabs to select
a color for the range. See “Select Color” on page 216 for more
information.

8 Click OK to close the Select Color dialog box and return to the
Configure Coloring ranges and Shades dialog box.

9 Click Add Range to add the custom range to the range list.
10 When you are done, click OK to close the dialog box.

Edit or remove a range

1 In the Configure Coloring ranges and Shades dialog box, click the
Methylation Results or Log Ratios tab and then select the data type to
configure.

2 In the range list, mark the Edit/Delete box to select the range. You can
mark more than one range.

3 Click Edit Range to change the minimum and maximum values, or to
change the color for the selected range.

4 Click Delete Range to delete the selected range.
5 Click OK to close the dialog box.

To change scatter plot appearance

You use the View Preferences dialog box to change the appearance of the
scatter plots in Chromosome and Gene views.

1 Right-click any part of a scatter plot, then click View Preferences.

Or, click the View tab, and then click View Preferences.
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The View Preferences dialog box appears. See “View Preferences” on
page 236.

2 Do any of the following:

To do this Follow these steps

Show or hide the scatter plot a In the View tab under Data Visibility, in View, select All
Views.
b Do one of the following:
To show the scatter plot, mark Scatter Plot.

To hide the scatter plot, clear Scatter Plot.

¢ Click OK.
Change the symbol that You can select the symbol separately for each design type.
appears for data points a Inthe View tab, under Rendering Patterns, select the

desired Design type.
b Under Styles, for each data type, select the desired symbol.
¢ Click Apply.

Show a separate scatter plot  a In the View tab, under View Alignment, under Rendering
in Gene and Chromosome Style, select Stacked.
Views for each selected array b Click Apply.

Show one scatter plot that a Inthe View tab, under View Alignment, under Rendering
contains data for selected Style, select Overlaid.

arrays b Click Apply.

Enable ToolTips for the ToolTips show information about an individual data point when
scatter plot in Gene View you place the pointer over it.

a Click the View tab.

b Under Data Visibility, in View, select Gene View.
¢ Mark Scatter Tool Tip.

d Click Apply.

3 Click OK.
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To print the scatter plot

You can print the scatter plot as it appears in Genome, Chromosome, and
Gene views. Each view selected in the analysis is printed on separate
pages. Chromosomes and genes appear on the printed pages, but tracks do
not.

1 In the Home tab, click Print.
The Print dialog box appears.
2 Set print options, then click OK.

To create custom scales for Views

You can customize the scale used for display in the Chromosome View and
Gene View. Custom scales are applied to both views.

1 Click the View tab and then click View Preferences.

2 In the View Preferences dialog box, under Configure Scales, mark the
box next to Apply for Methylation Results and/or Log Ratios.

3 In Range, type a value to use for the range. The range you type changes
the scale for the display of the selected data.

To locate and display data (or results) within the Views

To look through the data of the selected arrays, do any of the following. In
general, all views are synchronized; if you select a location or region in
one view, the other views move there as well.

To do this Follow these steps

Select a specific chromosome + In Genome View, click the chromosome.
to display All other views switch to the selected chromosome.

Display data in a region of the * In Chromosome View, drag the pointer over the region.
selected chromosome Gene View expands (or shrinks) to show only the selected
region. Tab View scrolls to the new cursor location.
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To do this Follow these steps

Zoom in and out in Gene View < Click |2 to zoom in.

+ Click |2 to zoom out.

Scroll through the selected * Click |~ | to scroll up.

chromosome * Click | ™ | to scroll down.

Note: These arrows will appear side by side for horizontal

orientation.
Re-center Gene View or Click anywhere in Chromosome View, or anywhere within the
Chromosome view scatter plot in Gene View.

The location you click becomes the new cursor location.

Move all views to a specific a Click Home > Go To Gene/Genomic location.
genomic location A dialog box appears.
b Under Genomic Location, select a Chromosome, and type a
Base Position.
¢ Click Go.
All views move to the selected location.

Display the location of a a Click Home > Go To Gene/Genomic location.
specific gene in the center of A dialog box appears.
all Views b Under RefSeq by Symbol, either select the gene (if
available) or type the name of the gene.
¢ Click Go.

All views move to the location of the selected gene.

Display the data selected in * InTab View, click any entry in any table, except a column

Tab View in the center of heading.

Chromosome and Gene Views Chromosome and Gene views: The genetic location of the
selected data appears in the center of Chromosome and
Gene Views.

Scroll to a specific columnin  a In Tab View, right-click any column heading, then click
Tab View (for the selected Scroll To Column.
chromosome) The Scroll to Column dialog box appears. See “Scroll to
Column” on page 214.
b In Select Column, select the column.
¢ Click OK.
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To do this Follow these steps

Search for a specific column  a In Tab View, right-click any entry except a column heading,
entry in Tab View, and move then click Find in column.
the cursor there The Find in column dialog box appears. See “Find in
column” on page 197.
b Set the search parameters, then click Find Next.
The program searches the column using your search
parameters, and highlights the row of the first entry that
matches. The cursor moves to the location defined in the
highlighted row.

Display the exact At the bottom of the main window, look at the first cell of the
chromosomal location of the  Status bar. The location appears as the chromosome followed
cursor by the base position. For more information on the status bar,

see “Status Bar” on page 165.
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Displaying Content (Gene Lists/Tracks)

To show gene lists in Gene View

A gene list is a set of genes of interest. Within the program, you can
highlight the genes in the gene list in Gene View, or limit the display of
data, genes, and tracks to the regions selected by a gene list.

You can import gene lists into Agilent Genomic Workbench, and you can
also create them in the program and export them. See “To import a gene
list” on page 66, and “To export a gene list” on page 73.

In Gene View, the names of all genes normally appear in gray. When you
apply a gene list, the program highlights the listed genes in their defined
display color. You can also limit the genes and/or data that appear in
Gene View and Chromosome View to only the listed genes.

1 In the My Entity List pane of the Navigator, expand the Gene List
folder. If the gene list does not appear, create or import it. See “To
create a gene list” on page 65, or “To import a gene list” on page 66.

2 Right-click the gene list, then do one of the following to apply it:

¢ To show all genes and all data, and highlight the listed genes in their
display color, click Highlight.

¢ To show only the listed genes and only the data for those genes, click
Show only.

Gene and Chromosome views change accordingly. In the My Entity List
pane of the Navigator, the name of the gene list appears in italics.

To remove the effects of a gene list, right-click the active gene list in
the Navigator, then click Show All.
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To select gene list display color

In Gene View, the names of all genes normally appear in gray. When you
apply a gene list, the program highlights the listed genes in their defined
display color. You can customize this color.

1 In the My Entity List pane of the Navigator, expand the Gene List
folder.

2 Right-click the name of the gene list whose color you want to change,
then click View in Table.

The Gene List dialog box appears.
3 Under Color, click Color.

A dialog box appears.
4 Select the desired color.

The dialog box offers three different ways to select the color. See “To
select gene list display color” on page 91.

5 Adjust the color as desired, then click OK.
6 In the Gene List dialog box, click OK.

To display a gene list as a table

You can display the description of a gene list and the names of the genes

in it.

1 In the My Entity List pane of the Navigator, in the Gene List folder,
right-click the desired gene list, then click View in Table.

The Gene List dialog box appears. See “Gene List” on page 199. The
names of the genes appear in Gene Names. You can also use this dialog
box to edit the description of the gene list, or to change its display
color. To change the display color, see “To select gene list display
color” on page 91.

2 When you are finished displaying the list, click OK.

You can also export a gene list. See “To export a gene list” on page 73.
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To change the appearance of genes in Gene View

You use the User Preferences dialog box to change the appearance of the
genes in Chromosome and Gene views.

1 Right-click any part of the Gene View, then click User Preferences.

The User Preferences dialog box appears.

2 Click Tracks.

See “Tracks tab” on page 231.

3 Do one or more of the following:

To do this Follow these steps

Show or hide genesin Gene  a
View

Change the display font for a
genes (and track annotations)
in Gene View b

Change the display angle for  a
genes (and track annotations)
in Gene View

Under Visualization Parameters:
To show genes — Under Genes, mark Show Gene Symbols.

To hide genes — Under Genes, clear Show Gene Symbols.
Click Apply.

In the Gene Symbols tab, under Font, select a new Font,
Font Style, and Font Size.
Click Apply

Under Visualization Parameters, under Genes, in
Orientation (Degrees), type a new orientation in degrees.
0° is horizontal.

Click Apply.

4 Click OK.

To show tracks in Gene View

Tracks contain information for specific genomic locations. A multitude of
tracks from diverse sources is available for many species. You can display
tracks next to genes and microarray data in Gene View.

1 Select and show microarray data. See “To select an experiment” on

page 78.

In the My Entity List pane, open the Tracks folder.

Right- click the track you want to display, and click Show In UL
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Or, you can do this:

1 In Gene View, right-click anywhere within the scatter plot, then click
User Preferences.

The User Preferences dialog box appears. See “User Preferences” on
page 231.

Click Tracks.
Mark the Show In UI check box of each track.
4 Click OK.

The program displays the selected tracks in Gene View.

To change the appearance of tracks

In the Tracks tab of the User Preferences dialog box, you can change the
appearance of tracks as described in the table below.

To do this Follow these steps

Include track information in a Inthe list of tracks, in the Show in Report column, mark the
reports check boxes of the desired tracks.
b Click Apply.
Doing this adds a column with the hits from the track file. For
each aberrant interval, it reports the entries from the track file
for that interval in that separate column.

Show or hide annotations in » To show annotations in all tracks: under Tracks, mark Show
all tracks Annotations.
» To hide annotations in all tracks: under Tracks, clear Show
Annotations.

Display all selected tracks as  * Under Tracks, mark Show Overlaid.
a single track The program combines the annotations of all selected
tracks into a single track named Overlaid Track.
+ To show tracks individually again, clear Show Overlaid.

Display the parameters and * Inthe list of tracks, for the desired track, click Details.
the list of annotations of a
track
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To do this Follow these steps

Change the display font for a Under Font, select a new Font, Font Style, and Font Size for
track annotations (and genes) track annotations.
b Click Apply.
The program changes the display font of track annotations
and genes in Gene View.

Change the order in which The order of tracks in the Gene Symbols tab controls the
tracks appear in Gene View. left-to-right order of tracks in Gene View.

a Click the name of the track you want to move.

b Do any of the following:
To move the track up in the list of tracks (and farther left
in Gene View), click its name, then click Up.
To move the track down in the list of tracks (and farther
right in Gene View), click its name, then click Down.

¢ Click Apply.

Change the display angle of » Under Genes, in Orientation, type a new orientation (in
track annotations (and genes) degrees). 0° is horizontal.
The program changes the display angle of track annotations
and genes in Gene View.

To show track information in reports

1 In the list of tracks, in the Show in Report column, mark the check
boxes of the desired tracks.

2 Click Apply.
Doing this adds a column with the hits from the track file. For each

aberrant interval, it reports the entries from the track file for that interval
in that separate column.

The annotations that are displayed in tab view are taken from the design file. This may
include names of genes and other annotations. The positions of these genes may also be
supplied as a separate Gene track and may contain unnecessary information.
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To limit data to the genomic boundaries of the track

1 In the list of tracks in My Entity List, right-click the track whose
boundaries you want to use to limit the display of the data.

2 Mark Genomic Boundaries.

You can remove the boundaries by clearing the check box.

To display a track in UCSC Browser

1 In the My Entity List pane, expand the Tracks folder and find the track
you want to view in the UCSC browser.

2 Right-click the track name, and click Show in UCSC.

The UCSC Browser appears, if you are connected to the Internet
(Figure 17). You may have to enable pop ups or set your other browser
preferences on the UCSC browser Web site.

3 Follow the instructions on the web site for what you want to do.

To upload a track to UCSC Browser

1 Right-click Gene View, and click Upload Track to UCSC.
2 The Upload Track to UCSC dialog box appears.

Complete the dialog to define the track you wish to upload. See
“Upload Track to UCSC” on page 229.

The UCSC Browser appears, if you are connected to the Internet
(Figure 17). You may have to enable pop ups or set your other browser
preferences on the UCSC browser Web site.

3 Follow the instructions on the web site for what you want to do.
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To change the graphical display to a different genome build

The default graphical display for Genome, Chromosome and Gene Views
represents human genome build 18.

* To change the graphical display to a different genome build, select an
experiment whose data are based on a design file of a different genome
build.

The display automatically changes when you select an experiment that
contains a design file with a different genome build, such as human
genome build 17, or a mouse or rat genome build.

If a genome build is not available for the design file you import, you must
import the genome build first. See “To import a genome build” on page 46.

The program will not let you add arrays that belong to one genome build
to an experiment that contains arrays of a different genome build.

See also “To create a new experiment” on page 51, “To add arrays to an
experiment” on page 53, and “To select an experiment” on page 78.
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To search Tab View for specific probe information

You can find a specific entry in a column of a data table in Tab View. For
more information on Tab View, see “Tab View” on page 161.

1 In Tab View, right-click anywhere in the column you want to search,
then click Find in column.

The Find in column dialog box appears. The search column also
appears in the title bar of the dialog box.

The Find in column function works within the selected chromosome.

2 Set the search parameters, as described below.

Parameter Comments/ Instructions

Find in column + Type the text you want to find (the search term). This can be an entire
entry, or part of one.

Direction + Select one of these options:
Up — Search the column upwards from the current cursor location
(the highlighted row of the table).
Down — Search the column downwards from the current cursor
location (the highlighted row of the table).
Tip: Click a row in Tab View to highlight it.

Conditions * Mark any of these, as desired:
Match Case — Find entries that match upper and lower case
characters in the search term.
Match whole word — Find an entry only if the entire entry matches
the search term.

3 Click Find Next.

If the program finds a match, it highlights the row that contains the
matching entry, and resets the cursor to the corresponding position.
You can click Find Next as many times as you want, and the program
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continues to search for additional matching entries in the column. If it
finds no match, the message: String not found appears in black in the
lower part of the dialog box.

4 When you complete your search, click Cancel to close the dialog box.

To search Agilent eArray for probe information

You can use the chromosomal region that appears in Gene View, or
another chromosomal region as the basis for a probe search on the Agilent
eArray Web site. eArray is a powerful microarray design system for CGH,
ChIP and gene expression applications. It contains a massive database of
validated, annotated probes, and a full complement of tools for custom
microarray design.

Before you can search for probes in eArray, you must register for an
eArray account if you do not already have one. For more information, go
to https://eArray.chem.agilent.com. Provide your eArray user name and
password in the Miscellaneous tab of the User Preferences dialog box. See
“User Preferences” on page 231.

1 In Gene View, right-click anywhere in the plotting area, then click
Search probes in eArray.

The Search probes in eArray dialog box appears. See “Search Probes in
eArray” on page 215.

2 Do one of the following to define the chromosomal region for your
search:

¢ To set the region to the one that currently appears in Gene View,
select For complete gene view.

¢ To set the region numerically, select User Defined, then select a
Chromosome and type Start and Stop locations for the desired
region.

3 Click OK.

The eArray Web portal opens in your internet browser.
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To search the Web for information on probes in Tab View

You can use any entry in a table in Tab View as the basis for a Web
search.

1

In Tab View, right-click any data table entry other than a column
heading.

Click one of the available sites.

If the site of interest does not appear in the shortcut menu, you can
create a custom search link. See “To create a custom Web search link”
below.

The selected site opens in your Internet browser. The program sends
the table entry to the site as a search string.

To create a custom Web search link

If you need to search a different database or site based on data table
entries, you can create your own custom search link. When you right- click
a table entry in Tab View, a shortcut menu opens, and your custom link
appears in it. If you select this link, Agilent Genomic Workbench opens the
site in your Web browser and sends the table entry to the site as a search
string.

1

Right-click any data table entry in Tab View, except a column heading,
then click Customize Link.

The Customize Search link dialog box appears. See “Customize Search
Link” on page 182.

2 Click New.
3 In the Input dialog box, in URL name, type a name for the link.

This name will appear in the shortcut menu that opens when you
right-click a data table entry.

4 Click OK.
5 In URL, type the complete URL needed to send a search string to the

site. Use <target> as the query string value.

For example, this URL sends selected table entries to Google.com:
http://www.google.com/search?hl=eng&g=<target>

Click Update, then click Yes.
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To update or delete a custom Web search link

1 Right-click any data table entry in Tab View other than a column
heading, then click Customize Link.

The Customize Search link dialog box appears.

2 In URL Name, select the custom search link to update or delete.

3 Do one of the following:

To do this

Follow these steps

Update a Web search link

Delete a Web search link

a Edit the URL name and the URL as needed.
b Click Update.

A Confirm dialog box appears.
¢ Click Yes.

» Click Delete.

4 Click Close.
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This chapter gives instructions on how to set up the analysis functions for
Methylation (CH3) Analysis experiments. These include the Preprocessing,
Analysis and Reports tabs.
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Working with Methylation Options

104

For a detailed description of the Methylation (CH3) analysis tabs and their
commands — Preprocessing, Analysis, Reports — see Chapter 5,
“Methylation (CH3) Analysis Reference”.

Home Sample Manager Preprocessing Analysis Reports Miew Help

Figure 18  Tabs available in the CH3 application

Table 1 describes the sections in this chapter and the tasks you do during
interactive analysis.

Table2  Methylation analysis topics

Subject See these topics

Changing Preprocessing ~ “To combine (fuse) arrays” on page 105

and Analysis options “To set up a moving average (Log Ratio) calculation to smooth the
data” on page 107

“To set up a moving average (ZScore) calculation to smooth the
data” on page 108

“To apply methylation (CH3) event detection” on page 109
“To apply BATMAN (Bayesian Tool for Methylation Analysis)” on

page 110
Displaying results and “To display results of analysis” on page 111
generating reports “To upload a track to UCSC” on page 113

“To save a result” on page 114

“To restore a saved result to the display” on page 115
“To generate a probe report” on page 115

“To generate a Batman report” on page 118
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Changing Preprocessing and Analysis options

To combine (fuse) arrays

If you have two arrays that use different design files, you can combine
(fuse) them into one larger virtual array. You do this to increase the
coverage of the genome in your design. If for example, you have a catalog
array, you can design another array to add probes between the catalog
probes to increase the density of coverage. With the Fuse function, you
can combine the array data to see all the probe data in the display at
once. The program cannot combine arrays from more than two different
design files.

Requirements for fusing arrays:
e Each array has a different design file.

¢ All of the arrays are of the application type. (For this application,
CH3.)

* None of the arrays are fused arrays.

e The samples you hybridize to the arrays are all aliquots from the
same preparation.

e (Preferred) Hybridization and labeling occur for all samples together
under the same conditions.

1 Create and select a new experiment. See “To create a new
experiment” on page 51 and “To select an experiment” on page 78.

2 Add the arrays to be combined to the experiment. See “To add arrays
to an experiment” on page 53.
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3 Assign the same value to the ArraySet attribute of every array you
want to combine. Follow these steps for each array:

d

In the Experiment pane of the Navigator, right-click the name of the
array, then click Show Properties.
The Microarray Properties dialog box appears.

Next to the ArraySet attribute, under Value, click E
A text box appears.

Type a value in the text box. Type the same value for the ArraySet
attribute of every array.

Click Close.

4 In the Preprocessing tab, under Combine, click Fuse.

The Array Set dialog box lists the arrays to be combined. See “Array
Set” on page 169.

Double-check the values in the ArraySet Attribute column of the dialog box. Agilent
Genomic Workbench combines all of the array pairs that have the same value for this
attribute.

b5 Set any of these options, as desired:

¢ Select Normalization — Select None or Centralization. Centralization

adds or subtracts a constant value from each log ratio measurement.
This recenters the log ratio values, and makes sure that the
zero- point reflects the most common ploidy state.

Remove arrays from experiment after fuse — To delete the initial
individual arrays from the experiment, mark this option so that the
experiment will not contain duplicate data.

6 Click Continue.

The program combines the arrays. The new array appears in the
Experiment pane of the Navigator in a new design folder within the
active experiment. The folder name contains the names of both designs.
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+ If the original arrays change, you can manually update the combined array. Fuse the
same set of arrays again.

+ If you want to combine many arrays, consider importing an array attributes file. See “To
import array attributes” on page 48.

+ When you combine (fuse) arrays, the centralization algorithm (if selected) is applied to
the individual arrays before they are combined.

To set up a moving average (Log Ratio) calculation to smooth the
data

With the Moving Average tool, a moving average is computed for each
point in the data set using a sliding window of fixed size, centered on that
point. This algorithm uses the pre-algorithm probe log ratios to calculate a
moving average line plot. See “Visualization algorithms” on page 245.

1 In the Analysis tab, under Moving Average, mark or clear Show to
show or hide the Moving Average Line Plot.

2 In Algorithm, select Linear or Triangular.

¢ Linear - The linear algorithm calculates a standard, unweighted
average using every probe Log Ratio score within a specified window
size (specified by either a number of adjacent measurements or a
positional range). This average is applied sequentially to every point
by moving the window along the chromosome. See “Moving average
(linear smoothing)” on page 261.

¢ Triangular — The triangular algorithm calculates a weighted average
using every probe Log Ratio within a specified window size. The
triangular algorithm is more sensitive to localized variations in the
data. See “Triangular smoothing” on page 262.

3 In Line width, select the thickness (in pixels) of the Moving Average
Line Plot.

The range is 1-5 pixels.
4 In Window, select the size of the moving average window.

Moving averages are computed with windows of sizes based on either a
specific length of base-pairs (5 Kb to 50 Kb or .1 Mb to 50 Mb) or a
fixed number of data points (1 pt. to 60 pt.).
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To set up a moving average (ZScore) calculation to smooth the data

The Moving Average (ZScore) applies a moving average to each point in
the combined methylation Z-score data set using a sliding window of fixed
size, centered on that point. This algorithm uses the post algorithm
combined Z-scores to calculate a moving average line plot. See “Overview
of Methylation Detection and Visualization Algorithms” on page 244.

1 In the Analysis tab, in the Moving Average (ZScore) group, mark or
clear Show to show or hide the Moving Average Line Plot.

2 In Algorithm, select Linear or Triangular. See “Visualization
algorithms” on page 245.

Linear - The linear algorithm calculates a standard, unweighted average
using every combined Z-score within a window size (that is defined by
either a number of adjacent measurements or a positional range). This
average is applied sequentially to every point by moving the window
along the chromosome. See “Visualization algorithms” on page 245.

Triangular — The triangular algorithm calculates a weighted average
using every combined Z-score within a specified window size. The
triangular algorithm is more sensitive to localized variations in the data.
See “Triangular smoothing” on page 262.

3 In Line width, select the thickness (in pixels) for the Moving Average
Line Plot.

The range is 1-5 pixels.

4 In Window, select the size of the moving average window, or type the
size of the window.

Moving averages are computed with windows of sizes based on either a
specific length of base-pairs (5 Kb to 50 Kb or .1 Mb to 50 Mb) or a
fixed number of data points (1 pt. to 60 pt.).

The window can be set manually to as low as .5 Kb (type .5 Kb).
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To apply methylation (CH3) event detection

The purpose of a methylation detection algorithm is to identify
methylation sites located within genomic regions such as promoters, CpG
islands, etc. It is used in conjunction with CpG Island tracks that either
already exist in the program’s database or that you import.

1 Set up genomic region tracks (such as CpG islands) in Gene View.

See “To import tracks” on page 47 for instructions on how to import
and display these tracks in Gene View and in the report.

2 Select the experiment now, or after step 3.
See “To select an experiment” on page 78.
3 Click Analysis.

4 Under Probe Methylation Select ZScore, select the algorithm, and then
mark Apply.

The Probe Methylation Status Setup dialog box appears.
See “Probe Methylation Status Setup” on page 211.

5 To select a Tm (melting temperature) mapping file, click Browse and
find the folder containing the file.

6 Select the file, and click Open.

7 Click Continue.

The algorithm is automatically applied if you've already selected the
experiment, or is applied when you select it. To learn how the algorithms

work see “Methylation Detection and Measurement Algorithms” on
page 246.

The Z-score or BATMAN score results appear in a second channel of Gene
View next to the log ratio data. You can now calculate a moving average
for the Z-scores. See the next topic.
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To apply BATMAN (Bayesian Tool for Methylation Analysis)

When BATMAN is selected, a Bayesian tool is used to calculate
methylation results (BATMAN). The BATMAN algorithm reflects the
underlying distribution of CpG dinucleotides by calculating a Gaussian
distribution of methylated sites to give the observed probe signal. The
signal used in BATMAN is either the probe log ratio or the methylation
detection algorithm Z- score. For more information on the BATMAN
algorithm, see “Bayesian tool for methylation analysis (BATMAN)” on
page 256.

1 In the Analysis tab, under Batman, mark the check box to enable the
Batman algorithm.

The Batman Parameter Setup dialog box is displayed. See “Batman
Parameter Setup” on page 170.

2 Complete the Batman Parameter Setup and click Continue to apply the
calculations and show results in the views.
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Displaying results and generating reports

The section shows you how to make sure the analysis results are displayed
automatically after you select an experiment. To learn more about what
the results mean, see “Visualization algorithms” on page 245.

To display results of analysis

After you set up an experiment and analyze it, the program displays the
results automatically in Genome, Chromosome, and Gene Views if the
display is turned on. Figure 19 and Figure 20 show examples of results
displayed in the Gene View. To customize the way the results appear, see
Chapter 3, “Displaying CH3 Data and Other Content”.

Results for probe methylation and log ratios compared to a CpG Island track
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Figure 19  Gene View, showing Z-score data next to log ratios and a CpG Island track
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Results for moving averages within genomic boundaries of CpG Island track
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Figure 20  Gene View, showing moving averages within genomic boundaries of tracks

If the analysis results do not appear in any of the Views

Check these four potential problem areas, in order:

¢ Make sure you have marked the Apply check box. Under Analysis, mark
Apply for Probe Methylation and/or Batman.

* Make sure you have selected the experiment or selected the arrays of
interest. See “To select an experiment” on page 78.

¢ Make sure you have turned on the display for the moving averages or
the Z-score algorithm. Do the following:

1 Right-click any of the Views, and click View Preferences.
2 Click the View tab.

3 Under Data Visibility, in View, select All views, then mark any of
the check boxes for the information to display.
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You can also select a single View.
4 Click OK.
e Make sure you are looking in the correct region of Chromosome View.
See Chapter 3, “Displaying CH3 Data and Other Content” to find out how

to display the Scatter Plot and how to search the View displays to see
results.

To upload a track to UCSC

The program lets you upload methylation results to the UCSC Web site for
further review.

1 Right-click in Gene View and select Upload track to UCSC.

The Upload Track to UCSC dialog box appears. See “Upload Track to
UCSC” on page 229.

2 Complete the dialog box, (mark Methylation Score under Select Track
Source) and click OK.

The track is uploaded to the UCSC Web site (Figure 21). Enable pop
ups or set preferences on the UCSC Web site, if necessary.

3 Follow the instructions on the UCSC Web site to review your data.
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Figure 21  Uploaded track in UCSC browser

To save a result

The program lets you save the current result of the active experiment. You
can run many different analyses in the same experiment, and save each
one. Later, you can restore any of your saved results.

If you are saving a result for the first time for the experiment:
1 In the Experiment pane of the Navigator, right-click the experiment,
and click Save Experiment Result, or

Click Home > Save Experiment Result.

A dialog box asks if you want to save the results of the current
experiment.

Click Yes.

The Save experiment result dialog box appears.

3 Type a name for the result, then click OK.
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If you have already saved at least one result for the experiment:
1 In the Experiment pane of the Navigator, expand the folders of the
current experiment.

The currently selected result, if any, appears in blue in the Results
folder.

2 Click Home > Save Experiment Result or
Right-click the experiment, and click Save Experiment Result.
A dialog box asks if you want to select one of the following actions:

* To replace the current result with another saved result, click
Overwrite Current Result.

¢ To add the current results to the list of experimental results, click
Create New Result.

e To change views to another result without changing the current
result, click Continue Without Saving.

To restore a saved result to the display

1 If necessary, select the experiment that contains the result that you
want to see. See “To select an experiment” on page 78.

2 In the Experiment pane of the Navigator, expand the folder of the
active experiment, then expand its Results folder.

3 Right-click the desired result, then click Restore result.

The restored result appears in Genome, Chromosome, and Gene Views.

To generate a probe report

The probe report includes the following information either for single
chromosomes or the complete genome:

* Log ratio for each event
e Number of probes

e Start and stop of each event
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e Whether the probe is in a CpG island, a promoter, or inside a gene
boundary

* Probable gene for the probe
1 Click Reports, then click Generate Report.
The Probe Methylation Report Setup dialog box appears.

2 To select if you want a report to include the results for the whole
genome or for individual chromosomes, click either Complete Genome
or Per- Chromosome.

3 Click Browse to find the folder for containing the report(s).
4 Type the report name, and click Open.
The report file name has the extension .xls.
5 Click OK.
6 When asked if you want to display the report, click Yes.

If you selected Complete Genome, an Excel spreadsheet appears containing
all the data:
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Figure 22  Excel methylation report for Complete Genome

If you selected Per-Chromosome, the text files for the individual
chromosomes appear in the folder you selected.
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List of text methylation reports for each chromosome

The Batman report includes the following information either for single
chromosomes or for the entire genome:

¢ Cytoband name

¢ Chromosome name

¢ Probe name
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e Start and Stop of each event
1 Click Reports and then select Generate Batman Report.

The Batman Report Dialog dialog box opens. See “Batman Report
Dialog” on page 171.

2 To select if you want a report to include the results for the whole
genome or for individual chromosomes, click either Complete Genome
or Per- Chromosome.

3 Click Browse to find the folder for containing the report(s).
4 Type the report name, and click Open.
The report file name has the extension .xls.
5 Click OK.
6 When asked if you want to display the report, click Yes.

If you selected Complete Genome, an Excel spreadsheet appears containing
all the data:
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Figure 24  Excel Batman report for complete genome
If you selected per-chromosome for the report output, the text files for the
individual chromosomes appear in the folder you selected.
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Methylation (CH3) Analysis Reference

Agilent Genomic Workbench CH3 Application Main Window 122
Switch Application Menu 123

Command Ribbons 124

Navigator 136

Genomic Viewer 152

Status Bar 165

Dialog Boxes 166

Report Format 240

This chapter describes the parts of the Agilent Genomic Workbench main
window that you use to import, organize, manage, export and display
array data and other content. It also describes the tab commands,
shortcut menus, and dialog boxes that can appear.
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Agilent Genomic Workbench CH3 Application Main Window

The main window of the CH3 Application contains the major components
illustrated in Figure 25.
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Figure 25  Agilent Genomic Workbench Lite Edition — CH3 application main window
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Switch Application Menu
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CH3

Q006

Sureselect Target Enrichment

Figure 26  Switch Application menu

The Switch Application menu lets you change to the other data display
and analysis application type in DNA Analytics. Mark the desired
application type.

(Separate license required) Imports, displays, and analyzes array-based
comparative genomics hybridization (aCGH) data in both an interactive
“analyze as you go” mode, and an automated workflow mode.

(Separate license required) Imports, displays, and analyzes ChIP-on-Chip
microarray data in both an interactive “analyze as you go” mode, and an
automated workflow mode.

(Separate license required) Imports and displays data from
microarray-based studies of genomic methylation patterns.

Use the Quality Analyzer function for SureSelect Target Enrichment. See
the SureSelect Quality Analyzer User Guide for more information.
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Command Ribbons

User Preferences

124

9.5 Preferences... i v

When you click a tab, groups of commands or single commands appear at
the top of the tab. This group of commands is called a command ribbon.
The interactive tabs of the CH3 Application include Home, Preprocessing,
Analysis, Reports, View, and Help (Figure 27). This section provides
descriptions of the commands for each of these tabs, as well as for the
Help tab. Descriptions of the remaining tabs are located in the following
guide:

e Sample Manager — Sample Manager User Guide

Home Sample Manager Preprocessing Analysis FReports View Help

GaoTo

- Import Expart SO
g2 <\L| 5 Ceaie ¥ Gene/Genamic ﬁPrint ._g. Exit

Preferences. .. i T i Experiment

location

Figure 27  Tab bar with command ribbon

Home command ribbon

The Home command ribbon displays the functions that let you import,
manage, export and display CH3 data and content for further CH3
analysis.

GoTo

User @ Import Expart T Create & i i ;
._I o = e e b Eﬁz;iﬁenomc EPunt g Exit

Figure 28 Home command ribbon

Opens the User Preferences dialog box with the following tabs:
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Tab

Description

Tracks

Miscellaneous

License

Opens a dialog box that lets you manage which tracks to display in
Genomic Viewer and how they appear. See “User Preferences” on
page 231.

Opens a dialog box where you can select a new location for your
data files and set up access to the eArray web site. See “User
Preferences” on page 231.

Opens a dialog box where you can enter an Agilent Genomic
Workbench application license, if you purchase one after using the
unlicensed version. See “User Preferences” on page 231.

Import Opens a menu of file types that you can import:

Option

Description

Array Files

Design Files

Genome Build

Opens a menu with these options:

» FE File — Opens the Import FE Files dialog box, where you can
select an Agilent Feature Extraction array data file to import.
See “Import” on page 201 and “To import Agilent FE or Axon
data files” on page 41.

+ Axon File — Opens the Import Axon Files dialog box, where you
can select Axon (*.gpr) files for import. See “Import” on
page 201 and “To import Agilent FE or Axon data files” on
page 41.

» UDF File — Opens the UDF Files dialog box, where you can select
a Universal Data File (UDF) to import. See “Import” on page 201
and “To import a UDF file” on page 43.

Opens a menu with these options:

» GEML File — Opens the Import Design Files dialog box, where
you can select Agilent GEML-based (*.xml) array design files for
import. See “Import” on page 201 and “To import Agilent GEML
design files” on page 39.

» Axon Design File — Opens the Import Axon Design Files dialog
box, where you can select Axon (*.gal) array design files for
import. See “Import” on page 201 and “To import Axon design
files” on page 41.

Opens the Import Genome Build dialog box, where you can import

Agilent-supplied genome build files. See “Import Genome

Build” on page 205 and “To import a genome build” on page 46.
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Option Description

Array Attributes Opens the Import microarray attributes dialog box, where you can
select a microarray attributes file. See “Import” on page 201.

Track Opens the Import Track dialog box, where you can select a BED
format track file for import, and create a display name for the track.
See “Import Track” on page 206 and “To import tracks” on page 47.

Experiments Opens the Import Experiments dialog box, where you can select a
ZIP format experiment file for import. See “Import
(experiments)” on page 203 and “To import an experiment file” on
page 49.

Export Opens a menu that lets you export several kinds of files.

Option Description

Experiments Opens the Export Experiments dialog box, where you can select
one or more experiments for export as a single ZIP file. See “Export
Experiments” on page 195 and “To export experiments” on
page 72.

Tracks Opens the Export Tracks dialog box, where you can select one or
more tracks to export as a single BED format file. See “Export
Tracks” on page 196 and “To export tracks” on page 73.

Array Attributes Opens the Export Array Attributes dialog box, where you can select
arrays and their attributes for export. See “Export Array
Attributes” on page 191.

Create Opens the Create Experiment dialog box, where you can create a new,
Experiment empty experiment and add data to it. See “Create Experiment” on
page 178 and “To create a new experiment” on page 51.

Save Experiment Opens a confirm dialog box. Click Yes and the Save experiment result
Results dialog box opens where you enter a name and description for the results
to save.
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Goto Moves the cursor to the location in Chromosome and Gene Views that you
Gene/Genomic  select. See “Go To Gene/Genomic Location” on page 200.
Location

Print Opens the Print window to print the display.

Exit Closes the program.
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Preprocessing command ribbon

The Preprocessing ribbon has a single command you use to prepare for
CH3 analysis: Fuse.

Design

Fuse

Figure29 CH3 Preprocessing command

The Fuse command lets you combine multiple array designs into a larger
virtual combined design. It also lets you combine both intra- and
inter- array replicate probes.

Click to open the Array Set dialog box, where you can select the names of
arrays that are combined, set options, and combine designs together to
form a larger virtual design. See “Array Set” on page 169, and “To
combine (fuse) arrays” on page 105.
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Analysis command ribbon

The Analysis ribbon contains the commands you use for CH3 analysis.

Moving Average (Log Ratio) Moving Average (Z-Score) Probe Methylation Batman
Show Algorithm  Line width Windows Show Algorithm  Line width Window Select Z5core Apply Apply
5 near 199 1 7O ! zMb ') i E Linsar '@ , 1 ! ELL 1| | Zscore Combined % E E

Figure 30  CH3 Analysis ribbon

Moving Average (Log Ratio)

~Moving Average(Log Ratio) i
|
Shoy Algorithm  Line width  Wfindou I

= Linear '%j 1 '%j 2 Mb 'I

Figure 31  Moving Average (Log Ratio) command

The settings under Moving Average(Log Ratio) control the calculation and
display of line plots that represent smoothed log ratio data for each
selected array. These plots can appear in Genome, Chromosome, and Gene
views.

Show Mark this check box to show moving average line plots, or clear the check
box to hide them. You turn the display of moving average line plots for
specific views on or off from the View tab by selecting View Preferences.

In View Preferences, under Data Visibility, select the desired view, then
mark or clear Moving Average. See “View Preferences” on page 236.

Algorithm  Select one of these options:

¢ Linear - The linear algorithm calculates a standard, unweighted average
using every Log Ratio score within a defined window size (specified by
either a number of adjacent measurements or a positional range). This
average is applied sequentially to every point by moving the window
along the chromosome.
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Line width

Window

Show

Algorithm

¢ Triangular - The triangular algorithm calculates a weighted average
using every Log Ratio within a specified window size. The triangular
algorithm is more sensitive to localized variations in the data. See
“Overview of Methylation Detection and Visualization Algorithms” on
page 244.

Select the desired thickness (in pixels) for the moving average line plots.
You can select a thickness from 1 to 5 pixels.

Select the desired size of the moving average window. You can select
either a specific number of base pairs (6 Kb to 50 Mb), or a specific
number of data points (1 pt to 60 pt). You can also type a value. The
program calculates a moving average for each selected array based on a
window of the given size centered on each point in the array.

Moving Average (ZScore)

IMoving Average(Zscore)
Shoy Algorithm  Line width  Wfindow

E Lnear | #11 (#][zmb %:

Figure 32  Moving Average (ZScore) command

The settings under Moving Average (Z-Score) control the calculation and
display of line plots that represent smoothed Z-score data for each
selected array. These plots can appear in Genome, Chromosome, and Gene
views. You must apply the Probe Methylation algorithm first.

Mark this check box to show moving average line plots for the Z-score
data, or clear the check box to hide them. You enable or disable the
display of moving average line plots for selected views in View
Preferences. See “View Preferences” on page 236.

Select one of these options:

¢ Linear - The linear algorithm calculates a standard, unweighted average
using every combined Z-score within a selected window size (specified
by either a number of adjacent measurements or a positional range).
This average is applied sequentially to every point by moving the
window along the chromosome.
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¢ Triangular - The triangular algorithm calculates a weighted average
using every Z-score within a selected window size. The triangular
algorithm is more sensitive to localized variations in the data. See
“Triangular smoothing” on page 262.

Line width  Select the thickness (in pixels) for the moving average line plots. You can
select a thickness from 1 to 5 pixels.

Window Select the size of the moving average window. You can select either a
number of base pairs (5 Kb to 50 Mb), or a number of data points (1 pt
to 60 pt). You can also type a value. The program calculates a moving
average for each defined array based on a window of the given size,
centered on each point in the array.

Probe Methylation

You apply this command to make Z-score calculations to find out whether
a Methylation detection array probe is methylated or unmethylated. See
“Overview of Methylation Detection and Visualization Algorithms” on
page 244.

Probe Methylation
Select ZScore Apply

Z5core Conbined 199 3

Figure 33  Probe Methylation command

Select ZScore  Select the algorithm to use for calculation of probe methylation score.

Apply Click Apply to display the Probe Methylation Status Setup dialog box to
assign a melting temperature (Tm) mapping file, if necessary, to the
experiment. See “Probe Methylation Status Setup” on page 211.
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Batman

Bakman
Apply

B

=l

Figure 34  Batman command

Click Apply to display the Batman Parameters Setup dialog box where you
set the parameters for the Batman tool for calculation and display of
methylation data. See “Batman Parameter Setup” on page 170 for more
information.

Reports command ribbon

Generate Probe

132

Report

Generate Generate
= Probe |3 = Batman
— Report — Report

Figure 35  CH3 Report command

The Reports command ribbon lets you save all the important information
about the Z-score statistics and CpG Island tracks that can help you find
out whether regions of the genome are methylated or not. You use a
spreadsheet program or your Internet browser to open the report files the
program creates. This lets you further display, analyze, and organize the
result.

Opens the Probe Methylation Report Dialog dialog box, where you can
enter a location and a name for the probe report file and select whether
you want individual reports for each chromosome or one report on the
complete genome. See “Probe Methylation Report Dialog” on page 212.

Methylation (CH3) Analysis Guide



Methylation (CH3) Analysis Reference 5

The Methylation Report makes information about the results of the probe
methylation algorithm available in .xml format (complete genome) or in
txt format (individual chromosomes). You can use a spreadsheet program
to open all these files. See “Report Format” on page 240 for a description
of the columns in the report.

Generate Batman Opens the Batman Report Dialog box where you set the parameters and
Report select a location to save the report.

View command ribbon

The View command ribbon lets you change the display of data/results in
Genomic Viewer.

View In Table Cytoband Info Mon-Unique Probes Customn Data
(., View =L, Copy & Show E E E E E
- {w’ Preferences = ¥ v Signal Intensity  Annotation Show In Gene View Highlight Shiow

Figure 36  View command ribbon

View Preferences Opens the View Preferences dialog box where you customize the display of
data and results in the Genomic Viewer. For more information, see “View
Preferences” on page 236.

Copy This command opens a menu with the options listed below. In general, the
Copy command copies pane(s) of the main window to the Clipboard as an
image. You can then paste the image into a document in another program.
See “To copy what you see in the main window” on page 74.

Option Description

All Copies all panes of the main window to the Clipboard as an image.
Navigator Copies only the Navigator to the Clipboard as an image.

Tab View Copies only Tab View to the Clipboard as an image.

Genome view Copies only Genome View to the Clipboard as an image.
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Show

Signal Intensity

Annotation

View In Gene

View

Highlight

Show

Option Description
Chromosome view Copies only Chromosome View to the Clipboard as an image.
Gene view Copies only Gene View to the Clipboard as an image.

Opens a menu with all available elements of the main window. Mark the
check box for the ones to display in Genomic Viewer.

View In Table

Mark the check box to see the red and green raw signal intensities of the
log ratio data in the Tab View.

Mark the check box to show annotations in the Tab View.

Cyto band info

Mark the check box to display cytobands in the Gene View.

NonUnique Probes

Mark the check box to display non unique probes in a different color.

Custom Data

Mark the check box to display custom data in the Genomic Viewer.

Help command ribbon

134

The Help command ribbon lets you display the available Agilent Genomic
Workbench help guides, and get information about software version,
installation history, and check for software updates. Help guides are
opened in Adobe Reader.

Help

Application Sample Data .
0 Guide 0 Manager Viewing '0 Al
Figure 37  Help ribbon for CH3 application
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Table3  Table of Agilent Genomic Workbench Help

Help Command Action

Application Guide Opens the Agilent Genomic Workbench application user guide for the
selected application.

Sample Manager Opens the Sample Manager User Guide, that shows how to use the
Sample Manager module of Agilent Genomic Workbench to organize
microarrays and edit their attributes.

Data Viewing Opens the Data Viewing User Guide that describes how to import,
organize, manage, export and display data and other content (experiments,
gene lists, tracks) within Agilent Genomic Workbench. It is targeted for
users who have no DNA Analytics application license(s).

About Opens a message with information about the version number and
copyright of the program.
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This section describes the parts of the Navigator, and the shortcut menus
and other functionality available within it.

Search

4
=]

Data
4 Data

- | CH3
-4 CGH
[N Designl 1356859211521019

-[GH 014693
-[GHE 014698
-[iGH 014950
[ [GH 018597
B H 018698
[+-[6HEE 021365
4

>
Experiment > 8
4 Experiments

|
|
|
| CGHZ !
-4 MyExperiment J;
=+-[5HEE 021365 [
[=+-Build hg13 |
B4 Arrays |

2 Usz3s0z418{

US23502415 4
Uszasnz415e
T
My Entity List > 8
_ 4 Entities
—}- 4 Gene List
- # ONCOgEnEs
| Tracks
i

>

«4— Search pane

«4—— Data pane

4—— Experiment pane

44— My Entity List pane

Figure 38 Navigator panes

The Navigator (Figure 38) shows the array data, experiments, and other
content stored in Agilent Genomic Workbench. It contains the following

panes:
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Pane

Comments

Search

Data

Experiment

My Entity List

My Networks

Lets you search within any pane of the Navigator for a specific
item (array or build, for example). You must type the entire array
name or term; otherwise, use asterisks (*) as wildcards for
unspecified strings. For example, type *1234" to find any item that
contains “1234". See “Search pane” on page 138.

Contains microarray data files, organized by application type, then
by design and genome build.

Shows all probe groups and microarray designs that are available
to you, organized by folders.In general, you can:

» Expand or collapse folders to show or hide content

* Right-click the name of a folder or item to open a shortcut menu
that lets you take action on the item.

See “Data pane —icons, special text, and buttons” on page 140

and “Data pane — actions and shortcut menus” on page 140.

Contains Agilent Genomic Workbench experiments. Experiments
are organizational units that contain links to microarray data and
design files. In data analysis modules, experiments also contain
saved results.

Contains gene lists and tracks:

» Gene Lists are collections of genes of interest. You can create
them within the program, import and export them, and apply
them to Gene View and Chromosome View.

+ Tracks are collections of annotation or other information that
map to specific genomic locations. You can import, export, and
combine tracks, and display them in Gene View with your array
data and analysis results.

» See “My Entity List pane — Icons, buttons, and special text” on
page 149.

Contains the biological networks/pathways that you found using
Network Search or that you create using a literature search in
eArrayXD. For more information, see the eArrayyp Users Guide.
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Search pane

Detach button

Resize buttons

Search term box

Pane list

138

The Search pane lets you find all occurrences of a specific search term in
the Data, Experiment, and/or My Entity List panes. See “To find specific
content items in the Navigator” on page 62. It also contains several
buttons that you can use to move, hide, show or resize the Navigator.

Search term box Detach Resize

=" [

Search term

l‘lglﬂ » ,I-_J clear button
™~

T ERES { Hext [ -3 Search button

-Search

Scroll buttons Pane list
button

Figure 39  Navigator — Search pane

Click to move the Navigator from the main window of the program and
open it in a new, separate window.

Click to hide, show, or expand the Navigator.

Where you type your desired search term. Search terms are not
case-sensitive, but they must reflect the entire name of an array or other
content item that you want to find. You can use asterisks (*) as wildcards
to represent groups of unspecified characters. For example, type *12345*
to search for any content that contains the string “12345”.

Lets you limit a search to a specific pane. Select the name of the desired
pane from the list. To select all panes, select All Panels. By default, the
program searches all panes.
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Search

hats X 0
| Hext [= -
&ll Panels "~

Figure 40  Search pane selection list

(Show Pane List button, available only if the Pane list is not visible)
Makes the Pane list visible.

“

»

(Hide Pane List button, available only if the Pane list is visible) Hides the
Pane list.

0 (Search button) Searches the pane(s) selected in the Pane list for all
occurrences of the term you typed in the Search term box. If the program
finds a matching item, it expands the folder structure to make the
matching item(s) visible, makes the lettering of each item red and
highlights the item in yellow. Note: The search term is not case-sensitive,
but it must contain the entire name of the desired items.

Scroll buttons  (Available only after a search) Lets you scroll up and down the lists of
highlighted search items after a search.

»  (Clear button, available only after a search) Clears the search term from
the Search term box, and resets the color of any matching item to its
original color.
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Data pane — icons, special text, and buttons

Item Comments

__|  Anunexpanded folder (domain) that contains subfolders or other items.
_1  Anexpanded folder. The items that it contains are visible in the Navigator.
Expands a folder to show its contents.

= Collapses a folder to hide its contents.

LHz A methylation array design. This folder contains array data for the design, organized by
genome build.

CiH A CGH array design. This folder contains array data for the design, organized by genome
build.

Exp A gene expression array design. This folder contains array data for the design, organized
by genome build.

CHp A ChlIP array design. This folder contains array data for the design, organized by genome
build.

Build A genome build folder within a specific design folder. This folder contains arrays for the
specific genome build and design.

- A single array data file.
B8 Data created from a multi-pack array.
red text An item that matches the search term in a search.

el (Dock out button) Moves the Data pane from the Navigator, and opens itin a, separate

window.

- (Collapse button, available only if the Data pane is not collapsed) Collapses the Data
pane, and shows its title bar at the bottom of the Navigator.

= (Expand button, available only if the Data pane is collapsed) Expands the Data pane.

Data pane — actions and shortcut menus

The Data pane of the Navigator shows available content items that are
stored on your server for the selected application type, and any external
content that you imported.
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¢ Double-click any folder to expand or collapse it.

Data Folder

¢ Double-click a data type folder (CGH, ChIP, Expression, or CH3) to
expand it and display its contents.

¢ Double-click a design folder to display the genome builds for the design.
* Double-click a build folder to display the imported arrays for that build.

Design Folder

¢ Right-click the name of a design folder to display these options:

Option Description

Update from eArray Updates the annotations for your array design from the eArray Web
site. Agilent regularly updates annotations in eArray as new ones
become available. See “To update probe annotation in design files” on
page 63.

Note: In order to use this function, you must enter your eArray
Username and Password in the Miscellaneous tab of the User
Preferences dialog box. See “User Preferences” on page 231.

Delete Opens a Confirm dialog box. If you click Yes, the program permanently
deletes the design and all arrays associated with it.

Genome Build Folder

¢ Right-click the name of a genome build folder to display these options:

Option Description

Show Properties Opens the Design Properties dialog box. See “Design Properties” on
page 183.

Delete Opens a Confirm dialog box. If you click Yes, the program permanently

deletes all of the arrays in this genome build folder.

Individual Arrays

* Right-click the name of an array to display these options:
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Option Description

Show Properties Opens the Microarray Properties dialog box. See“Microarray
Properties” on page 208 and “To display or edit the attribute values of
a specific array” on page 59.

Rename Opens an Input dialog box, where you can type a new name for the
array. Click OK to rename the array.

Delete Opens a Confirm dialog box. If you click Yes, the program permanently
deletes the array.

* Drag an array from the Data pane to an experiment folder in the
Experiment pane to associate it with an experiment. You can drag
multiple arrays at once from one genome build in a design. Hold down
the ctrl key and click the additional arrays to select them. You can also
select a contiguous block of arrays; click the first array in the block,
then hold down the Shift key and click the last one.
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Experiment pane — icons, special text, and buttons

Item Comments

Click to expand a folder and display its contents.
= Click to collapse a folder and hide its contents.
3 A folder that contains files or other folders.

LHz A methylation array design. This folder contains array data for the design, organized by
genome build.

CiH A CGH array design. This folder contains array data for the design, organized by genome
build.

Exp A gene expression array design. This folder contains array data for the design, organized
by genome build.

CHp A ChlIP array design. This folder contains array data for the design, organized by genome
build.

Build A genome build folder within a specific design folder. This folder contains arrays for the
specific genome build and design.

=) Anarray thatis not selected for view and analysis.

E] An array that is selected for view and analysis. The specific color of this icon can vary.
€l Acalibration array.

- An empty folder.

Fatel Data created from a multi-pack array.

blue  The active experiment. All data and results that appear in Chromosome, Gene, and Tab
text  Views are from this experiment.

red text An item that matches the search term in a search.

] (Dock out button) Moves the Experiment pane from the main window, and opens it in a,
separate window.

4

- (Collapse button, available only if the Experiment pane is not collapsed) Collapses the
Experiment pane, and shows its title bar at the bottom of the Navigator.
= (Expand button, available only if the Experiment pane is collapsed) Expands the

Experiment pane.
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Experiment pane — actions and shortcut menus

4
a

Expetiment
_ Experiments
-] CGH_ExP
[h-_ 4 CGH Four-Pack,
- [HEE 014698
E+-Bild hats
1 Arrays
il USZ2502705_251469814934_S01_CiaH-v4 95 Feb07 1 1
B Usze502705 251460814934 501 CGH-v4 95 Feb0? 1 2
B Usz2502705 251460814935 501 CGH-v4 95 FebO? 1 1
E 7 US22502705_ 251460814935 501 CGH-v4 95 Feb0? 1 2
o g Calibration Arrays
[ _ 4 Results

R W =H Four-Pack Result

Figure 41  Expanded Experiment Pane

You can use many items in the Experiment Pane of the Navigator to open
shortcut menus or take other actions.

¢ In general, double-click the Experiments folder within the Experiment
Pane, and the folders within it, to expand and collapse them. Exception:
Double-click the name of an unselected experiment to select it for
analysis. This action opens the Experiment Selection dialog box. To
select the experiment for analysis, click Yes.

Experiments Folder

¢ Right-click the Experiments folder to display these options:

Option Description

New Experiment Opens the Create Experiment dialog box (see “Create Experiment” on
page 178), where you can name the new experiment, and open
another dialog box that lets you add microarray data to the
experiment. See “To create a new experiment” on page 51.

Export Opens the Export Experiments dialog box, where you can export one
or more experiments as a single ZIP file. See “Export Experiments” on
page 195 and “To export experiments” on page 72.
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Specific Experiment Folder

¢ In the Experiments folder, right- click the name of a specific experiment
folder to display these options:

Option

Description

Select Experiment

Deselect Experiment

(Appears only if the experiment is not selected.) Opens the
Experiment Selection dialog box, which asks if you want to select the
experiment. Click Yes to select the experiment for display and
analysis.

Or, in the Experiments folder, double-click the name of an experiment
that is not selected to open the Experiment Selection dialog box. To
select the experiment for analysis, click Yes.

If you switch experiments, a Confirm dialog box asks if you want to
save the current result. Select one of these options:

» Overwrite Current Result — Replaces the selected experiment
result in the Data Navigator with the result that appears on your
screen.

» Create New Result — Opens the Save experiment result dialog box,
where you can save the result that appears in the main window as
a new experiment result. See “To save a result” on page 114.

» Continue Without Saving — The program does not save the result
that appears on your screen.

In some cases, the Confirm dialog box offers only Yes and No choices.

If you click Yes, the Save experiment result dialog box appears, where

you can save the result that appears on your screen with the name of

your choice.

(Appears only if the experiment is selected.) If the results are unsaved,
a Confirm dialog box opens with these options:

* Overwrite Current Result — Replaces the selected experiment
result in the Data Navigator with the result that appears on your
screen.

» Create New Result — Opens the Save Experiment result dialog box,
where you can save the result that appears on your screen as a
new experiment result.

» Continue Without Saving — The program does not save the result
that appears on your screen.

In all three cases, the program then removes the experiment data and

results from all views.
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Option Description

Show Properties Opens the Experiment Properties dialog box. Use this dialog box to
see the names of the arrays in the experiment, and also to add or
remove arrays from the experiment. See “Experiment Properties” on
page 188.

Sample Attributes Opens the Sample Attributes dialog box, where you can change the
values for the attributes assigned to the arrays in the experiment. See
“Sample Attributes” on page 213. To add new attributes you must use
the Sample Manager. See Sample Manager User Guide.

Export Opens the Export Experiments dialog box, where you can export this
and other experiments as a single ZIP file. See “Export
Experiments” on page 195, and “To export experiments” on page 72.

Export Attributes Opens the Export Array Attributes dialog box, where you can save a
file that contains selected attributes of the arrays in your experiment.
See “Export Array Attributes” on page 191.

Edit Array Color Opens the Edit Array Color dialog box, where you can select a display
color for each of the arrays in the experiment. See “Edit Array
Color” on page 186.

Edit Array Order Opens the Edit Array Order dialog box, where you can change the
order of the arrays in the experiment pane of the Navigator, and in
Chromosome, Gene, and Tab Views. See “Edit Array Order” on
page 187.

Rename Opens an Input dialog box, where you can type a new name for the
experiment. Click OK to rename the experiment.

Delete Opens a Confirm dialog box that asks if you want to delete the
Experiment. Click Yes to delete it.

Note: You can delete any experiment except the selected one.

Design Folder

e In the folder of a specific experiment, right-click the name of a design
to open a shortcut menu with a Delete command. If you click Delete, a
Confirm dialog box opens. Click Yes to disassociate all of the arrays
under the design from the experiment.
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¢ In the folder of a specific experiment, in a specific design folder,
right- click the name of a genome build to display these options:

5

Option

Description

Set for Calibration

Save As Text File

Delete

Use of calibration arrays is not recommended by Agilent. This feature
has been deprecated.

Opens the Save Design dialog box, where you can save all of the data
for the genome build and design within the experiment as a
tab-delimited text file.

Opens a Confirm dialog box that asks if you want to disassociate all
arrays under the design from the experiment. Click Yes to remove the
links between the arrays and the experiment.

Note:

* Ifyou delete a design from an experiment, the program removes the
links between the experiment and the design and its arrays. The
actual design and array data stay in the Data folder.

+ Saved results become unavailable if they involve arrays you delete
with this command.

Individual Arrays

* In a specific experiment, right-click the name of an individual array to

display these options:

Option

Description

Select

Deselect

Select for Calibration

Deselect from
Calibration

(Available only if the array is not already selected) Selects the array for
display and analysis.

(Available only if the array is selected) Removes the array data from
Genome, Chromosome, and Gene views, and excludes it from the
analysis. Also removes the array data from the Selected Arrays tab in
Tab View.

Use of calibration arrays is not recommended by Agilent. This feature
has been deprecated.

Use of calibration arrays is not recommended by Agilent. This feature
has been deprecated.

Methylation (CH3) Analysis Guide

147



b Methylation (CH3) Analysis Reference

Option Description

Rename Opens an Input dialog box, where you can type a new name for the
array in this experiment. Click OK to accept the new name for the
array. The array name is changed only for the selected experiment.

Delete Opens a Confirm dialog box that asks if you want to disassociate the
array from the experiment. Click Yes to remove the link between the
array and the experiment.

Note:

+ Ifyou delete an array from an experiment, the program removes the
link between the experiment and the array. The actual array data
remains in the Data folder.

» You cannot restore an experiment result that includes a deleted
array.

Show Properties Opens the Microarray Properties dialog box, where you can view and
edit microarray attributes. See “Microarray Properties” on page 208.

For array files from the Agilent Feature Extraction program, you can
also view the headers and feature data from the file.

See “To display or edit the attribute values of a specific array” on
page 59.

Edit Array Color Opens the Select Color dialog box, where you can select a display
color for the array. See “Select Color” on page 216.

Edit Array Order Opens the Array Order dialog box, where you can change the order of
the arrays in the Experiment pane of the Navigator, and in
Chromosome, Gene, and Tab Views. See “Edit Array Order” on
page 187.
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My Entity List pane — Icons, buttons, and special text

Item

Comments

=
525
&

red regular
text

colored
italics

red bold
italics

black bold
italics

4

]

Click to expand a folder and display its contents.
Click to collapse a folder and hide its contents.
A folder that contains files or other folders.

An individual gene list or track.

An item that is an exact match with the search term in a search, or a gene list that
has not been applied or that has red chosen as its custom color.

A gene list that has been applied.

A track that is selected for display in Gene View.

A “combined” track that is selected for display in Gene View. A combined track
contains information from two or more individual tracks associated by logical
criteria.

(Dock out button) Moves the My Entity List pane from the main window, and opens
itin a, separate window.

(Collapse button, available only if the My Entity List pane is not collapsed) Collapses
the My Entity List pane, and shows its title bar at the bottom of the Navigator.

(Expand button, available only if the My Entity List pane is collapsed) Expands the
My Entity List pane.

My Entity List pane — Actions and shortcut menus

Gene List folder

¢ Right-click the Gene List folder to open a shortcut menu with an
Import Gene List option. This command opens an Import dialog box
that you can use to import a gene list into the program. See
“Import” on page 201.

¢ Double-click the Gene List folder to show or hide its gene lists.
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¢ In the Gene List folder, right-click the name of a gene list to display
these options:

Option Description

View in Table Opens the Gene List dialog box, where you can view the list of genes.
You can also edit the description of the gene list, and change the
display color of the genes. See “Gene List” on page 199 and “To
display the genes in a gene list” on page 66.

Rename Opens an Input dialog box, where you can type a new name for the
gene list. Click OK to accept the new name.

Delete Opens a confirm dialog box that asks if you are sure you want to
delete the gene list. Click Yes to confirm.

Save As Opens a Save As dialog box, where you can save the gene list as a text
(*.txt) file. See “To export a gene list” on page 73.

Add to gene list Opens the Add gene list dialog box, where you can add the gene list to
any other one in the Gene List folder. See “Add Gene List <name>
to” on page 166 and “To add one gene list to another” on page 67.

Highlight (Available if the gene list is not selected.) Displays all genes in Gene
View, and highlights the genes from the gene list in their display color.
See “To show gene lists in Gene View" on page 90.

Show only (Available only if all genes appear in Gene View, or if the gene list is
not selected) Restricts the genes in Gene View to those on the gene
list. No other genes appear. The program displays the genes in their
display color. See “To show gene lists in Gene View" on page 90.

Show All (Available only for the selected gene list.) In Gene View, displays all
genes, without highlighting. See “To show gene lists in Gene
View" on page 90.

Tracks folder

e Right-click the Tracks folder to display these options:
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Option Comments

Import Tracks Opens the Import Track dialog box, where you can import a
BED format track file into the program. See “Import Track” on
page 206 and “To import tracks” on page 47.

Export Tracks Opens the Export Tracks dialog box, where you can select
tracks for export as a single BED format track file. See “Export
Tracks” on page 196 and “To export tracks” on page 73.

Combine Tracks Opens the Combine Tracks dialog box, where you can
associate two or more individual tracks by logical criteria to
create a new combined track. See “Combine Tracks” on
page 172 and “To combine tracks” on page 68.

Track name
¢ Right-click the name of a track to display these options:

Option Comments

Show in Ul Mark this option to display the track in Gene View next to the
data and results of the selected experiment. See “To show
tracks in Gene View" on page 92.

Show in Report Mark this option to display the track in the reports.

Genomic Boundaries Click to analyze data invoking the genomic boundaries for only
that track. You can choose to do this for only one track.

Show in UCSC Opens the UCSC Genome Browser in your Web browser and
uploads the track. You can then view the track.

View Details Opens a dialog box that displays information about the track.
See “Track” on page 223.

Rename Opens an Input dialog box, where you can type a new name for
the track. Click OK to rename the track.

Delete Opens a Delete Track dialog box that asks if you are sure you
want to delete the track. Click Yes to delete the track.
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Genomic Viewer

Genomic Viewer is the display for the DNA Analytics applications (CGH,
ChIP and CHS3). It includes the three Views — Genome, Chromosome and
Gene Views - the Tab View and the View Cursor.

Genome View

a Resize
y Detach button Q buttons
1 = 3 ES 5 5 r ] o] 10 11 12

Selected
chromosome

13 14 45 16 17 18 19 0 21 22| X h

EEEEEHH E
E
The View Cursor S

F .

Figure 42 Genome View (vertical orientation), with human chromosomes. The X chro-
mosome is selected.
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Genome View shows pictures of each of the distinct types of chromosomes
in the selected genome. A blue box is drawn around the selected
chromosome, and the View cursor appears as a blue line across the
chromosome.

Genome View actions and shortcut menus

Click a chromosome to select it. When you select a chromosome,
Chromosome, Gene, and Tab Views show only genomic regions, genes,
and data for it. The specific location in which you click the
chromosome sets the position of the cursor. See “The View Cursor” on
page 160.

On the selected chromosome, click anywhere to move the cursor. See
“The View Cursor” on page 160. This also moves the cursor in
Chromosome, Gene, and Tab Views.

Right- click anywhere within Genome View to display a menu. If you
click View Preferences, the View Preferences dialog box opens, where
you can set preferences for the display. See “View Preferences” on
page 236.

Click the Detach button ——— (located at the top center of the pane)
to remove Genome View from the main window and open it in a
separate window. To reattach the view, click its Close button [3.

Drag the side or bottom borders of the pane to resize it.

On a border of the pane, click a resize button (for example, 4 or k) that
points away from the pane to move that border all the way to the edge
of the main window. To move the border back to its previous location,
click the other resize button.
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Chromosome View
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Figure 43 Chromosome View, human X chromosome shown

Chromosome View shows a more detailed diagram of the chromosome you
select in Genome View.

¢ Cytobands and a plot area appear next to the chromosome.

* When you select arrays for display, their data appear in the plot
area.

¢ The cursor appears as a solid blue line across the chromosome and
the plot area.

¢ The selected region of the chromosome (if any) appears as a dotted
blue box in the plot area.
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Chromosome View actions and shortcut menus

Click a cytoband, any part of the chromosome, or anywhere in the plot
area to move the View cursor to that location. See “The View
Cursor” on page 160.

Drag the pointer over any part of the plot area to select a chromosomal
region for display in Gene View. Drag parallel to the chromosome. This
also moves the cursor to the center of the selected region. See “The
View Cursor” on page 160.

Right- click anywhere within Chromosome View to display a menu. If
you click View Preferences, the View Preferences dialog box opens,
where you can set preferences for the display. See “View
Preferences” on page 236.

Click the Detach button ——— (located at the top center of the pane)
to remove Chromosome View from the main window and open it in a
separate window. To reattach the view, click its Close button 3.

Drag the side or bottom borders of the pane to resize it.

On a border of the pane, click a resize button (for example, 4 or k) that
points away from the pane to move that border all the way to the edge
of the main window. To move the border back to its previous location,
click the other resize button.
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Figure 44  Gene View, with log ratio data from an experiment and CNV tracks.

Gene View shows a more detailed view of the chromosomal region you

select in Chromosome View. See “Chromosome View” on page 154.

¢ Regions that contain genes appear as small blue boxes. Gene names
appear nearby. You can customize the appearance of gene names.
Also, you can use a gene list to highlight genes of interest, or to
display only the genes in the list. See “To change the appearance of
genes in Gene View” on page 92, and “To show gene lists in Gene

View” on page 90.
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* Log ratio data from selected arrays in the active experiment appear
as a scatter plot. You can also customize the scatter plot. See “To
change scatter plot appearance” on page 85.

¢ The location of the cursor matches the location of the cursors in
other views. See “The View Cursor” on page 160.

¢ The name of the chromosome, and the coordinates and size of the
displayed chromosomal region appear at the top of the pane.

¢ Imported tracks can also appear in Gene View. See “To show tracks
in Gene View” on page 92.

Scatter Plot

Configure Coloring schemes

Methylation Results Log Ratios
E Calar by| Z-score Yalues 'y ! E Color by Log Ratio Values %

Configure Color and Ranges

Figure 45 Scatter Plot command group in CH3 Gene View

You access the scatter plot command group in Gene View or through View
Preferences from the View tab. The commands are different for CGH, ChIP
and CH3 applications. Scatter plots appear in the Chromosome and Gene
Views but only if they have been selected in the View Preferences dialog
box.

Methylation Mark the box to enable the Methylation Results scatter plot. Selection for
Results the CH3 Methylation Results scatter plot lets you color the methylation
results based on Z-score Values.

Log Ratios Mark the box to enable the Log Ratios scatter plot. Selections for the CH3
Log Ratios scatter plot let you color the Log Ratios by Log Ratio Values or
Probe Score Values.
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Configure Colors

158

and Ranges

D [o e

| 4

Fs

Opens the Configure Coloring Ranges and Shades dialog box, where you
can set up the colors and ranges for the Methylation Results and Log
Ratios scatter plots. For more information, see “Configure Coloring Ranges
and Shades” on page 174.

Gene View buttons
Zooms in to see a smaller region in more detail.

Zooms out to see a larger region in less detail.

When in vertical orientation, scrolls up through the genes and data to
lower- numbered chromosomal coordinates.

When in vertical orientation, scrolls down through the genes and data to
higher-numbered chromosomal coordinates.

When in vertical horizontal orientation, scrolls left through the genes and
data to lower-numbered chromosomal coordinates.

When in vertical horizontal orientation, scrolls right through the genes and
data to higher-numbered chromosomal coordinates.

(Resize buttons) The button that points away from Gene View expands the
view. The other button restores the view to its original size. (These
buttons will appear horizontal if the view orientation is horizontal.)

(Detach button) Removes Gene View from the main window, and opens it
in a separate window.

Gene View shortcut menu and other actions

e Click anywhere in the plot area of Gene View to move the cursor to
that location. See “The View Cursor” on page 160.

e Drag an inside border of Gene View to resize the view.

* Right-click anywhere in the plot area of Gene View to display these
options:
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Option

Description

Create Gene List

Upload Track to UCSC

Search Probes in eArray

User Preferences

View Preferences

Opens the Create Gene List dialog box, where you can create a
new gene list based on the selected (or another) chromosomal
region. See “Create Gene List” on page 180 and “To create a
gene list” on page 65.

Opens the Upload Track to UCSC dialog box, where you can set
parameters to upload the track to the UCSC (University of
California at Santa Cruz) Genome Browser in your Web
browser. You can then display the track and use the tools
available in the UCSC Web site to examine the data. See
“Upload Track to UCSC” on page 229.

Opens the Search Probes in eArray dialog box, where you can
set the region to search for probes in eArray.

Opens the User Preferences dialog box, where you can set
user preferences on three separate tabs. See “User
Preferences” on page 231 for more information.

Opens the View Preferences dialog box, where you set
preferences for the Genomic Viewer. See “View
Preferences” on page 236.
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The View Cursor

The View cursor reflects the center of the current chromosomal location of
interest. It appears in several Views:

¢ In Genome View, it appears as a blue bar across the selected
chromosome.

¢ In Chromosome View, it is a blue bar that appears across the
chromosome and across the plot area of the view.

* In Gene View, it is a blue bar that appears across the plot area and
tracks of the view.
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Figure 46  Genomic viewer showing view cursors

The position of the cursor in one view is also the position of the cursor in
all views. The exact chromosomal location of the cursor appears in the
first cell of the Status bar. Several actions change the position of the
cursor:

* In Genome View, click anywhere on a chromosome to move the
cursor to that location.

¢ In Chromosome View, click a cytoband name, part of the
chromosome, or anywhere in the plotting area to move the cursor to
that location.

¢ In Gene View, click anywhere in the plotting area to move the cursor
to that location.

The cursor used in Gene View is the same cursor used for the tracks.
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e In Tab View, click a row of a data table to move the cursor to the
chromosomal location for that row.

Tab View

Resize buttons Detach button Selected Unselected
array array
6}
—_—

rﬁfrays‘ Calibration Arrays \ ‘

ProbeMame | Chriame Stark Stop FeatureMum || Description Mame of Gene| Accession @KS‘E‘ZVXY-D. K562v>¥\"-0.1b

A_14_P136... [chrx 2295446 2295497 9564 Homao sapie,.. [MM_175569,1 |ref|MNM_175,., |-0.005349377 |-0.2633222

A_14_P112... [chrz 2367161 2367216 16456 Homo sapie,.. [MM_003918.1 |ref|MNM_003,., |-0.50595176  |-0,21093377
||A_14_P107... [chri 2440064 2440109 25503 Homo sapie... [MM_001669,1 |ref|MM_001,,, [-0.21492063 |0.040961533

A_14_P115... [chrz 2462555 2462605 13310 Homo sapie,.. [MM_000047.1 |ref|MM_000,., |-0,14865656 |0,3100856

4_14_P13 chr 2517313 2517372 Unknown chr:00251 -0.43687245  |-0,28349552

| 93 o Seoo 49

A_14_P104... [chrz 2745810 2745869 Unknown chr:00274... -0,70064205  |-0,32613337

A_14_P111... [chrz 2843303 2843365 Homo sapie... [MM_015419.1 o F0029343456  -0.3672466
|a_14_P136... [chrz 2936372 2936431 Unknown chri:00293.., |- -0,11707405  |-0,2037653

I A_14_P139... [chrx 3100400 3100459 Unknown chrx:00310.., |- 0,032055993  |-0,40952452 A
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. Selected row
Design tabs

Figure 47 Tab View

Tab View displays design annotation and log ratio data related to the
chromosome you select in Chromosome View.

¢ The exact column content of the tables depends on the specific tab
and design, but it always includes chromosomal locations of probes.

¢ The selected row of data appears highlighted in blue. This row
represents data that corresponds approximately with the location of
the cursor.

¢ Columns of log ratio data appear below the names of the specific
arrays to which they correspond. If an array is selected for display
in Chromosome and Gene views, a colored square appears next to its
name.
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Design tabs

Arrays tab

Selected Arrays
tab

1
k
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e Signal intensity (raw signals) and/or annotations appear if selected
from the View command ribbon.

Tab View tabs and buttons

You can see the following tabs and buttons in Tab View. See Figure 47 for
a diagram that identifies some of these elements.

A separate tab appears for each microarray design included in the active
experiment. The name of the design appears on each tab, along with an
icon:

CHz — A methylation array design
[6H — An aCGH array design.
Exf — A gene expression array design.
[ge — A ChIP-on-Chip array design.
When you click a design tab, the data and annotation for the arrays in the

design appear in Tab View. The program separates the arrays of the
design into the Arrays tab and the Calibration Arrays tab (see below).

(Available when you click a specific design tab.) Contains a table of data
and annotation for all arrays in a design that contain biological data.

Contains a table of data and annotation for the selected arrays from all
designs in the active experiment.

(Resize buttons) The button that points away from Gene View expands the
view. The other button restores the view to its original size

(Detach button) Removes Gene View from the main window, and opens it
in a separate window.
Tab View actions and shortcut menus

¢ (Click the name of an array in a column heading to select the array for
display.

¢ Right-click the name of an array in a column heading to display these
options:
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Option

Description

Rename Array

Remove Array From
Experiment

Select Array

Deselect Array

Edit Array Color

Edit Array Order

Select All Arrays

Deselect All Arrays

Scroll to Column

Opens an Input dialog box, where you can type a new name for
the array. This only changes the name of the array within the
active experiment.

Opens a confirmation dialog box. Click Yes to remove the link
between the array and the active experiment. This command
does not delete the data file from the program. To do this, see
“To remove data or design files from the program” on page 64.

(Available if the array is not selected.) Selects the array for
display. A colored square appears next to the name of the
array.

(Available if the array is selected.) Removes the array data
from scatter plots, and removes the column of the array from
the Selected Arrays tab.

Opens the Select Color dialog box, where you can change the
display color of the array. See “Edit Array Color” on page 186
and “To change the display color of an array” on page 81.

Opens the Edit Array Order dialog box, where you can change
the order in which the names of the arrays in a given design of
the active experiment appear in Tab View and in the Data
Navigator. In Gene View, when you view separate scatter plots
for each array, the plots also appear in this order. See “Edit
Array Order” on page 187 and “To change the order of arrays in
an experiment” on page 54.

Selects all arrays in all designs in the active experiment for
display. All arrays appear in the Selected Arrays tab.

Removes all arrays from display, and from the Selected Arrays
tab.

Opens the Scroll to Column dialog box, where you can select a
column in the current tab. The program then scrolls the data
table in the tab so you can see the selected column. See
“Scroll to Column” on page 214.
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¢ Right-click a heading of a column other than an array data column

to open a shortcut menu with a Scroll To Column option. If you click
this option, the Scroll To Column dialog box appears, where you can

select a column in the current tab. The program then scrolls the data
table in the tab so you can see the column.

Click an entry in a data table to select the row in which it appears.
This also moves the cursor to the location of the data point
corresponding to the selected row.

¢ Right-click a data table entry to display these options:

Option

Description

Find in column

Google
LocusLink

PubMed
UCSC HG15(April ‘03)
UCSC HG16(July'03)
UCSC HG17(May’04)
UCSC HG18(March'06)
UCSC mm8(Feb’06)
UCSC mm9(July’07)
DGV(hg18)

GO

KEGG(HUMAN)

Customize Link

(other options)

Opens the Find in column dialog box, where you can search for
a specific text string within the column you clicked. See “Find
in column” on page 197.

Opens your Web browser, and sends the column entry you
clicked as a search string to the selected site. The UCSC links
search the indicated University of California, Santa Cruz
database related to the indicated genome build. See “To
search the Web for information on probes in Tab View" on
page 100.

Opens the Customize Search link dialog box, where you can
create or edit a custom Web link that appears in this shortcut
menu. When you click a custom link, the program opens your
Web browser, and sends the column entry you clicked as a
search string to the site. See “Customize Search Link” on
page 182 and “To create a custom Web search link” on

page 100.

If other options appear in this shortcut menu, they are custom
Web search links. Click them to open your Web browser, and
send the column entry you clicked as a search string to the
site.
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Cursor position Genome build Ratio type

16:60335453

log2 ratio [Selected Row = 1817 | 2907 x 12 |

Table size

Figure 48  Status bar

Cursor position

Genome build

Ratio type

Selected Row

Table size

The Status Bar displays information related to the displayed data.

The chromosomal location of the cursor. See “The View Cursor” on
page 160.

The genome build for the displayed data.
The mathematical type of the array data. The possible types are:

* ratio
* log, ratio
* log, ratio

* In (natural log) ratio

The row in the displayed data table that is selected. The location of the
cursor is approximately the chromosomal location for this row.

The number of rows and columns in the displayed tab. The size appears
as
<# of rows> x <# of columns>.
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Dialog Boxes

166

This section describes the dialog boxes specific to the interactive analysis
of the CH3 Application. They are listed in alphabetical order by title.

Add Gene List <name> to

Select target
gene list

Build

X Add gene list “oncogenes” fo

Select target gene list Build

genelistz i hig17

Description

S.No iGene Mames |
1 SMKT

2 PAPZD J{
3 LPPR4

4 PALMD

5 FRRS1

=] AL

7 SLC35AS

& HIATL

£l SAS56

10 CCDC7E

11 LRRC39 i
am e v
Genelist Colar: 1l

oK Cancel

Figure 49

Add Gene List <name> to

Purpose: Adds genes from one gene list (the source gene list) to another
(the target gene list).

To open: In the Data pane, right-click the name of a gene list, then click
Add to Gene List.

The gene list to which genes are added. Select one from the list.

(Read-only) The genome build for the genes in the list. The builds of the
two gene lists must match.
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Description  (Optional) Description of the combined gene list.
Listof genes A list of the genes in the target gene list.
Gene List Color (Read-only) The display color of the target gene list.
0K Adds the genes from the source gene list to the target gene list.

Cancel Closes the dialog box without adding any genes to the target gene list.

Agilent Feature Extraction Importer

Micro-Array information

lobal Display Mame : e Flip
U523502418_252808110005_501_CGH_109_Feb10 1 2 Marmal )
11523502418 _252808110006_501_CGH_109_Feb10_1_1 Harrmal 47
1523502418 _252808110006_501_CGH_109_Febl0_1_2 Matrmal g
11523602418 _252808110008_501 _CGH_1010_Auglo_1_1 Matmnal e

Genomic Workbench will create a new array node in the data section of the navigator in interactive mode. The new
node will have the name of the imported File. However, vou can use this dislog to edit the file namels). Additionally,
vou can specify if an array is dve-flipped. In this case the ratios will be inverted, but dye-flip pairs will nat be
automatically combined.

E‘Overwrite arrays with duplicate names. Run in Background | Ok Cancel

Figure 50  Agilent Feature Extraction Importer

Purpose: Lets you edit the name of the FE data file you will import and
to indicate whether you want to flip the red/green ratio for the data.
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To open: In the Home tab, click Import > Array Files > FE File, select
the desired FE data file(s), then click Open.

Name Lets you edit the names of the FE files. You can change the names of the
files to names that are easier to recognize or remember.

Dye Flip For each array:

Select Normal if:

¢ The test samples were labeled with cyanine-5 (red).

¢ The control samples were labeled with cyanine-3 (green).
¢ The imported ratio (test/control) should be reported as is.
Select Flipped if:

¢ The test samples were labeled with cyanine-3 (green).

e The control samples were labeled with cyanine-5 (red).

¢ The imported ratio (control/test) should be reported with the ratio
inverted (test/control).

The program does not combine dye-flip pairs.

Overwrite arrays Mark this option to replace existing file(s) in the program with the
with duplicate  imported one(s), if they have the same name(s).
names

Runin Imports the files, and lets you use your computer for other purposes while
Background the import occurs. This is especially useful if you have many files to
import.

OK Imports the files in the foreground. You cannot use your computer for
other purposes while the import occurs.

Cancel Cancels the entire import process without importing anything.
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Array Set

Table

Select
Normalization

Remove arrays
from experiment
after fuse

Continue

Cancel

A Array Set: Designs 112 and 012

Arrayset Attribuke Array Mame Design 1D Design bype |
deset1 MORMWAY 104512 Designl 135685921152, .. |cgh
drsetl YD, 1 012700 cgh
~ioptions
Select Mormalization | Centralization | ! E Remave arrays From experiment after fuse

Continue Cancel

Figure 51  Array Set dialog box.

Purpose: To select replicate arrays to combine in the analysis.
To open: Click Fuse in the Preprocessing ribbon.

The array set dialog box opens when you combine designs. See “To
combine (fuse) arrays” on page 105.

Displays the arrays that are combined, in order of their values for the
ArraySet attribute. The program creates a separate combined array for
each group of arrays with a given value for ArraySet. The table also shows
the design ID for each array, and the design type.

Select Centralization normalization or none. See “Methylation Detection
and Measurement Algorithms” on page 246.

Deletes the original individual arrays after creating combined arrays so
that the experiment won't contain duplicate data.

Click to create combined designs using the selected options.

Cancels any selections, and closes the dialog box.
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Batman Parameter Setup

Z-score

Select CPG
Window

Select CPG File

Select TM
mapping file

170

'+ Batman Parameter Setup

rZ-score | rSelect CPG Window ]
{ = |
iEUs& Z-score | | 200bp , # |
| L |
E-Sele:t PG File - ]
i I Browse. ., :
[ Selact TM mapping Fibe: - 1
[ Design Name | M map Fle _ Bowse ||
(l023795 A allable - ||
! |
Continue Cancel

Figure 52  Batman Parameter Setup dialog box

Purpose: This dialog box is used to set the parameters for the Batman
tool of methylation analysis. For details on how this algorithm works, see
“Bayesian tool for methylation analysis (BATMAN)” on page 256.

To open: In the Analysis tab, under Batman, mark the Apply box.
Mark Use Z-score to use the Z-score in place of the log ratio values.

Select the local CPG window to use.

Click Browse and select a FASTA file containing sequences with 400 bases
on either side of the center of the probe. The file must be in standard
FASTA format.

If the Tm information is present in the design, the TM map file will
display Available. If the Tm information is not in the design, you must
select a TM file to use. The Tm file must be a tab delimited text file with
probe name and Tm as two columns.
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Continue Click to apply the Batman parameters and display them in the views.

Cancel Click to close the dialog box without applying the Batman algorithm.

Batman Report Dialog

“* Batman Report Dialog

~Repart Type

@Pru:ul:ue Based

~ukput Farmak

@Cumplete GEnome

OPer-ChrDmDsume

~3elect File Location

Browse, ..

Save

Zancel

Figure 53  Batman Report Dialog

Purpose: This dialog box is used to select the output format and location

of the Batman report.

To open: In Reports, click Generate Batman Report.

Report Type  All methylation reports are probe-based.

Output Format Complete Genome - Creates report as .xlIs file for entire genome
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Per- Chromosome - Creates report for each chromosome as .txt file. Open
in spreadsheet program to see headers properly aligned.

SelectFile Click Browse to select a location for the file, and type a file name.

Location
Combine Tracks
Combine Tracks E|
Edit Cormbined track.

Marme kombined Hs Track #55

Track Operatar | Mew Condition
Hs hgts CMv 20080404 =) AND (= =
Hs hglf mifthé& 20050404 ) AND = Delste Condition
Reset Save Close

Figure 54  Combine Tracks dialog box

Purpose: Lets you create a combined track that contains elements of two
or more source tracks, associated by logical criteria. See “To combine
tracks” on page 68.

To open: In the My Entity List pane, right-click the Tracks folder, then
click Combine Tracks.

Name The name of the combined track
New Condition Adds a new, empty row to the Track/Operator table in the dialog box.
Delete Condition Removes the bottom row from the Track/Operator table in the dialog box.

Track In each row, select a track to include in the combined track.
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Operator In each row, select the desired logical operator. This operator controls the
manner in which the program combines the track in this row with the
others. Select one of these options:

Operator Comments

AND Places an element in the combined track if it appears in both this track and any of
the others.

OR Places an element in the combined track if it appears in either this track or any of

the others. If you set this operator for all tracks in the list, the resultis a
nonredundant set of elements from all tracks.

MINUS Removes the elements that appear in this track from the combined track, if they
otherwise appear there.

Reset Removes all Track/Operator pairs from the table in the dialog box, and
clears the Name of the combined track.

Save Creates the combined track, but does not close the dialog box.

Close Closes the dialog box. Opens the Confirm track save dialog box if you
created a combined track, but did not save it.
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Configure Coloring Ranges and Shades

“ Configure Coloring Ranges and Shades

Coloring Ranges and Shades

‘Methylation Results fLDg R‘aticrs‘
4 Color by 4 Log Ratio Yalues
[ JL0g Ratio Values L
.. Prabe Scare Values Min | Max - Colar Add Range
Remove Range Edit Range
Miriirrurm Maneimurn Color Delete/Edic |
-20 5 [ B
5 i B
0 s Il B
5 20 ] B

*You can add maximum & ranges.

Ok Cancel

Figure 55 Configure Coloring Ranges and Shades dialog box

Purpose: This dialog box is used to enter ranges and select colors for
scatter plot options. Tabs show selections for Methylation Results and Log
Ratios options.

To open: In Gene View, move the mouse pointer over Scatter Plot to
display the scatter plot options and then click Configure. Or, click the
View tab and click View Preferences. Under Configure Coloring schemes,
click Configure Colors and Ranges.
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Table4  Methylation Results Parameters

Parameter Description

Z-score Values

Min Type a minimum value for the range.
Max Type a maximum value for the range.
Color Click to open the Select Color dialog box, where you can select the

color you want to display for this range. See “Select Color” on
page 216 for more information.

Add Range Click to add a row to the range table using the values displayed in Min
and Max, and the selected Color.

Remove Range Click to remove the ranges with Edit/Delete box marked.

Edit Range Click to edit range(s) with Edit/Delete box marked.

Range table This table displays the defined ranges, including minimum and

maximum values, color for each range, and Edit/Delete selection.

Table5 Log Ratios Parameters

Parameter Description

Log Ratio Values

Min Type a minimum value for the range.
Max Type a maximum value for the range.
Color Click to open the Select Color dialog box, where you can select the

color you want to display for this range. See “Select Color” on
page 216 for more information.

Add Range Click to add a row to the range table using the values displayed in Min
and Max, and the selected Color.

Remove Range Click to remove the ranges with Edit/Delete box marked.
Edit Range Click to edit range(s) with Edit/Delete box marked.
Range table This table displays the defined ranges, including minimum and

maximum values, color for each range, and Edit/Delete selection.
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Table5 Log Ratios Parameters (continued)

Parameter Description

Probe Score Values

Min Type a minimum value for the range.
Max Type a maximum value for the range.
Color Click to open the Select Color dialog box, where you can select the

color you want to display for this range. See “Select Color” on
page 216 for more information.

Add Range Click to add a row to the range table using the values displayed in Min
and Max, and the selected Color.

Remove Range Click to remove the ranges with Edit/Delete box marked.

Edit Range Click to edit range(s) with Edit/Delete box marked.

Range table This table displays the defined ranges, including minimum and

maximum values, color for each range, and Edit/Delete selection.
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Confirm Overwrite

£ Confirm overwrite

Some of the designs andfor microarrays have been already imported into DRA
Analytics. Select the designs)/microarrays, which you wish ko overwrite,

Select the designs you wish to overwrite,

Design Overwrite
Designl135685921152101915_hgl? =
Designl 13568322571319439176_hgl7

Select Al Deselect Al

Select the microarrays you wish to overwrite,

Brray Mame Ovverwrite
Microfrray121094123,,. |SKBR3E1Z

Microfrrayl21094123... [NORWAY 7412
Mirertreaw] 210941273 (RIORWAY 10412 ¥

Select Al Deselect Al

oK Cancel

Figure 56  Confirm overwrite dialog box

Purpose: When you import an experiment, it can contain designs and/or
arrays that have the same names as those already available in Agilent
Genomic Workbench. This dialog box lets you select which designs and/or
arrays to overwrite.

To open: This dialog box appears when you import a ZIP format
experiment file, and it contains designs and/or arrays that are already
available in Agilent Genomic Workbench. See “To import an experiment
file” on page 49.

Select the designs to overwrite

Design The names of the designs in the imported file that have the same names
as designs that are already available in Agilent Genomic Workbench.

Overwrite  Mark the check box for each design that you want to overwrite.
Select Al Marks all of the check boxes under Overwrite.

Deselect All Clears all of the check boxes under Overwrite.
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Select the microarrays to overwrite
Array The microarray identification, usually a barcode.

Name The names of the arrays in the imported file that have the same names as
arrays that are already available in Agilent Genomic Workbench.

Overwrite  Mark the check box next to each existing array that you want to
overwrite.

Select Al Marks all of the check boxes under Overwrite.
Deselect All  Clears all of the check boxes under Overwrite.

0K Overwrites the selected files (both designs and arrays) and closes the
dialog box.

Cancel Closes the dialog box, and returns you to the Import (experiments) dialog
box. See “Import (experiments)” on page 203.

Create Experiment

Create Experiment g|

Marme [

Description

Properties ok Cancel

Figure 57  Create Experiment dialog box

Purpose: To create an organizational unit in the Experiment pane of the
Navigator to link to array data for display and analysis and to create the
links to the data for the experiment (see “Experiment Properties” on
page 188).

To open: In the Experiment pane of the Navigator, right-click the
Experiments folder, and click New Experiment, or click File > New
Experiment.
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Name Type a name for your new experiment.

Description  Briefly, describe your experiment with information that will help you
identify it.

Properties Click to display the Experiment Properties dialog box where you can
select microarrays to add to your new experiment. See “Experiment
Properties” on page 188.

Do not click OK until you have added arrays to your experiment in the Experiment
Properties dialog box or you will have an empty experiment. You can also add arrays to the
experiment later, by dragging and dropping the arrays from the Data pane of the navigator.
See “To add arrays to an experiment” on page 53.
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Create Gene List

¥ Create Gene List

WEIE] Build
I— e |-
b

Description

~5et Chromosome Start-Stop
Chromosome Stark Stop

[ o
} i

OLlser Defined

@For complete gene wiew

Colar

W | Change...

QK Il Cancel

Figure 58 Create Gene List dialog box

Purpose: To limit the genes presented in Gene View to a preselected
number valuable for interpreting data

To open: Right-click Gene View, and click Create Gene List.
Name Type in name of gene list.
Build Select the genome build for the genes.

Description Describe the type or nature of the genes in the list.

Set Chromosome Start-Stop

Select a chromosome and a region in Chromosome View for selecting the
genes in the list before you open the Create Gene List dialog box.
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User Defined Select to choose region from which the genes in Gene View are selected.
The chromosome selection list and the Start and Stop positions on the Y
axis are enabled when this option is selected. With this option, you can
override the selections you made before opening Create Gene List.

For complete  Select all the genes in Gene View.
gene view

For aberrant  Select those genes that appear in the aberrant region just below the
region below cursor position in Gene View.
cursor

Chromosome If you select User Defined, you can select a different chromosome than
had been selected before opening the Create Gene List dialog box.

Start If you select User Defined, you type in a Start position to define the
region that contains the genes for the list.

Stop If you select User Defined, you type in a Stop position to define the
region that contains the genes for the list.

Color

Change Click to change the color of the gene list name in Data Navigator.
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Customize Search Link

URL Name

URL

New

Update
Delete

Close

Customize Search link

Mote:

In URL field, enter the site url with queny string walue
as"=target=". Example:

http: o, google.comdsearch?hl=endg=<target>

-
LRL name | i)
URL |
Mew Update Delete Close

Figure 59  Customize Search Link dialog box

Purpose: This dialog box lets you create a custom Web search link in the
shortcut menu that appears when you right-click a table entry. The link
opens the URL of your choice, and sends the table entry to it as a search
string. See “To create a custom Web search link” on page 100.

To open: Right-click any entry in a tab in Tab View, other than a column
heading, then click Customize Link.

The name of the custom Web search link that appears in the shortcut
menu (see above). To edit an existing custom Web search link, select it
from the list.

The full uniform resource locator (URL) of the desired search page. For
the query string value, type <target>

For example, this URL sends the selected tab view entry to google.com:
http://www.google.com/search?hl=eng&g=<target>

Opens an Input dialog box, where you can type a name for a new custom
Web search link. Click OK to add the name to the URL name list.

Saves the settings in the dialog box.
Deletes the selected custom Web search link.

Closes the dialog box.
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Purpose: Gives general and detailed information about a given microarray

design. See “To display the properties of a specific design” on page 62.

To open: In the Data pane of the Navigator, right-click the name of a

genome build within a design folder, then click Show Properties. Several

tabs are available.

Attribute tab

Displays general identifying attributes of the array design, and statistics
such as the total number of features in the design. For Catalog designs,

the “Date” field is the date of the downloaded catalog design file.

oy Design Properties

Fribute 'uneProb_es‘!' Data

Mame Walue
WE] 014661
Tvpe chip
Genome build hal7?
Species H. sapiens
Is Fused Design fFalse

Date

05/12/2006 9:29:1

Data Available For Mumber of Chromosomes

21

Mumber of Features

41565

Mumber of Replicate Probes

0

Mumber of Mon Unique Probes

It}

Close

Figure 60  Design Properties dialog box — Attribute tab

Non Unique Probes tab

Displays the nonunique probes in the design. Nonunique probes have more

than one mapping in the genome that is a perfect match.
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# Design Properties

 attribute o Urigus Probes) Dats)
5.Mo Probe Walue |
1 A_18_P10316231 chrl:142689397-142889343 | chr... i
z A 18 P13304487 chrz:87290171-87290230 | chr2:... |£
3 A_18_P16129683 chr7 72252622-72252564 | chiT:... |
4 A_18_P14749132 chr4:75511720-75511778 | chr4:...
5 A 18 P1Z2210664 chr7:57795297-57795241 | chri5...
& A 18 _Plel27424 chr7:72126068-72126023 | chr?:...
7 A 18 P16194541 chr7:5870637-5870589 | chr?:97...
& A_18_P10521542 chrl:220712195-220712239 | chr...
o A_18_P16198767 chr7:101111563-101111622 | chr...
10 A 18 P16194545 chr7:73971446-73971387 | chr?: ...
11 A_18_P10309471 chrl:142503907-142503856 | chr...
12 A 18 P168395817 chr4:132815293-132815234 | chr...
13 A_18_P10309255 chrl:142494051-192494110 | chr...
14 A_18_P15312171 chr5:985869559-965889603 | chrS: ...
15 A 18 P13397924 chrz: 130944 748-130944639 | chr... 3
16 A_18_P16541050 chrz2:94564734-94864793 | chra:.., :
Close
Figure 61  Design Properties dialog box — Non Unique Probes tab
S.No The sequence order of the probes within the tab.
Probe The name of the each nonunique probe.

Value The chromosomal locations to which each of the probes binds. Because
these are nonunique probes, two locations appear for each probe.
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Displays the names of the probes in the design and their target genomic

locations. The tab displays the probes for one chromosome at a time.

4 Design Properties

[ Aittribute’ [ Han Unique Probes‘f‘gﬂ‘

Select Chromosome: | chrl

— =

!

Probe Chromosome Skart Stop |
A_18_P10000009 chri 3179 53223
A_18_P100000Z1 chrl 4753 4304
A_18_P10000034 chrl 8673 5717
A_18_P10000124 chrl 41899 41955
418 _P10000236 chrl 67372 57431
A_158_P10000241 chri 77034 BT
A_158_P10000243 chrl 77303 77364
A_18_P10000247 chrl 79593 7657
A_18_P10000248 chrl 7953 7997
415 _P10000270 chrl 37402 37461
A_18_P10000277 chri 5E790 GE542
A_18_P10000235 chrl 9z164 02213
A_18_P100002%0 chrl 95334 o556
A_18_P10000306 chrl 101380 101419

ar

Close

Figure 62

Design Properties dialog box — Data tab

The chromosome whose probes appear in the list. To display the probes

for another target chromosome, select one from this list.

The name (Probe ID) of each probe.

The name of the chromosome to which the probe is designed.

The location on the selected chromosome of the first base pair for the

probe.

The location on the selected chromosome of the last base pair for the

probe.
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Edit Array Color

Select Array

Color

Select All
Deselect All
Edit Color

Restore default

186

X Edit Array Color

Edit
~Select Color
Select Array | color |
B Example Data 01 -
E Example Data 02 -
Select Al || Deselectall | ;. Ediceler || Restore default
|OK Cancel |

Figure 63  Edit Array Color dialog box

Purpose: To change the color of the arrays in an experiment
To open: Right-click the experiment name, and click Edit Array Color.
Mark the check box for the array(s) whose color you want to change.

Click to change the color for the selected array(s). If you selected more
than one, all the selected arrays will change to the same color.

Click to mark all the check boxes.
Click to clear all the check boxes.
Click to change the color for the selected array(s). Same as Color button.

Click to restore the original color(s) to the selected array(s).
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Edit Array Order

Array Name

Design

Order by

K

X Edit Array Order

Array Mame
EampleChivData0l rDesign
ExampleChYData0z
018897_hgls 'y l
~Order by
Mane I :
Y
v
[0]4 Cancel

Figure 64  Edit Array Order dialog box

Purpose: This dialog box lets you change the order of arrays in an

experiment, which defines the order in which the program displays arrays
and array data in the Experiment pane of the Navigator and in Tab View.
If you select the Stacked rendering style for scatter plots, the array order
also determines the order in which the scatter plots for the arrays appear.

To open: Right-click the name of an experiment, then click Edit Array
Order in the shortcut menu.

The arrays in the selected design, listed in their current order.

Select the name of a design. In Array Name, the program displays the
arrays associated with the selected design.

Select an attribute to use as a basis for ordering the list. For example, if
you select Barcode, the program reordered that Array Name list based on
Barcode.

Moves a selected array up in the Array Name list. To select an array in
this list, click the name of the array.

Moves a selected array down in the Array Name list. To select an array in
this list, click the name of the array.
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0K Applies the new array order.

Cancel Closes the dialog box without making any changes to the array order.

Experiment Properties

Experiment Properties E|
Experiment Name: CGH_EXP
Dreseriphion:
Salect Dwsign
Designs ! Genorme Buids :
Design] 135685521 152101915 = hal? Fr
Arrays
Array List Selected Array List
= TANFORD 33§12 !
Wi 10112 1
i waY 14412
Friz
< WAY 47§12 !
WY 16§12 &
S5 Ta74412 Ll
Display Name by | Global Display Name "%3 o Cancel

Figure 65 Experiment Properties dialog box

Purpose: To select the arrays to link to the experiment

To open: In the Create Experiment dialog box, click Properties, or in the
Experiment pane of the Navigator, right-click the experiment name, and
click Show Properties.

Experiment Displays the name of the selected experiment.
Name:

Description Displays the description of the experiment that was entered when the
Text Box: experiment was created.

Select Design

Designs  Select the design whose arrays you want to add to the experiment.
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Genome Builds Select the genome build for the design you selected, if the design has more
than one genome build.

Arrays

Array List Displays the arrays in the selected design that are available for the
experiment.
* To select an array to move to the Selected Array List, click its name.

e To select additional arrays, hold down the ctrl key and click their
names.

¢ To select a contiguous block of arrays, click the name of the first array,
then hold down the Shiftkey and click the name of the last one.

Selected Array  Displays the arrays that you have selected for the experiment.
List

= Moves the selected arrays in Array List to the Selected Array List. You can
move arrays from as many designs as you want, if they are all for the
same genome build.

= Moves all of the arrays in Array List to the Selected Array List.

- Removes an array from the Selected Array List. To select an array for
removal, click its name. If desired, you can re-add an array.

£ Clears the Selected Array List.

Display name by  Click to select how the array names are displayed in the experiment. The
Global Display name is the name assigned in Sample Manager for the
array. See the Sample Manager User Guide for more information.

OK Adds the selected arrays to the experiment and closes the dialog box.

Cancel Closes the dialog box without making any changes.
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Export

Lookin: | ] Data AGW

| AberrationFesult
| designs

| expresult

| genelist

| genomebuild

| microarrays

__| sparse\Wrapper
| tracks

| udfMappings
| Workflowstatus

File name: IEXP.zip

=
Files of kype:  ZIP =_.,

Expott Cancel

Figure 66  Export dialog box — Several types of file exports use this dialog box. This spe-
cific example exports selected experiment(s) as a ZIP format file.

Purpose: Lets you select a location for an exported file.

To open: This dialog box appears after you select specific experiment(s),
track(s), or array attribute(s) to export. See “To export experiments” on
page 72, “To export tracks” on page 73, or “To export array attributes” on

page 71.

Lookin Displays the folder or other location whose contents appear in the main
pane of the dialog box. To select another folder or other location, click ¥ .

Moves to the next higher folder level.

Displays the Desktop.
£ Creates a new folder in the selected location in Look in.

Displays the names, only, of folders, files, and other locations in the main
pane of the dialog box.
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= Displays both the names and information about folders, files, and other
— locations in the main pane of the dialog box.

Main pane Displays the folders, files, and other locations in the selected location in
Look in. Only files of the selected type are displayed. To select file, click
its name. To open a folder or other location, double-click its name.

File name Displays the name of the file to which the exported content is saved. To
change the name, you can either select a file in the main pane of the
dialog box, or type a new name.

Filesoftype  Sets the type of files that are displayed. To show all files, click ¥ , then
select All Files.

Export Saves the selected content to the location given in the dialog box.

Cancel Cancels your selections and closes the dialog box.

Export Array Attributes

Purpose: This dialog box lets you select arrays whose attributes you want
to export. It contains two tabs: an Array tab where you select the arrays,
and an Attribute tab where you select the attributes of the selected arrays
to export. See “To export array attributes” on page 71.

To open: In the Home command ribbon, click Export > Array Attributes,
or in the Experiment pane of the Navigator, right-click the name of an
experiment, then click Export Attributes.
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Designs

Genome Builds

192

Array List

Array tab

Export Array Attributes

fﬁ\' Atribute’
‘Select Design-

Designs ¢ Genome Builds :

Designl 135685921 152101915_hgl? | = hgl? s

| Arrays

Array List Selected Array List
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HORWAY 7512 | <
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MORYAY 11512 B i

=5

Mext = || 3 || Zancel

Figure 67  Export Array Attributes dialog box — Array tab

Select Design

Displays all of the designs available in the program. Select the design for
arrays that you want to export.

Displays the genome build(s) for the design. Select the desired genome
build to display the arrays for a single genome build.

Arrays

Displays the arrays in the selected design that are available for export.
¢ To select an array to move to the Selected Array List, click its name.

¢ To select additional arrays, hold down the ctrl key and click their
names.

¢ To select a contiguous block of arrays, click the name of the first array,
then hold down the Shiftkey and click the name of the last one.
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Displays the arrays that you have selected for export.

5

Moves the selected arrays in Array List to the Selected Array List. You can
move arrays from as many designs as you want, as long as they are all for

the same genome build.

Moves all of the arrays in Array List to the Selected Array List.

Removes an array from the Selected Array List. To select an array for

removal, click its name. You can later add a removed array.
Clears the Selected Array List.
Moves to Attribute tab to select attributes for export.

Closes the dialog box without exporting any array attributes.

Attribute Tab

Export Array Attributes

*arvay [(AETBUEE)

Fallowing attributes are mandatory while importing an attribute file in application,
S0 it is advised ko select them while exporting.
Array I, Global Display Mame, Green Sample, Red Sample, Polarity

Aktributes-

Attribute List Selected Attribute Lisk

= Ak Cv3 used{ug)

| Amk CyS used{ug) F

e Array Fab date
: Array [0

< Array bype 1
ArraySet =
] (Comments T
< Back (64 Cancel

Figure 68  Export Array Attributes dialog box — Attribute tab
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Attribute List

Selected
Attribute List

<

=F

Back
0K

Cancel

194

Attributes
Displays the attributes that are not exported for the selected arrays.

Displays the exported attributes for the selected arrays.
¢ To select an attribute to move to the Attribute List, click its name.

e To select additional attributes, hold down the ectrl key and click their
names.

¢ To select a contiguous block of attributes, click the name of the first
attribute, then hold down the Shift key and click the name of the last
one.

You must select the following mandatory attributes, or else you cannot import the attribute
file at a later time: Array ID, Global Display Name, Green Sample, Red Sample, Polarity.

Removes an attribute from the Selected Attribute List. To select an
attribute for removal, click its name. You can add a removed attribute
later.

Clears the Selected Attribute List.

Moves the selected attributes in the Attribute List to the Selected Attribute
List.

Moves all of the attributes in the Attribute List to the Selected Attribute
List.

Moves back to the Array tab for array selection or removal.
Opens the Export dialog box. See “Export” on page 190.

Closes the dialog box without exporting any array attributes.
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Export Experiments

Select experi-
ments to export

Select All
Deselect All
0K

Cancel

‘+* Export Experiments

Select experiments ko export

W ot exe
W newcah
Fchiez

) 20090823_CGH_29-5ep-2009_LDF

i

A tewca

Select Al Deselect Al a4 Cancel

Figure 69  Export Experiments dialog hox

Purpose: Lets you select experiments for export. The program exports all
array designs and data for the experiments as a single ZIP file. This file
does not include any parameter settings, array selections, or results. See
“To export experiments” on page 72.

To open: In the Home tab, click Export > Experiments.

Displays all experiments available for export. Mark each experiment you
want to export.

Selects all experiments for export.
Clears all check boxes under Select experiments to export.
Opens an Export dialog box. See “Export” on page 190.

Cancels the export and closes the dialog box.
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Export Tracks

Select tracks

Select All
Deselect All
0K

196

]

Export Tracks

Select Tracks:

9 Hs_ha1s_crv_z0080404

E Hs_hgls_Cpilsland_20080404
1 Hs_hg18_mirma_z0080404
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Select all Deselect all (o] 4 Cancel

Figure 70  Export Tracks dialog box

Purpose: Lets you select tracks to export as a single BED format file. See
“To export tracks” on page 73.

To open: In the Home tab, click Export > Tracks.

Displays all of the filters available in the program. Mark the check box
next to each track that you want to export.

Selects all available tracks for export.
Clears all of the check boxes under Select Tracks.

Opens the Export dialog box, where you can select a location for the
exported BED format file. See “Export” on page 190.
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Cancels the export and closes the dialog box.

Find in column

Find in column

Direction

Conditions

Find in column "ProbeMame™

Find in colurin | Fird Mexk
Direction 1 Conditions i Cancel
ng E Match Case
@Qu:uwn _ EMatch whole word

Figure 71  Find in column dialog box

Purpose: This dialog box lets you set search parameters for a specific

column entry for the selected chromosome. Based on these parameters,
the program can highlight the row of the first entry that matches. The
cursor then moves to the location defined in the row.

To open: Right-click any entry in a tab in Tab View other than a column
heading, then click Find in column in the shortcut menu.

Type all or part of the entry you want to find.

Select a search direction:

e Up - Sets the search to move up the column from the selected location.

e Down - Sets the search move down the column from the selected
location.

Mark any of these search options:

e Match Case - Mark this option to take case into account. For example,
if you mark Match Case, and you type aa351 in Find in column, the
search finds the next entry in the column that contains aa3b1. It does
not find entries that contain AA351 or Aa351.
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¢ Match whole word - Mark this option to only find entries in which the
complete entry matches what you type in Find in column. For example,
if you type AA351 in Find in column, and mark Match whole word, the
program finds the next AA351 entry. It does not find entries such as
AA3512 or AA351992.

Find Next Finds the next matching entry in the selected column, and moves the
cursor to the location defined in the row that contains the entry. The
search is performed only for the chromosome selected in the Genome
View.

Cancel Closes the dialog box.
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Gene List
Gene List [z|
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<
v
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1 ABL
z BETZ 7
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4 BCLZALPHA
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B BCR.
I=] BRCAL
El BRCAZ
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11 CCND
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13 (CRK-II
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5 DEL |
16 [ 1
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~Colar-
| Color,.. |
oF Cancel

Figure 72  Genelist dialog box

Purpose: Lets you view the names of the genes in a specific gene list and
to change the display color of the gene list. See “To display the genes in a
gene list” on page 66.

To open: In the My Entity List pane of the Navigator, right-click the
name of a gene list, then click View in Table.

Name (Read-only) The name of the gene list.

Description (Optional) Brief descriptive comments about the gene list, such as how it
was created or the nature of the genes in the list. You can edit the
description.
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S.No The sort order number. This is the index number of each gene within the
gene list.

Gene Names The names of the genes in the gene list.

Color Opens the Choose Gene List Color dialog box, where you can change the
display color for the gene list. See “Combine Tracks” on page 172.

0K Saves the gene list with any new description or display color, and closes
the dialog box.

Cancel Closes the dialog box without making any changes to the gene list.

Go To Gene/Genomic Location

Go to Gene/Genomic location E|

Select something below and press Go

Refaeq by Symbol

Genomic Location

-

ap
o
[=1

Chromosame Base Pasitian

chrl 'y ! E Go

Cancel

Figure 73  Go To Gene/Genomic location dialog box

Purpose: To find a specific gene location in Gene View by either selecting
the RefSeq by Symbol or by selecting the Genomic Location.

To open: Click Home > Go to Gene/Genomic location.
RefSeq by Symbol  Select the Reference Sequence accession symbol from NCBI, and click Go.

Genomic Location ¢ Chromosome - The chromosome number.
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¢ Base Position - The position on the chromosome.

Click Go after selecting the chromosome number and the position of the
gene on the chromosome.

Cancel Closes the dialog box.

Import

Import E|

B = =. .| pEgEE ===
Lookin: ] Data G — | e =Sl =

| AberrationResult ] WarkFlowstatus

| designs E] arrayattributes, xml

| expresult dataconfig.xml

1 genelist genomeBuilds, xml

| genomebuild @ UDFColumntMappings. xml
| microarrays

| sparsetWrapper

| tracks

| udfMappings

File: narne: |

=
Files of bype: sl ]

Import Cancel

Figure 74  Import dialog box

Purpose: Lets you select files and import them into Agilent Genomic
Workbench.

To open: In the Home tab, click Import, then select any kind of import
except Genome Build or Track. The type of file for import appears in the
title of the dialog box. To import a gene list, right-click the Gene List
folder in the My Entities List pane of the Navigator, then click Import
Gene List.
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File name

Files of type

Import or Open

202

Cancel

Use the standard Windows Explorer commands in the dialog box to select
a file for import.

For some imports, you can select multiple files. Click the name of the first
file, then hold down the ctrl key and click the names of additional files. To
select a contiguous block of files, click the name of the first file in the
block, then hold down the Shiftkey and click the name of the last one.

Displays the name of a file you select for import.

Lets you select the types of files to display from the types shown in the
table below. To display all files, click ¥ ,then select All Files.

File type Extension
FE array File *ixt
Axon array file *.gpr
UDF file txt

Design file (GEML) *xml

Axon design file .gal
Array attributes *ixt
Experiments *.zip
Filters *xml
Gene list " txt

Imports the file into the program. In some cases, the name of this button
is Open, rather than Import. Also, when you click Import, in many cases
one or a series of additional dialog box(es) lets you further define the
content for import. See the instructions for each type of import in
Chapter 2.

Cancels the import and closes the dialog box.
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Import (experiments)

X

Import

Select experiments o import

Irnport [Expetiment |
CGH_EXP
MewZiGH
ChiPz

Wi
MewTGH1

Select Al Deselact Al

a4 Cancel

Figure 75 Import dialog box (for experiments)

Purpose: Lets you select the specific experiments within a ZIP format
experiment file to import into the program. See “To import an experiment
file” on page 49.

To open: In the Home tab, click Import > Experiments. In the dialog box
that appears, select the desired ZIP format experiment file, then click
Import.

Select These columns appear:
experiments to

: rt e Import - Mark the check box for the experiment(s) to import.
impo

¢ Experiment - The names of the experiments available for import in the
ZIP format experiment file.
Select All  Selects all of the experiments in the ZIP file for import.

Deselect All Clears all of the check boxes under Import.

0K Imports the selected experiments into the program. If the name of an
imported array design or data file matches one that is already available in
the program, the Confirm overwrite dialog box appears, where you can
select the data and/or design files that you want to overwrite. See
“Confirm Overwrite” on page 177.
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Cancel Cancels the upload and closes the dialog box.

Import GEML design files

Import GEML design files. [ ]

Details of GEML design files that are to be imported...

No." File Mare || (8] || Type || Species || Genome Build || Import SKP Probes || Skatus Remove
1 |023795_0_F_20090703_ch3.xml |023795 | cH3 |H. sapiens |hots | e 8 |

- Any corrupt files will not be imported,

- Catalog design files will not be imported,

- Read-Cnly design files will not be imported,

- Update design will not be allowed if design species is changed.

Start Import Cancel

Figure 76  Import GEML design files dialog box

Purpose: To display information in the design file and to remove any files
that you don’t want to import.

To open: In the Home tab, click Import > Design Files > GEML File.
Select the desired *.xml design files, then click Open.

File Name The name(s) of the design file(s) for import.
ID The Agilent ID number for the design file
Type The application type; CGH, ChIP, miRNA, or gene expression.
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Genome Build

Status

Remove
Start Import

Cancel
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The species for the genome build. This appears automatically when the
Genome Build is selected.

The genome build for the design. If the genome build is not read
automatically, a “?” appears. Click Genome Build and select the correct
value from the list.

¢ Not Set - Appears if Genome Build and Species information is not
shown.

¢ Not Allowed - Appears if a Genome Build is selected that does not
match the design.

¢ Overwrite — Appears when the design file has been updated and will
overwrite any existing one of the same name.

¢ Valid - Appears when the file is new.
Click ] to remove a specific design file from the list.
Starts the import of the design files in the list.

Cancels the upload and closes the dialog box.

Import Genome Build

Import Genome Build @
Species human
BuldName |
Refseq File I Browse
CytoBand File | Browse
Ok Cancel

Figure 77  Import Genome Build dialog box

Purpose: To import a new set of genome build files into Agilent Genomic
Workbench. See “To import a genome build” on page 46.

To open: In the Home tab, click Import > Genome Build.
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Species
Build Name
Refseq File

CytoBand File

The genome’s species of origin.
The name of the build to import.

The location of the RefSeq database file. This file contains chromosomal
locations of genes. To select a Refseq file, click Browse.

The location of the applicable cytoband file. This file contains graphical
cytoband information for Gene View and Chromosome View. To select a
cytoband file, click Browse.

0K Imports the genome build and closes the dialog box.
Cancel Cancels the import and closes the dialog box.
Import only Agilent-supplied genome build files.
Import Track
Import Track
Species H. sapiens i Colar
Euild Mame hgl;":i. '+l |W| CcChange...
Track Mame |
Track File | Browse. .,
ok Cancel
Figure 78 Import Track dialog box
Purpose: Lets you import a BED format track file. See “To import
tracks” on page 47. Track information can appear in Gene view. See “Gene
View” on page 156.
To open: In the Home tab, click Import > Track.
Species  Select the species to which the track relates.
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Color

Track Name

Track File

Browse

0K

Cancel
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This list contains the available genome builds for the selected species.
Select the desired genome build.

The assigned display color for the track. To change this color, click
Change.

Type a name to identify the imported track.

Type the location of the BED track file that you want to import, or click
Browse to select a file.

Opens an Open dialog box, where you can select the BED track file to
import.

Imports the track into the program.

Cancels the import and closes the dialog box.
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Microarray Properties

Purpose: Displays the properties associated with an array. You can also
edit the values of specific attributes. To add attributes to the list, see the
Sample Manager User Guide.

To open: For any array in the Data folder or Experiments folder,
right- click the array name, then click Show Properties. For non- Agilent
arrays, only the Attribute tab appears.

Attribute tab

-+*|Microarray Properties

m" FE Headers' !"FE Features'

Atkribute Value [
Array 10 Zel7Z931000% 11 e
Carmments 19Mow Export/Impark e
Global Display Name 17293 003_1 1 s
Model Syskem Mo [
||Palarity 1 = |

Close

Figure 79  Microarray Properties dialog box with list of Attributes and their values

e Attribute — Displays the attributes in an array by name. You can load
these from an Excel spreadsheet.

¢ Value - Indicates the values, if any, for each array.
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Value

Close

Methylation (CH3) Analysis Reference

You cannot edit values for read-only arrays.

Closes the dialog box.

FE Headers Tab

¥ Microarray Properties

{ attribute [FE Headers) e Featres’
Index Marne Valus |
n rMetric_ReproducibilityGreen_BG.. . |1
2 FeatureExtractor_ScanFilecUID  |b4136cfe-2693-4bbc-bels-06eZ. .. 2
i3 OutlierFlagger_IQRatio 1.42 i
e rMultDetrendSurfaceAverage 249,128
(s a0utlierFlagger_Auto_FeatB_Term [352.917 |
L] réveMumPixOLLo 0,319777
E Qi Metrics_UseSpikelns 0
3 ahlegiCtriMumlnliers 1467
o AnyColorProntSat 0.00903476
10 gDarkOffsetfverage 24,303
1 SpotAnalysis_kmeans_moi_rejec... 2.5
12 FeatureExtrackor_SingleTextFile... |1
13 AnyColorPrentBaMonlUnif oL 0.0217656
| 14 DyeMorm_RankTolerance 0.05 |
s BGSubtractor_additiveDetrendF... |1 !
I3 Grid Cnlsnarina A5 v |
Close |
Figure 80  Microarray Properties dialog box with list of FE Headers and their values

Displays a sequential index to help identify FE properties.

5

Displays feature parameters, statistics and constants for the whole array.

Displays the value for each parameter, statistic and constant.

Closes the dialog box.
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Selection List

List Box

FE Features Tab

H Microarray Properties

{ Attribute FE Headers [FE Features)

chrl py

Index Featurelium Probelame glsPosandsignif LogRaticErrar
1 175131 A_18_P12360742  |true 0.205077603453... 0. ]
2 6944 A_18_P12358768  |true 0.204467236995,., [0,
13 194352 A_18_P12360694  |true 0.204562962055... (0.4 |
4 113660 A_18_P12359966  [true 0.204610005021... |0.¢
] o514 A_13_P10000009  (true 0.204344514417... [0.¢
|6 119925 A_18_P16717255  |true 0.204966723915... |0.] |
7 110654 A_15_P10000017  [true 0,205067604780,.. (0. |
Ii] T2E91 A_13_P10000019  [true 0.204314514994,,, (0.
a 37826 A_18_P13359727  |true 0.204450390421... |0.¢
10 143351 A_13_P10000021  [true 0.204501405355,.. 0. |
11 26346 A_18_P10000023  |true 0,204759255051... |0.]
Il2 4740 A_18_P12361799  [true 0.204619213935.., EI."I
I13 35648 A& 13 P10000026  [true _D.ZD4‘!-16185I§1?..=.qD...57 i
| Close |
Figure 81  Microarray Properties dialog box with list of FE Features and associated data

Select the chromosome whose feature information you want to display.

Displays FE features and the associated data. The fields are:

Index
glsPosAndSignif
gProcessedSignal
rMedianSignal
glsSaturated
rIsFeatNonUnifOL
rIsPosAndSignif

FeatureNum
LogRatioError
rProcessedSignal
¢BGSubSignal
rIsSaturated
gIsBGNonUnifOL
glsWellAboveBG

ProbeName
PValueLogRatio
gMedianSignal
rBGSubSignal
glsFeatNonUnifOL
rIsBGNonUnifOL
rIsWellAboveBG
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Probe Methylation Status Setup

# Probe Methylation Status Setup

~Select T mapping file

Design Mame TM map File Browse |
014791 Z:\aailent Projectsicenomic Warkbenc. .. Browse, .. |

Cancel

Figure 82 Probe Methylation Status Setup dialog box

Purpose: To associate Tm (melting temperature) map files with the design
files for the arrays in the experiment or to make sure the Tm information
is already in the design file.

To open: Click Analysis, then mark Apply for the Probe Methylation
command

Design Name Shows the names of the design files contained in the experiment

Tm Map File  Click Browse to find the Tm map file for the design file. This is necessary
only if the design is a custom design or if Tm is still not available after an
attempted update.

If the design is an Agilent Catalog array, the Tm information is available
within the file as long as it has been updated. If the design file has not
been updated, the Browse button is active. If it has been updated, the Tm
Map File option says Available. If not, update it before continuing.

Continue The methylation algorithm calculates and displays the Z-score results.

Cancel Closes the dialog box without generating a report.
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Probe Methylation Report Dialog

Report Type

Output Format

Select File
Location

4 Probe Methylation Report Dialog

~Report Type

s

@Prnbe Based

~Cutput Formak

@Complete GEname

OPer—Chromusume

~Select File Location

Erowse. ..

Save

Cancel

Figure 83  Probe Methylation Report dialog box

Purpose: To select whether the results are reported for the complete
genome or for individual chromosomes. See “Report Format” on page 240.

To open: Click Reports, then click Generate Probe Report.

All methylation reports are probe-based.

Complete Genome - Creates report as .xls file for entire genome

Per- Chromosome - Creates report for each chromosome as .txt file. Open
in spreadsheet program to see headers properly aligned.

Click Browse to select a location for the file, that you must name.
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Sample Attributes

% Sample Attributes

Array ID Global Display Name|  Green Sample Red Sample Palarity Extraction Status
IP51469814934_1_1 LS22502705_25146 1 |
IP51469814934_1_2 LS22502705_25146 1
IP51469814935_1_1 LS22502705_25146 1
|f251469814935_1_2 LS22502705_25146 1

[i2 Show(Hide Attributes E‘,&'—_l Save Changes E,E'j Cancel Changes [ ¥ Close

Methylation (CH3) Analysis Guide

Figure 84 Sample Attributes dialog box

Purpose: To show, hide, or edit array attributes

To open: In the Experiment Pane of the Navigator, right-click the
experiment, and click Sample Attributes.

This dialog box lets you enter or change the existing values for the
attributes listed for the arrays in the experiment. You can also show or
hide attribute columns. The columns that appear initially are the default
columns (Array ID, Global Display Name, Green Sample, Red Sample,
Polarity and Extraction Status) plus any that you selected to show.
Changes you make are applied globally. See the Sample Manager User
Guide.

Changes to array attributes you make in this table appear also in the Sample Manager
table.
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Scroll to Column

Scroll to Column

& Select column
ProbeManme

Ak

oK || Cancel

Figure 85  Scroll to Column dialog box

Purpose: This dialog box lets you select a column. The program then
scrolls the tab so that you can see the selected column.

To open: Right-click a column heading in Tab View, then click Scroll To
Column. in the shortcut menu.

Select column  Displays the columns available in the selected tab. Select the one you
want to display.

0K Scrolls the current tab to show the selected column.

Cancel Closes the dialog box.
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Search Probes in eArray

User Defined

For complete
gene view

For aberrant
region below
cursor

Chromosome

Start/Stop

¥ Search probes in eArray

~Set Chromosome Start-Stop

Chromosome Starkt Stop

M |

DLlser Defined
@For complete gene view

{)For aberrant region below cursor

[0]'4 Cancel

Figure 86  Search probes in eArray dialog box

Purpose: To select the probes you want to update in eArray
To open: Right-click Gene View, and click Search probes in eArray.

Select a chromosome and a region in Chromosome View for selecting the
probes related to the genes in this region.

Select to choose the region to search for probes in eArray. The
chromosome selection list and the Start and Stop positions on the Y axis
are activated when this option is selected.

All the probes related to the genes in Gene View are searched.

Selects those probes for the genes that appear just below where the cursor
sits in Gene View.

If you select User Defined, you can select a different chromosome than
had been selected before opening this dialog box.

If you select User Defined, type Start and Stop positions for defining the
region for the genes in the list.
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Select Color

Purpose: To select a color. Three tabs are available for selecting colors:
e Swatches tab - select colors based on samples (swatches)

¢ HSB tab - select colors based on an HSB schema (Hue, Saturation, and
Brightness)
* RGB tab - select colors based on an RGB schema (Red-Green-Blue)

To open: This dialog box opens when a function allows you to change a
color. For example, right-click on an array in an experiment, click Edit
Array Color and click the Swatches, HSB, or RGB tab.

Swatches tab

I_]
T

O

Recent;

ECTE 1]

Preview

n - . Sample Text Sample Texk

. . . Sample Text Sample Text -

OK Cancel

Figure 87  Select Color - Swatches tab

This tab is used to select a color based on color samples (swatches).

Preview The Preview area shows how the selected color appears. When you change
the color, the original color appears at the top of the color box on the

right.
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0K
Cancel

Reset

Saturation

Brightness
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Choose a recent color selection.

Click to select the color and close the dialog box.

Click to close the dialog box without changing the color.

5

Click to change swatches, HSB, and RGB colors back to the default colors.

HSB Tab

“ Selact Color

I §watchesf‘ﬂ5_5" RGE'

P oOn [z
0: | 0=
| OB |100=

R |10z
G| 102
B| 255

Presvigw

n - . Sample Text Sample Text

. . . Sample Text Sample Text -

| OK || cCancel || Reset

Figure 88  Select Color - HSB Tab

In this tab, you can select a color based on an HSB schema (Hue,

Saturation, and Brightness).

Click the H button, and move the slider up and down, or go up and down

the list of numbers, to select the hue or color of the array.

Click the S button, and move the slider up and down, or go up and down

the list of numbers, to select the saturation level for the color.

Click the B button and move the slider up and down, or go up and down

the list of numbers, to select the brightness level for the color.

Methylation (CH3) Analysis Guide
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RGB Numbers

Preview

0K
Cancel

Reset

Red

Green

218

Reflect the amount of red, green and blue in the resulting color.

The Preview area shows how the selected color appears. When you change
the color, the original color appears at the top of the color box on the
right.

Click to select the color and close the dialog box.
Click to close the dialog box without changing the color.

Click to change the swatches, HSB, and RGB colors back to default values.

RGB Tab

% Select Color

| Swatches ﬁ@

£
Red T T [102=
a a5 170 255
Green TR | 102k
0 a5 170 255
Elue | e e B e R R R IZSEE
0 g5 170 255

Preview

n - . Sample Text Sample Text

. . . Sample Text Sample Text -

ok | Cancel | Resst |

Figure 89  Select Color - RGB Tab

This tab is used to select a color based on an RGB schema.

Move the slider to change the amount of red in the color. Or, click the up
or down arrow to select a number.

Move the slider to change the amount of green in the color. Or, click the
up or down arrow to select a number.

Methylation (CH3) Analysis Guide



Preview

0K

Cancel
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Move the slider to change the amount of blue in the color. Or, click the up
or down arrow to select a number.

The Preview area shows how the selected color appears. When you change
the color, the original color appears at the top of the color box on the
right.

Click to select the color and close the dialog box.
Click to close the dialog box without changing the color.

Click to return the swatches, HSB, and RGB colors back to default values.

Select data type for experiments

Experiment Name

Data Type

Select data type for experiments E|
|

Expetiment Mame Data bype Design bype
cgh_2009a_udf ratio "% cgh [ |

Continue Cancel

Figure 90  Select data type for experiments dialog box

Purpose: Lets you select the mathematical form of the data in an
imported UDF file, and its associated application type. See “To import a
UDF file” on page 43.

To open: In the Home tab, click Import > Array Files > UDF File. In the
dialog box that appears, select the desired UDF file, then click Open.

By default, the experiment name is the name of the imported UDF file. To
change the name, double-click it, then edit it as desired.

Select the mathematical form of the array data in the UDF file. The
options are:

* ratio
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* log, ratio
* logq ratio

* Inratio (base e)

Design type  Select the application type (CH3, CGH, or expression, for example) for the
array data in the UDF file.

Continue  Accepts your selections, and goes to the next step in the UDF import
process.

Cancel Cancels the UDF import.

Set genome build and species for Axon design files

Set genome build and species for Axon design files. R|

Setting of Species and genome build for files to be imported.

Mo | File: Mamne I Species | Genome Buid | Status | remove |
1 |016267_0_20090930.gal |H. sapiens =) hats =l Healthy [ |

- Any corrupt files will not be imported,
- Genome build need to be specified For the files,

Start Import Cancel

Figure 91  Set genome build and species for Axon design files dialog box
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Purpose: Lets you set the species and genome builds for imported Axon
design file(s), and to remove specific designs files from the import, if
necessary. See “To import Axon design files” on page 41.

To open: In the Home tab, click Import > Design Files > Axon File. In
the dialog box that appears, select at least one Axon design file, then click
Import.

No. An index number within the dialog box for each Axon file.
File Name The names of each Axon design file selected for import.

Species The species for each design file. If a species is incorrect, select the correct
one from the appropriate list.

Genome Build The genome build for each of the design files. If a genome build is
incorrect, select the correct one from the appropriate list.
Status The status of the file is one of the following:
¢ Valid - The file is a new file that can be imported.
¢ Healthy - The file passes validation and can be imported.

¢ Not Set - Appears if Genome Build and Species information is not
shown.

¢ Not Allowed - Appears if a Genome Build is selected that does not
match the design, or if the design is an Agilent Catalog design.

¢ Overwrite — The file is a valid design file, but when you import it, it
will replace an existing design that has the same name.

¢ Corrupt - The file failed validation. When you start the import process,
the program ignores the file.

Remove Click ] to remove a specific design file from the list. This is
useful if you select a design file in error, or if you do not want to
overwrite an existing one.

Start Import Imports the file(s) and closes the dialog box.

Cancel Cancels the import and closes the dialog box.
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Show/Hide Columns

Save

Select All
Deselect All

“* Show/Hide Columns

Array 1D | M
Global Display Name |

Wash Conditions

AR

| Select Al Deselect Al Close

Figure 92  Show/Hide Columns dialog box

Purpose: Used to select the attributes for display in the Sample Attributes
dialog box and the Sample Utility tab. The Sample Utility tab is available
when you go to Sample Manager. See the Sample Manager User Guide for
information about Sample Manager.

To open: This dialog box appears when you click Show/Hide Attributes
at the bottom of the Sample Attributes dialog box.

All available attributes are shown in the Attributes column. Attributes
with a check-mark next to them are displayed in the Sample Attributes
and Sample Utilities tab for each sample. To select an attribute for display,
mark the Show in Table box next to it. To hide an attribute, clear the
Show in Table box.

Saves the current list of selected attributes and updates the Sample
Utilities table based on the selections.

Selects all the attributes in the list.

Clears all check marks from attributes in the list.
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Close Closes the dialog box. If changes have been made, the program asks if you
want to save your changes before closing.

Track

[~ Track Parameters-
. Mame Hs_hgl7_CpGlsland_20080404
Species H. sapiens
Farmat bed
Genome Build hgl7
Description April 4 2008
I--Data-

Chromosome Stark Stop Mame SCOre strar
chrl 18598 19673 CpG: 116 1000 + "']
chrl 124987 125426 CpiG: 30 1000 + ¥
chrl 367653 F68092 CpiG: 29 1000 + F
chrl 477014 478027 CpG: 54 1000 +
chrl 459136 490407 Cpi: 99 1000 +
chrl 573052 573977 CpG: 94 1000 +
chrl 4601 SE6512 CpGi 171 1000 +
chrl 753547 794410 CpiG: 60 1000 +
chrl S02279 503305 CpG: 115 1000 +
chrl S28726 G29074 CpG: 25 1000 +
chrl 541838 S42201 CpG: 24 1000 +
chrl 545061 G45491 CpiG: 50 1000 +
chrl 579557 SE0452 CpG: 83 1000 + ::1
| lchet 417 C745 Cria: 153 1000 + ]
L. 3 RS

Close |
Figure 93  Track details dialog box

Purpose: This dialog box lets you view the chromosome locations in the

track.

To open: Click the Details link for the desired track in the Tracks tab of
the Preferences dialog box. See “Tracks tab” on page 231.
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Track Parameters

224

Data

Close

These parameters appear:

Parameter Description

Name The name of the track.

Species The species to which the track applies.

Format The format of the track data. Agilent Genomic Workbench supports

Genome Build

Description

the BED format.
The specific genome build of the species to which the track applies.

Descriptive text saved with the track.

Tracks must contain

entries for at least these four columns in the table:

Column Description

Chromosome The name of the chromosome

Start The first base pair of the particular feature in the chromosome.

Stop The last base pair of the particular feature in the chromosome.

Name The name of the feature. This name appears next to the defined region

for the feature.

The other columns are additional BED track file columns that can appear
for some tracks. Agilent Genomic Workbench does not display these.

Closes the Track dialog box.
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UDF Import Summary

UDE Import Summary El

File: Mame Lines Imparted Lines Skipped |
Barz231 bt 26 o |

Skipped lines during import are shown in the table,

Lines skipped, if any, are due to lines missing chromosome mapping information, IF so, you should
just views the data as-is since the missing data cannot be mapped onto the genome.,

MOTE: It might also be due to Formatting problems in the data being imported. Re-examine the
data and look For lines that appear irregular with respect to the rest of the data,

The files shown in red might not have been imported,

oK

Figure 94  UDF Import Summary dialog box

Purpose: Reports how many lines of data were successfully imported from
a UDF file, and how many lines were skipped. Skipped lines are caused by
missing chromosome mapping information, or improper formatting of the
UDF file.

To open: Import a UDF file (see “To import a UDF file” on page 43). This
dialog box appears after you map the columns of the UDF file.

Table Displays the file name of the imported UDF file, the number of lines that
were successfully imported, and the number of lines, if any, that were
skipped during import. If many lines were skipped, review the data for
improper formatting or missing chromosome mapping information.

0K Closes the dialog box.
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Universal Data Importer - Map Column Headers

-+* Universal Data Importer, - Map column headers

Header Info Species Info Mapping Info Array ID Info

Design Id: Cuskom Select species Select Mapping:  [cusTom Wirtual Array 1D |12654104?889?

Design type: cgh Select Genome Build hgls Save Mapping As Euse System Generated Array 1D

chrl 5639741 646237 THFRSF14 1000 aF 5639741 646237 1]
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Figure 95  Universal Data Importer - Map Column Headers dialog box

Select Species

Select Genome

Purpose: Lets you set up a universal data file (UDF) for import. You select
several properties for the UDF, and identify the contents of each column
of data in the file. You can also save column mappings for re-use.

To open: As you go through the UDF import process (see “To import a
UDF file” on page 43), in the Select data type for experiments dialog box,
click Continue. See “Select data type for experiments” on page 219.

Species Info

Build

226

Sets the species-specific build to use.

Select the species for the array data in the UDF.
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Mapping Info

Select Mapping Applies an existing column map to the current UDF. A column map
identifies the contents of each column of data. To create a new column
map for the current UDF, select CUSTOM.

Save Mapping As Saves the column map under a new name. Opens an Input dialog box,
where you can type a name for the new map.

Array ID Info

Virtual Array ID A number that uniquely identifies the data in the UDF. Typically, an
Agilent microarray slide has a physical barcode that Agilent Genomic
Workbench uses to generate an Array ID. The Array ID is used to track
the data from the slide as it goes through the steps of an analysis
workflow. A “virtual” Array ID is, by default, a system-generated ID that
serves the same purpose for data from UDFs. You can also create your
own virtual Array ID.

Use System By default, the virtual barcode assigned to the array data in a UDF is a
Generated Array number that is created by the program. To create your own barcode, clear
ID Use System Generated Array ID, then type a new number in Virtual
Array ID.

Table

This table lets you identify the contents of the columns of data in the
UDF. The first row of the table displays the column heading information
from the UDF. The second row contains labels that you apply to each
column, and the rest of the table displays lines of data from the UDF. If
the UDF contains data from Agilent arrays, the column headings will
exactly match the labels in the lists.

In the list below each column heading, select the applicable label. You
must use each of the labels exactly once, except LogRatio, which you can
use more than once. These labels are available:

Label Description

ProbeName Names of probes.

ChrName Names of chromosomes.

Start First chromosomal location for each probe.
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Reset

Import

Cancel

Label Description

Stop Last chromosomal location for each probe.

Description Text annotation for the probe.

LogRatio Array data values that correspond to each probe. You can use this

label more than once.

If you select an existing column mapping, then change or reset the column labels in the
table, the program changes or resets the saved column map as well.

Clears all the column labels in the second row of the table. If you have
selected an existing column mapping, this command also clears the labels

in the saved map.

Imports the UDF file with the specified parameters, and opens the UDF
Import Summary dialog box (see “UDF Import Summary” on page 225).

Cancels the import and closes the dialog box.
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Upload Track to UCSC

Name

Build

Description

Set Chromosome
Start-Stop

Upload Track to UCSC 53
Mamne Build
F!s_hng_Cpg i
Description

Set Chromosome Start-Stop
Chromosome Start Stop

= | |

() User Defined

@For complete gene view

Select Track Source Calar

| Change...

v

E Save as Track in Genomic Waorkbench

oK Cancel

Figure 96  Upload Track to UCSC dialog box

Purpose: Lets you select a track to upload to the UCSC Web site, where
you can view it in the UCSC genomic browser.

To open: Right-click in Gene View, and select Upload Track to UCSC.

Type a name for the track. This name identifies the track when it appears
in lists and displays.

(Available if you select User Defined in Set Chromosome Start- Stop.)
Select the genome build with which to associate the track.

Type descriptive text to attach to the track for reference.

This parameter defines the region of the chromosome used for the track.
Select one of these options:
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¢ User Defined - Lets you define an arbitrary region of any chromosome.
If you select this option, select the desired chromosome in
Chromosome, then type the beginning (Start) and end (Stop) locations
of the desired interval.

¢ For complete gene view — The chromosomal region that appears in
Gene View.

* For aberrant region below cursor — All of the intervals that begin
before the cursor position and end after the cursor position.

Select Track The type of analysis result the program uses to construct the regions
Source defined in the track. Select one or both of these options:
* Methylation Score — Uses the current methylation score as the source
for the track.

Save as Track in  Saves the selected track in the Tracks folder in the My Entity List pane of
Genomic the Navigator.
Workbench

OK Creates the track. To display the track in Gene View, use the Tracks tab
of the User Preferences dialog box to enable it. See “Tracks tab” on
page 231. To export the track, see “To export tracks” on page 73.

Cancel Closes the dialog box without creating a track.
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User Preferences

Purpose: This dialog box is used to set up preferences for display of
tracks, data storage locations, and licenses.

To open: From the Home tab, click User Preferences. Or, right-click in
the Gene View, Chromosome View, or Genome View, and click User

Preferences.
Tracks tab
User Preferences E|
[Fracks) Miscellaneous|| License!
Font
Fant Fant Style Fant: Size )
SansSerif i ! Reqular mr 1 10 i
Track Name Show in LT Show in Report ||Genomic Boundaries Delete
Genes E Detail,, "]
|IHs_ha17_crv_z... B = (5] B Details. J |
Hs_hgl?_Cpilsl,.. = = [6) = Dietails. .
Hs_hgl?_PaR_z... = B 0 ] Dietails. .
Hs_hgld_chy 2., = = [G) = Dietails. .
Hs_hgl_Cpilsl,.. ] B (&) ] Detais..;
| Hs_hgl&_miRMa, .. =) = [G) M Details. 2!
V4>
Import... Delete Up Dawn
[~Wisualization Parameters-
-Genes Genomic Boundaries Tracks
Orientation (Degrees) FS.D @Include in analysis Eshow Annotations
I OEchude from analysis E Show Crverlaid
Bshow Gene Symbols in Gene View
|
Ok | Cancel | e |

Figure 97  User Preferences dialog box - Tracks tab

Purpose: To import and set up the appearance of tracks next to the Gene
View. Tracks are additional graphic displays of genomic information
loaded from an external file. They align with genomic coordinates in Gene
View.

To open: In the User Preferences dialog box, click the Tracks tab.
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Track Name
Show in Ul
Show in Report

Genomic
Boundaries

Delete

Details
Import
Delete

Up

Down

Genes

Genomic
Boundaries

Tracks

232

Font Options

Select the font type, style and size for the gene annotations that appear in
the selected tracks.

Tracks List

Name of the track already loaded or imported

Mark the check box to display the track next to Gene View.

Mark the check box to display the track information in all the reports.

Click to use the track to define only the regions that aberration detection
algorithms will run. You can choose to do this for only one track.

Mark the check box to delete the track from the list. Then, click Delete to
delete the track from the list.

Click to display all the chromosome locations defined in the track.
Click to import new tracks.

Click to delete the tracks selected in the Delete column.

Click to move a track up the list.

Click to move a track down the list.

Visualization Parameters

These options affect the appearance of the Track and Gene View.

¢ Orientation — Type a number to set the angle at which the Gene
Symbols will appear in Gene View and the Track Annotations appear in
the tracks.

e Show Gene Symbols — Mark to show gene symbols in Gene View, and
clear the check box to hide them.

These options let you include or exclude the Genomic Boundaries from the
analysis.

These options affect the appearance of the Track Views.

e Show Annotations — Mark to show the names of the gene regions for
the tracks, and clear to hide them.
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¢ Show Overlaid - Mark to overlay all the tracks that appear next to
Gene View, and clear the check box to display the information in
separate tracks.

Miscellaneous tab

User Preferences E|
f fracksf”ﬁfe"ﬂmag"' License’

& -efrray User Details

URL |

Username l.lser@agilent.com

Password r********

-Error Model

| Select Ervor Model | DLRErrorModel "3'3 |

‘Data Location

Drata Location k:'l,Program Files\AgilenttGenomic Workbench Lite Edition 6.0.130,1 | Browse...

Please specify the location where microarray and experimental data should be stored,

[e]4 Cancel

Figure 98  User Preferences dialog box — Miscellaneous tab

Purpose: For data/content set-up, this dialog box allows you to set up
eArray access and to change the location for data.

To open: In the User Preferences dialog box, click the Miscellaneous tab.
eArray User Sets login details for the Agilent eArray Web site.

Details URL - At present, https://earray.chem.agilent.com

¢ Username — The name registered on the eArray site.

¢ Password — The password registered on the eArray site.
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Error Model (Not available for CH3) The DLRErrorModel (Derivative Log Ratio)
measures noise in the data for CGH analyses.

Data Location The folder where the program stores array data and design files. To select
a location, click Browse.

Apply Applies any changes to the preferences.
0K  Accepts any changes and closes the dialog box.

Cancel Cancels all changes and closes the dialog box.

License tab

User Preferences §
{Tracks![Miscellaneous f License)

Please provide license information to ackivate the ch3 functionality of Genomic Workbench,

Host Name = webbpc100

Select Analysis Application:

ch3 ?1

OServer Location

| @Text License

Please paste your license text in the area below:

EATIURE ch3 agilent 5.0 04-dec-2009 uncounted HOSTID=ANY SIGN="0013",
ABL3 3B17 0D73 9469 1780 AZ60 E200 41F4 CCC3 OFS0 0B32Z BFF4
31DF

QK Cancel Apply

Figure 99  User Preferences dialog box — License tab
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Purpose: The License tab allows you to display and update your CH3
application license. This license enables the CH3 application, and allows
you to use it to analyze array data.

To open: the In the User Preferences dialog box, click the License tab.
Host Name Displays the host computer name automatically.

Select Analysis  Select the Agilent Genomic Workbench application for which you have a
Application license.

Server Location  Select this option if you have a concurrent user license. To edit this name,
select Server Location, then type the path where your license(s) are
located. If you select this option, the Text License option is unavailable.

Text License  Select this option if you have an application license (CGH, ChIP, CH3). To
change the license, delete the old license text, and paste the new license
text in the box.

OK Accepts any changes you have made, and closes the dialog box.
Cancel Closes the dialog box without changing any license information.

Apply Accepts any changes you have made, but does not close the dialog box.
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View Preferences

View Preferences [ x|
Wiew Alignment
Orientation Rendering Style
@Horlzontal OVertlcaI @Overlald ostacked
Diata Wisibility Fendering patterns
View | Gene Yiew | 3! Design type CH3 ] :1
@Scatter Flat EScatter Toal Tip
Skyles
E Moving Average EZScore Log Ratios + sign
Moving Average Continuous

E Log ratio error envelope

P

Configure Scales Configure Coloring schemes

Methylation Results Log Ratios Methylation Results Log Ratios
EADDIV EADDIV I Color by E Color by

Z-score Values | ¢ Log Ratin Values %

Configure Color and Ranges

Scatter Plot {Chr Wiew)

Foint Size [ s
v

— QK Cancel Apply
E Show Memary Monitar in Status Bar

Figure 100 View Preferences dialog box

Purpose: This dialog box allows you to configure how data and results
appear in Genome, Chromosome, and Gene views.

To open: In the View tab, click View Preferences.
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View Alignment  Selects the orientation and rendering style (described below).

5

Option

Description

Orientation

Horizontal

Vertical

Rendering Style

Overlaid

Stacked

Stacks Genome, Chromosome, and Gene views horizontally in the
main program window. Genomic locations appear across the bottom
of each view.

Displays Genome, Chromosome, and Gene views from left to right as
side-by-side panes in the main program window.

In Chromosome View and in Gene View, displays data and results as a
single, combined pane for all arrays. (Default)

In Chromosome View and in Gene View, displays a separate pane for
each array.

Data Visibility For each view, or all views, selects the kind(s) of data and results to

display.

In View, select the view you want to configure. To set availability of

display items for all views, select All views. Some display items are only
available for certain views. When you select a display item, it enables the

item for display — for some items, you must take additional steps to
display them. For example, you may need to configure a specific algorithm

in the toolbar.

Mark any of the following options, as available:

Display item

Description/Comments

Scatter Plot

Scatter Tool Tip

Moving Average

The plot(s) of individual log ratio data points.

The ToolTips that appear when you place the pointer over specific data
points on the scatter plot(s) in Gene View. The tool tip shows the array
of origin and the numerical log ratio value for the data point.

The result of the Moving Average algorithm. See “To set up a moving
average (Log Ratio) calculation to smooth the data” on page 107.
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Display item Description/Comments

ZScore Marking this check box displays the results from the methylation
algorithm to produce the statistical likelihood of methylation or no
methylation in CpG Island regions of the genome.

Log Ratio Error Mark this check box to display the error envelope for log ratio values.
Envelope

Rendering These options control the specific appearance of data and results in
Patterns Genome, Chromosome, and Gene views. You configure these options
separately for each type of array design.

¢ Design Type - Select the type of design to which the patterns are
applied: CH3, Expression, or Other.

e Styles — Select the display style for each of these elements:

Display element Details

Log Ratios Select how to display individual data points as: Color filled circles
(ellipses), circles, rectangles, filled rectangles, + signs, or x signs.
The latter two choices increase performance.

Moving Average Select the line style for the moving average display. Lines appear in
the display color defined for each array. See “To set up a moving
average (Log Ratio) calculation to smooth the data” on page 107.
+ Continuous — A solid line.
» Dashed — A dashed line.
» Dotted — A dotted line.
* Do not show area — No line.

Scatter Plot (Chr  Select a point size to use for display of scatter plot data points.
View) Point Size

Rendering scatter plots for more than 10 high density arrays in the Chromosome View may
take significant time. Selecting filled circles as the rendering style for CH3 scatter plots can
also decrease performance. For faster performance, change the rendering style for CH3
data from the filled circle to the plus (+) or cross hair sign.
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For Methylation Results or Log Ratios plots, mark Apply to enable the
custom scale. In Range, type the value to use as the range for the scatter
plot.

Use these options to change the display of the scatter plot in the Gene
View. These options are the same as those displayed in the Scatter Plot
ToolTip in the Gene View.

Displays a memory usage monitor in the eighth cell of the status bar. For
information about the Status Bar, see “Status Bar” on page 165.

Applies the changes you made to all preferences and closes the dialog box.
Closes the dialog box without applying changes.

Applies changes without closing the dialog box.
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Report Format
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The Methylation Report contains all the statistical results to help you
determine if there are methylated or unmethylated regions in the genome.
The report is created in .xls format for the complete genome or in .txt
format for individual chromosomes. Use a spreadsheet program to open

the report(s).

To learn the meaning of the values in the ZScore columns see “Overview
of Methylation Detection and Visualization Algorithms” on page 244.

Methylation Reports contain the following columns, in this order:

Column Description

CytoBand Accepted name of the cytoband for each section of chromosome

ChrName Name of the chromosome (for example, chr17)

ProbeName Name of the probe (for example, P)

Start The first base pair of the chromosomal location to which the probe
binds

Stop The last base pair of the chromosomal location to which the probe
binds

Description Name or phrase for the type of probe (for example, promoter)

GeneNames Names of each gene in whose region probes are located

“Name of CpG Island
Track”

Combined ZScore

ZScore_Methylated

ZScore_Unmethylated

logOdds

Name of each CpG Island in whose region probes are located

Combination of both the methylated and unmethylated ZScores. The
higher the positive combined ZScore, the more likely the probe is
methylated and vice versa.

Probe ZScore that are contained in right Gaussian. All of these values
are positive or small negative values.

Probe ZScore that are contained in left Gaussian. All of these values
are negative or small positive values.

This number reflects how likely it is that a probe is methylated rather
than unmethylated. The higher the positive value, the more likely it is
methylated.
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Column Description
logRatio Log ratio from the extracted FE image file for the probe
Tm Melting temperature for the probe region
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This chapter provides implementation details for the algorithms used in
the Methylation (CH3) application of Agilent Genomic Workbench Lite
Edition 6.5. The methylation algorithms facilitate the statistical analysis of
methylated genomic regions. The first section presents the methylation
detection and measurement algorithms. This is followed by a section that
describes the visualization options available for methylation analysis.
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Overview of Methylation Detection and Visualization Algorithms

204

The Methylation module of Agilent Genomic Workbench provides
algorithms for genomic methylation detection and visualization. The main
methylation detection algorithms are described below. Information on
algorithms that visualize the data follows.

Methylation detection and measurement algorithms

Methylation of cytosines in DNA is an epigenetic modification that can
play a role in the regulation of gene expression. Generally, methylation is
associated with repression of gene expression. Much of the aberrant DNA
methylation associated with disease is found in CG-rich regions, termed
CpG islands.

Agilent catalog methylation (CH3) arrays are specifically designed to
assess the methylation pattern within CpG islands and gene promoter
regions. The methylation detection algorithm is designed to be compatible
only with the Agilent protocol for DNA methylation analysis and the
Agilent methods for affinity-based methylated DNA enrichment.!

Methylation status detection algorithm

The methylation status detection algorithm is designed for two-color
assays, where the green (Cy3) channel is comprised of input DNA, and the
red (Cyb) channel is comprised of the affinity-enriched DNA. As a result
of constraints imposed on the array design, the probes that target genomic
regions with varying CG content do not share a uniform melting
temperature (T,,), which can result in compression of the log-ratios.

The methylation detection algorithm allows you to normalize the log-ratios
for each probe, based on its T,,, and returns the methylation status of a
probe. This sharpens the bimodal distribution observed with log-ratios
alone. For more information, see “Methylation status detection

algorithm” on page 246.

BATMAN algorithm

The BATMAN (BAyesian Tool for Methylation ANalysis) algorithm2 has
been adapted here for analysis of Agilent methylation microarrays. This
algorithm takes into account the local density of CpG dinucleotides in the
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genomic vicinity of the interrogating probes, and estimates methylation
events using this information. The algorithm is used with log ratio
observations and can additionally incorporate the effects of probe melting
temperature corrections based on the output Z-scores from the
methylation status detection algorithm. For more information, see
“Bayesian tool for methylation analysis (BATMAN)” on page 256.

Visualization algorithms

Moving average — linear

The moving average algorithm sets a fixed window size around every point
of interest. The points are either the probe log-ratio scores determined
prior to the methylation detection algorithm, or the combined scores that
result from application of the methylation detection algorithm. The
program reports the value for each point as the average of that point and
neighboring points within the window boundaries. For more information,
see “Moving average (linear smoothing)” on page 261.

Moving average — triangular smoothing

The triangular smoothing algorithm is a shaped algorithm based on a
moving average. As the moving average centers on a point of interest, the
program applies a maximum weight, and that weight falls off with
increasing distance. The program adjusts the point of interest as the
weighted mean of itself and neighboring points. For more information, see
“Triangular smoothing” on page 262.
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Methylation Detection and Measurement Algorithms

246

Agilent Genomic Workbench provides two algorithms for methylation
detection and measurement of the methylation levels detected by
Methylated DNA Immunoprecipitation (MeDIP). The methylation status
detection algorithm uses a melting temperature differential to discriminate
between methylated CpG regions and unmethylated regions. The Bayesian
tool for methylation analysis (BATMAN) algorithm uses conditional
probabilities from a calibration step to estimate methylation levels in CpG
regions. The BATMAN algorithm may be used directly on the log-ratios, or
it may be used on the resultant Z-scores from running the methylation
status detection algorithm.

Methylation status detection algorithm

You find epigenetic methylation predominantly in genomic areas of
increased GC content, known as CpG islands. Agilent human methylation
arrays specifically query approximately 25,000 CpG islands in the human
genome, in addition to gene promoter regions. The Agilent methylation
protocol uses antibody enrichment for 5- methylcytosine, which results in a
log-ratio of the relative abundance of genomic fragments with methylation
to those without.

Although the log-ratio scores give information about the relative
abundance of the genomic fragments, individual specificities of the probes
in each log-ratio score vary by melting temperature. Differences in melting
temperature can therefore decrease probe specificity. Normally, the probes
on Agilent arrays are chosen in such a way as to minimize probe-to- probe
differences in melting temperature.

The algorithm first bins the probes by their melting temperature. Within
these bins, you can make direct probe comparisons. When you compare
probes by log-ratio scores within each bin, you observe a bimodal
distribution — a mode comprised of those probes that were not
methylated, and a mode comprised of methylated probes. You also observe
a bimodal distribution in per-T,, Z-normalized scores.
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The algorithm determines the methylation status of a probe in a
T,,-dependent manner. To determine which probes are methylated, the
binning process compares log-ratios among probes of similar melting
temperatures.

To apply parametric statistical techniques, the algorithm fits the bimodal
distribution to a set of Gaussian curves, each of which requires only a
limited number of parameters to accurately fit the data. The algorithm
uses normalized Z-scores from the Gaussian distributions to effectively
judge the methylation status of a given probe on the array.

Purpose Detection of methylation status is a visualization and report analysis that
determines the confidence score for probes that query known CpG islands
and gene promoter regions. To determine the probe methylation status, the
analysis uses a combination of log-ratio scores from competitive
hybridization methods, and the range in melting temperatures among
probes located in CpG islands.

Use To establish a link between genomic methylation and gene expression,
detection of methylation status is used to identify probes likely to query
methylated genomic regions. CpG islands, measured on the Agilent catalog
methylation (CH3) design array, generally are either fully methylated or
fully unmethylated. You use the algorithm to identify methylation status
for probes. You can then visualize the probes in a genomic context — for
example, CpG islands within the genome.

Algorithm  The algorithm first bins the probes by their melting temperature. For each
bin, it applies Gaussian fits using one of three models. It fits the probe
log-ratios to Gaussians, using a local searching algorithm called random
hill climbing.3 Z-scores and p-values derived from the Gaussian data give
probabilities and confidence values for methylated and unmethylated
probe populations. The algorithm then calculates a methylation logOdds,
which gives the relative probability that a probe is more likely methylated
than unmethylated.

The log0dds score indicates how likely a probe is to be methylated. It compares p-values
from the methylated to unmethylated populations. If they are the same, this value is zero.
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Step 1: Create a binned distribution of probes

To compare log-ratio scores between genomic fragments enriched by
methylation and those without methylation, the algorithm orders probes
into discrete melting temperatures.

71 Probes are binned according to their melting temperature. Each bin is
1°C wide.

8 The algorithm fits the Gaussian distributions to the probe log-ratios
within each T, bin. It does this by further dividing the probe log-ratios
into sub-bins (with default size of 0.1 °C), to generate the observed
distribution of signals, as shown in Figure 101.

Methylated
CpGislands = P

Probe bins v -
80-81
e | o | -

Inter-bin probe

T log, ratio scores
distribution -

Methylation

S oy
status of probes ._‘N__JQ____U L-,./“’n_.

Figure 101 Overview of procedures in the methylation status algorithm

Step 2: Fit Gaussian curves to the binned data

For each bin of 1°C, the algorithm applies Gaussian fits in one of three
models, depending on whether the data points are unimodal or
multimodal:
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e If the data are unimodal, then it fits one Gaussian distribution to the
data.

e If the data are bimodal (the most common fit for methylation data),
then it fits two overlapping Gaussian distributions to the data.

e If the data are trimodal, then it fits three overlapping Gaussian
distributions to the data.

One Gaussian goodness of fit can exceed two Gaussians if, for example, no methylated
probes were pulled down during the antibody enrichment process, or if the number of
methylation events is exceedingly small. If this occurs, Agilent Genomic Workbench
automatically fits one Gaussian to the data, and the message “SINGLE GAUSS” appears in
the report. The Z-score in the visualization and report is then calculated from the single
Gaussian (that is, how likely the probe is to be methylated), instead of a combined Z-score
(which is reported from models using either two or three Gaussians).

The process to fit a Gaussian curve to the data has two steps:

1 Initial parameter approximation

2 Improvement of the model parameters using a local search procedure
called random hill climbing.?

Initial parameter For each Gaussian curve, the parameters to be fit are the mean (W),
approximation standard deviation (c), and mixture coefficient (o, the total Gauss
integral). For each of the three possible models, the algorithm
approximates the initial parameters as follows:

¢ First Gaussian

For any of the three models, the parameter estimations are done in
the following ways:

1 The mean is estimated by the maximum bin.

2 The standard deviation is estimated using the IQR (Inter- Quartile
Range) of the distribution, as inferred from the data left of the mean.

3 The mixture coefficient is estimated from the maximum bin height.

¢ Second Gaussian
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Parameter
improvement
procedure

Target fitness
function

If the data points are bimodal or trimodal, the first Gaussian is
subtracted from the distribution. The mean, standard deviation, and
mixture coefficient are then estimated in the same way as the first
Gaussian.

e Third Gaussian

If the data are not well explained by either a unimodal or bimodal

distribution, then a third Gaussian curve can be fit to allow a better
estimate of the first and second Gaussian parameters. In this case,

the parameter estimates are:

1 The mean is estimated from the mean from the entire bin.
The standard deviation is estimated from the entire bin.

The mixture coefficient is estimated from the height of the bin used
to estimate the third Gaussian mean.

Because many probes are generally present in each T,, bin (on the order
of thousands), the algorithm uses a straightforward local search procedure
called random hill climbing3 for parameter optimization. This procedure is
highly accurate and extremely fast when fitting the Gaussian models to
the data.

In each step, the algorithm alters a random parameter. It accepts this
alteration if it improves the target fitness function. To converge to a
(locally) optimal result, each random step gets shorter with each iteration.
This reduction in step is made logarithmically by 7, the number of
iterations, and a default starting value of 100 (termed LB):

log(LB +n) 1)
log(LB)

The algorithm achieves convergence when a new step does not yield an
improvement in the target fitness function. The procedure converges if no
change occurs to the fitness value for 1000 iterations, or after the
algorithm has performed 50000 iterations.

The default target function is the Chi-squared goodness of fit. This
function is described using an observed distribution OD;-; », and an
estimated distribution function EF (for example, the convex combination
of two Gaussians), as follows:
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Step 3: Calculate Z-normalization scores

After the algorithm fits the Gaussian curve(s) to the data, it performs
parametric statistical analysis. The log-ratios from the T,,-binned probes
may differ in value. Agilent Genomic Workbench therefore uses a measure
from the Gaussian distributions themselves to normalize the scores. This
measure is called a Z-score:

~ log - ratloprobe — Mpin

Spin

(3)

where £, is the mean and ¢,;, is the standard deviation of the Gaussian
distribution. The Z-score is a measure of the distance of a given probe
log-ratio score from the mean of any of the Gaussian curves, given the
standard deviation of that curve. The Z-score normalizes comparisons of
probes from different bins, by taking into account the Gaussian-fit curves
of the different bins.

Because the methylation model typically contains two Gaussians, the
algorithm calculates Z-scores for each one. The left Gaussian represents
those probes with a lower log-ratio score, and consists predominantly of
unmethylated probes. The left Gaussian is also the major mode, because
the majority of probes are generally unmethylated. The right Gaussian
represents probes with a high log-ratio score, and consists predominantly
of probes enriched for methylation. The algorithm calculates the following
Z-scores as statistical measures of whether or not a probe is methylated:

1 The Z-score derived from the left Gaussian. A negative or small positive
value means that the probe is likely to be unmethylated.

2 The Z-score derived from the right Gaussian. A positive or a small
negative value means that the probe is likely to be methylated.

3 The combined Z-score. This is the summation of the left and right
Gaussian Z-scores. It reflects the location of a probe log-ratio value in
relation to the Gaussian distribution(s) of probes with similar T,,. A
strong positive value of the combined score means it is methylated,
while a strong negative value indicates the probe is unmethylated. See
Figure 102 for more information.
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Figure 102 Effect of probe log-ratio score placement on a mixture of Gaussians — result
ranges for Z-normalization score

In addition to the Z-score calculation, Agilent Genomic Workbench
calculates a p-value that considers how much of a tail continues past the
log-ratio point on the Gaussian curve. Such a calculation is important
because the tails of the Gaussian distributions overlap; hence it is often
difficult to clearly assign a given probe log-ratio score to the left or the
right Gaussian if a pronounced valley exists between the two distributions.
See Figure 103 for more information.
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Figure 103 Calculating Z-scores and p-values from two overlapping Gaussian distribu-
tions

The following p-values are calculated for the usual case of two Gaussians:

1 The p-value derived from the left Gaussian. This is denoted py; in the
report, and is the confidence at which the non-methylation null
hypothesis is rejected (that is, the confidence at which you can call the
probe methylated).

2 The p-value derived from the right Gaussian. This is denoted py in the
report, and is the confidence at which the methylation null hypothesis
is rejected (that is, the confidence at which you can call the probe
unmethylated).

3 Finally, the algorithm uses the bimodal distribution of log-ratio scores
among probes of similar T,, to calculate a logOdds score of the probe.
This final logOdds score reflects the likelihood that a probe is
methylated, and is calculated as @

o= —Iog(z—'\lj) (4)
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Interpreting the

254

results

Visualization

As shown in Figure 103 above, the boundary to decide whether a probe is
methylated often comes from log-ratio scores that fall in a valley between
two Gaussians. Although the program can establish a ratio of the
contribution of each Gaussian by calculation of the logOdds score @ a
region exists where m approaches a value of 1, and a methylation status
decision cannot be made. In other words, a threshold on the logOdds
score decides the methylation status call. This threshold is not fixed, and
can be determined after you inspect the output in the context of a project.

Agilent Genomic Workbench can display a moving average for both the
probe log-ratio scores and the Z-normalization scores from the

methylation status algorithm. The Z-scores used in the moving average
visualization are the combined Z-scores, and reflect the position of the
probe log-ratio score on both Gaussian curves, as shown in Figure 102.

Figure 104 displays the Gene View results of the methylation status
algorithm for Chromosome 21. The left pane displays the Z-score moving
average. There is no defined cut-off value to determine whether a probe
or probe region is methylated. The middle pane shows the moving average
for the probe logOdds ratios, with genomic tracks annotated. The right
pane displays the CpG island track. Note that the probes fall specifically
within CpG islands, and upstream of genomic tracks such as coding
regions.
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Figure 104 Output of methylation status detection algorithm. On the right side of Agilent
Genomic Workbench, Gene View displays the moving average for both the
Z-score (left pane of Gene View) and the probe log-ratios (middle pane of Gene
View). Human CpG islands are displayed as a track along the right side of the
moving averages. Note that the probe log-ratios, which are only slightly posi-
tive in this region (colored red), may take on negative combined Z-scores (col-
ored by sample).

Outputreport The program generates an output report for each chromosome. The report
contains the following statistical measures:
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Table6  Contents of methylation output report

Reported parameter Meaning

Z-score unmethylated Z-score derived from the left Gaussian. This is the probability
that the observed value for a probe comes from the
unmethylated population.

Z-score methylated Z-score derived from the right Gaussian. This is the probability
that the observed value for a probe comes from the methylated
population.

Combined Z-score Summation of the methylated and unmethylated Z-scores

Pm The p-value derived from the left Gaussian. This is the

confidence at which the non-methylated null hypothesis is
rejected (that is, the confidence at which you can call the probe
methylated).

Pu The p-value derived from the right Gaussian. This is the
confidence at which the methylated null hypothesis is rejected
(that is, the confidence at which you can call the probe
unmethylated).

logOdds The logQOdds score @ the likelihood that a probe is methylated
rather than unmethylated.

Bayesian tool for methylation analysis (BATMAN)

Epigenetic methylation is found predominantly in genomic areas of
increased GC content, known as CpG islands. Agilent human methylation
arrays specifically query approximately 25,000 CpG islands in the human
genome, in addition to gene promoter regions. Like many MeDIP protocols,
the Agilent methylation protocol uses antibody enrichment for
5-methylcytosine, which results in a log-ratio of the relative abundance of
genomic fragments with methylation to those without.

Although the log-ratio scores give information about the relative
abundance of the genomic fragments, the scores do not reflect the
underlying distribution of CpG dinucleotides, the abundance of which can
increase fragment enrichment. Differences in CpG dinucleotide frequencies
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can therefore confound methylation state quantitation because the signal
log-ratios themselves depend upon the density of the methylated CpG
sites.

To obtain an absolute measure of methylation, the BATMAN algorithm
first calibrates a set of conditional probabilities based upon the distance
of a probe from any CpG sites. Based on expected fragment sizes during
DNA shearing, the total number of CpG sites per probe can be estimated,
yielding a Gaussian distribution of methylated sites to give the observed
probe signal. This conditional probability is then used as a likelihood to
generate a Bayesian posterior probability of the methylation status of any
CpG site given the probe signal. The signal used in BATMAN can be either
the probe log ratio or the Z-score from the methylation detection
algorithm.

In general, probes chosen for MeDIP- microarray experiments are limited
by their genomic location and therefore have a wider range of melting
temperatures. The methylation detection algorithm accounts for this by
binning the probes according to their melting temperature and
standardizing the probe scores. Agilent Genomic Workbench therefore
allows you to combine the output from the methylation detection
algorithm with the BATMAN algorithm, to account for the differences in
probe melting temperatures and the effects of inhomogeneous CpG
densities.

To increase the speed of the overall calculation, BATMAN uses the
assumption that the methylation state of neighboring CpG dinucleotides is
not independent, but rather homogeneous due to the effect of methylation
spreading and maintenance. A Monte-Carlo simulation is then used to
sample windows of fixed genomic size to establish methylation levels for
all CpG sites.

Purpose  BATMAN is a visualization and report analysis that determines the
absolute methylation level for CpG dinucleotides that are contained within
DNA fragments queried by probes across the microarray. These probes
typically capture known CpG islands and gene promoter regions. To
determine the absolute methylation level of individual CpG sites, the
analysis uses a calibration method to arrive at a distribution that
describes the conditional probability of the probe signal given a set of
methylation states. Bayesian inference is then used to obtain the
methylation states given the probe signal.
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Use

Algorithm

To establish a link between genomic methylation and gene expression, or
to observe epigenetic changes, Agilent Genomic Workbench uses the
BATMAN algorithm to quantify the methylation level of CpG dinucleotides
across probes that query methylated genomic regions. You can then
visualize the probes in a genomic context — for example, CpG islands
within the genome, or individual CpG dinucleotides within CG-sparse
regions.

The algorithm begins with a calibration step, which uses a regression to
fit a trend between local CpG density and either probe log-ratios, or
Z-scores if the methylation status detection algorithm is used. This is
followed by a modeling step, which uses the calibration results to
construct the conditional probability of the log-ratios (or Z-scores) given
the methylation state. A sampling step occurs to generate a large number
of possible methylation states. Bayesian methodology is used to invert the
conditional probability and summarize the methylation state per probe.
Finally, a methylation call step fits a distribution to the scores on a
per-chromosome basis. Additionally, for each CpG island, genomic
intervals are found with the same methylation call.

Step 1: Calibration step

As described in Down et al.,z a coupling factor Ccp is defined as:

=m
CCp‘n

where ¢ is any given CpG dinucleotide, 7 is the number of fragments
containing ¢, and m is the total number of DNA fragments hybridizing to
any probe p. A linear regression is then fit to the plot of the log-ratios (or
Z-scores) versus Cy,;, Where:

Ciot = Z:cp
p

Since most CpG-rich areas are hypomethylated while most CpG-poor
regions are hypermethylated, the regression fit is increased by limiting the
least- squares method to the low-CpG regions. The least square estimates
are given by:
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~ X =Xy -Y)
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Bo = ¥-BiX
The variance of the predicted response (that is, the expected range of
values of y at 95% confidence) is given by:

.2
Var(yy - [o+Bxyl) = (52 1+l+M

M Nxg- %)”

This value is then used in the modeling step along with the regression line
slope and intercept.

Step 2: Modeling and sampling

This step uses the data from the calibration results to create a likelihood
model. The MeDIP model is given by:

-1
f(A|m) = I_ELAp|Abase+r2:cpMc’ v J
C

p

Where A, is the log ratio (or Z-score) for the probe, Ay, is the baseline
value given by the linear regression, and M, the methylation state at c, is
regarded as a continuous variable with a Gaussian distribution.

Possible combinations of methylation steps are sampled from the MeDIP
model using nested sampling.4
Step 3: Summarization (Bayesian inference)

The sampling step results are then summarized to create a score for each
probe. Each of the sampling states are weighted by the likelihood estimate
from the model. The IQR and median values are calculated across samples
and for every probe in every array.

Methylation (CH3) Analysis Guide 259



6 Statistical Algorithms

The responses are then trimmed to the regions of interested (for example,
track boundaries).

Step 4: Methylation calling

A beta distribution is fit to the scores per chromosome obtained in the
summarization step. (See “Methylation calling — the beta distribution” on
page 265 for more information). Agilent Genomic Workbench then
calculates the modes of the distribution and compares the score to the
mode, assigning methylated / status calls (+1 for methylated, -1 for
unmethylated). If the modes are not unique, then zero is returned as a
call.

The beta distribution is fit using a local searching algorithm called
random hill climbing.3

Interpreting the  For each CpG island, Agilent Genomic Workbench displays consecutive
results regions that share the same call across each chromosome.

Visualization The consecutive regions appear as intervals for inspection.
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Visualization Algorithms

After you apply the methylation algorithm, it is useful to visualize the
general trend of the pre-algorithm probe log-ratios and post-algorithm
combined Z-scores, using a moving average line plot. To facilitate the
visualization of large datasets, Agilent Genomic Workbench employs a
sliding window across the genome, to smooth the data points for detailed
examination. The smoothing functions are available independently from
the main methylation algorithm. A change in window size in the
visualization algorithms does not affect the methylation calls.

To reduce the complexity of the data from probe-to-probe noise, you can
apply one of two smoothing algorithms. One algorithm applies linear
smoothing (the moving average algorithm), and the other applies a
triangular smoothing function. These algorithms use a sliding window of
fixed size, set in the user interface (UI). You can apply them to the log
ratios, the Z-score output from the methylation algorithm, or both.

The moving average visualization algorithm sets a fixed window size
around every point of interest. The algorithm reports the value for that
point as the average of that point and neighboring points within the
window boundaries.

Moving average (linear smoothing)

To compute a moving average, the program averages probe log-ratios or
combined Z-scores over a small subset of points in the genome. This
moving average window, w, may be simply a number of adjacent
measurements, or it may be over a positional window (such as every
megabase).
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Triangular smoothing

Purpose

Use

Algorithm

The triangular smoothing algorithm is a shaped smoothing algorithm based
on a moving average. As the moving average centers on a point of interest,
the program applies a maximum weight, and that weight falls off with
increasing distance. Then the program adjusts the point of interest as the
weighted mean of itself and neighboring points.

When you visualize or analyze array data, it is common to smooth the
data using a moving average. However, the moving average approach is not
the optimal means to reduce noise associated with each independent
point, because it can minimize log-ratio changes or methylation Z-scores
and obscure individual points. Triangular smoothing is a good compromise
that reduces noise of individual points, while remaining sensitive to true
localized or small-scale variations in the data.

The smoothing functions are used for visualization purposes only, and do
not affect the methylation algorithm. However, the program applies the
moving average (Z-score) after the methylation algorithm, to smooth the
methylation Z-scores that you visualize in the user interface.

The number of neighboring points used for smoothing depends on the type
of moving average. If you select point input (pt input), the program keeps
constant the number of points that are averaged. It may use, for example,
3,5, 7 9, or 11 points, and it gives each point equal weight. Alternatively,
you can select a window of constant width (in Mb or Kb). The window
moves across the data and centers on the point of interest. All points
within its range are averaged to yield the moving average value for the
point.

In linear smoothing, the user-defined point input (pt input) uses the same number of probes
as in triangular smoothing. However, an equal number of probes is taken in each direction
(to the left and right of the center probe) to compute the moving average. This might not be
ideal if the probes are placed at varying distances.

Two potential problems exist in linear smoothing:

1 Use of a fixed window width (by choice of a base pair from the UI)
causes a variable number of probes to be averaged at each smoothed
point. Therefore, the degree of averaging varies from probe to probe,
depending on how many probes are in the fixed-width window. Because
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varying numbers of measurements contribute to each smoothed point,
the degree of statistical noise reduction also varies for each point. This
can complicate the error analysis.

2 For so-called “zoom-in” arrays, where some genomic regions of interest
are covered more densely than neighboring regions, the appropriate
window size can vary greatly between the different genomic regions.
Smoothing windows that are appropriate for sparsely tiled regions
obliterate all structure in densely tiled regions. Windows appropriate for
densely tiled regions perform practically no averaging at all in sparsely
tiled regions.

Triangular smoothing avoids these problems, by use of smoothing windows
that contain a fixed number of probes, regardless of the total range of
sequences those probes span. This respects the fact that nearby probes are
more relevant than distant probes to the average at any point.

The concept is illustrated in Figure 105. Fixed-count smoothing includes
the same number of points in each average, but weights probes far from
the averaged point as much as points near it. In triangular smoothing with
pt input, the program enlarges a symmetric window around the averaged
point until it contains the number of points chosen for the fixed-size
window. These points may be on one or both sides of the averaged point,
depending on the probe density around the averaged point. These points
are then weighted appropriately for the triangular smoothing function,
depending on their distance from the averaged point.

When you enter a number of points from the user interface, the program
uses a variable window width, chosen to be the smallest window that is
symmetrical about the averaged point and includes the specified number
of points. Figure 105 illustrates the application of this method for pt
input.
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7 probe span A

Window width W

Figure 105 Triangular smoothing with pt input

The program applies smoothing to a region of varying probe density. The
effective width of the smoothing window, W, depends on the length of the
smallest symmetrical region (A) that includes the specified number of
points. The weight given to each point is proportional to the height of the
triangle at that point.

Weights assigned to the log-ratio or combined Z-score values of these
probes are given by the equation:

2
N(X) = (W-I[x)/ W (1

where the effective window width, W, is determined by the length, A, of
the symmetrical region that includes the specified number of points:

Interpretation The smoothing algorithms affect the scatter plot in the Chromosome and
Gene Views. See Figure 104 for more information.

Visualization Agilent Genomic Workbench can display scores from the methylation
algorithms in the UCSC genome browser for visual interpretation.
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Appendix

This section contains additional information about statistical algorithms
and is useful to understand algorithm steps in detail.

Methylation calling — the beta distribution

The beta distribution is given by:

Xa—l 1_x B-1
B(o, B)
Where B in the denominator is an incomplete beta function given by:
rxr
3(x, y) = KLY
'(x+y)
And the gamma function is:

1

C2) = [ (& te ™t

0

The beta distribution is shown in Figure 106.
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Figure 106 The beta distribution, illustrated with various parameter values
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